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welcome

1.1

1.2

RuinoC AM2020

ecSoft Corporation - )
Ls_ opyright 1998 .mgn Profile-NEST.

Prefer Printed Documentation? Check Here!

The RhinoCAM Profile-NEST module offers sheet nesting capability with 2-1/2 Axis Profiling
toolpaths. Toolpaths can be nested individually orin groups with control over sheet size, layout
and thickness, with all of the cut material simulation capabilities of the MILL module. Nesting
parameters include grain control, auto-tagging, orientation, nesting reports and more, all running
inside Rhino.

For purposes of brevity, RhinoCAM-Profile-NEST will be referred to as Profile-NEST in all
subsequent references. Also, Rhino refers to both Rhinoceros 5 or Rhino 6.

Profile-NEST also comes with numerous post-processors to output the programmed G-code to
some of the most popular machines in the market. This online help system provides
comprehensive help topics as well as context sensitive ToolTips to help you become a productive
user of RhinoCAM.

understanding

Here is some additional information that will help you understand how Profile-NEST works:

e Profile-NEST allows you to nest 2 Axis Profiling toolpath operations onto one or more
nested sheets. You can have multiple nest setups within the same Machining Job. Each
are listed in the order they are processed in the Machining Job.

e The Machining Job can have one or more Setups called E Operations to Nest. If you
expand a Setup in the Machining Job you will see that it has a set of Nesting Parameters
assigned toit. You can adjust these parameters individually for each Setup. When you
Regenerate a Setup the toolpath operations contained within it are updated and its
associated nested sheets are also updated. Regenerating a toolpath operation will also
update its associated nested sheets.

e When Nested Sheets are generated they are listed under the Setup they are associated
with.

Workflow

Profile-NEST offers a quick and easy work flow for nesting 2 Axis Profiling toolpaths. Working left
to right from the Nest tab, here are the basic steps:

© 2020 MecSoft Corporation
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welcome 6

Define your Machine and Post Processor.

Define your Sheet parameters.

Set your Nesting Parameters.

Create your 2 Axis Profiling operations.

Generate your Operations to update your Nested Sheets.
Review your Nested Sheets.

Generate your Nesting Report if needed.

©® N o U B~ W N

Simulate and Post Process.

1.3 Post-Processing

Once the machining operations have been created and verified, they can be post processed to
create G-code files. These G-code files can then be sent to the controller of the machine tool to
drive the actual machine tool.

© 2020 Mec Soft Corporation
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Quick Start

Quick Start Guides for each RhinoCAM module are available in both PDF and Video format. Refer
to the following information to access these guides:

[T] What's New
What's New in RhinoCAM 2020
Watch the What's New in 2020 Webinar!

[T] The Complete Quick Start Video Play List
Here is a link to the complete 2020 Video Play List

[T] How to Access the Quick Start Guide Documents

To help you quickly get started in working with each module, select one of the Help
buttons located on the RhinoCAM Learning Resources dialog.

You will find:

e Quick Start Guides

e What's New documents
e Online Help links

The Quick Start Guides will help you step through an example tutorial which will
illustrate how to use the module. To access the Learning Resources dialog:

1. From the Rhino Main Menu, drop down the Main menu and select Learn ...

© 2020 MecSoft Corporation
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Quick Start 8

29 Untitled - Rhincceros § Mot For Resale Lab - [Pesspective]
Fidle Edit View Curve Surfsce Schid Mesh Dimension  Transform  Tools Analyze Render Panels  RhinoCAM _ Help
Commans:| e
Smndard  CPlanes  SetView  Display  Select  Viewpertlayeut  \Visbility Tendform  CureTs  Foeddill
O EEQ [ x @ O 2002 cH= =% @8 wu
redibe- NEST
I\, :__l Program | Simulate & -5 MILL-TURN
Mm"n. B Stock * o WorkZen B iz v M - MESH
@@‘ {apm B8 wign = =f 2w G SAsis v my e
DO, 5 sewp s [ Mueint A 3aisadv - gy Holes nEsT
@ '1 Machine Setup ock Muhimng Cperations ART
P <3 | B | Machining Job )
{ i B Machine - 3Axis e
g‘a i Post- Fanuchm Cheeck for Updates ...
a @r Sock - Hone LicEnse ...
% =) Frotwres - Mone ‘Web-site
I -
o o«

To access the Learning Resources dilog in RhinoCAM

2. Select a document from the Learning Resources dialog to get started using the
module of your choice.

¥ You can also select the Open Quick Start Files Folder button located at the bottom
of the dialog to open the Quick Start folder where the source files (start and
completed versions) are located.
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Learning Resources

Welcome to RhinoCAM 2020!

To get started as quickly as possible usa the following resources.

What's New? On-Line Help
MILL-TURN Profie-HEST
On-Line Hislp OnLine Help
ART
On-Line Help OnvLine Help
Where to go for more help:

Quick Start

{

L

Cuick Start

i

L

Quick Start

L o Q@L.J@

To getyour specific support questions answered click here to fill out a support form.

For all atherinfomation visit ourweb-site waww.mecsoftoom

Learning Resources Dialog

Quick Start
G-Code Editor
@ L
Ondine Help Couick Start
Open Quick Start Files Folder

© 2020 MecSoft Corporation
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Resource Guide

Download this PDF Guide for a list of the available RhinoCAM Resources.

D:l 2020 RhinoCAM Resource Guide

-.;iﬁ The RhinoCAM 2020

2020 :
RhinoCAM | - Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Click Here to download this guide!

© 2020 Mec Soft Corporation
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User Interface

The RhinoCAM Profile-NEST module adheres to the Windows standard for user interface design

and integrated into the Rhino screen seamlessly.

[1] MILL Module Displayed

A screen shot of the RhinoCAM Profile-NEST module running inside of Rhino is shown
below:
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The Profile-NEST module runninginside of Rhino

The RhinoCAM MILL Interface

There are 3 main interface objects created when MILL module is loaded.
1. RhinoCAM menu bar entry under Rhino menu bar
2. Machining Browser (Mops) window

3. Machining Objects (Mobs) Browser window

© 2020 MecSoft Corporation
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4.1 The Main Menu

When RhinoCAM is loaded it will add a menu bar item, titled
RhinoCAM to the main Rhino menu bar. Selecting this menu baritem
will display a drop down menu as shown below.

4.2 Profile-NEST Browsers

Learn ...

FreeMILL
MILL
TURM
MILL-TURM
MILL-MEST

X

MESH
NEST
ART
NC-EDIT

Check for Updates ...
License ...

Web-zite

Help ...
About ...
RhinoCAM Main Menu

The Profile-NEST Browser is a dock-able window that allows management of various entities or
objects that can be created in the RhinoCAM Profile-NEST module. There are 2 browsers in
RhinoCAM —the Machining Operations Browser (Mops) and the Machining Objects Browser

(Mobs).

[1] Profile-Nest Browsers

© 2020 Mec Soft Corporation
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Profile-NEST|'JRl  test | Simulate & g 5
2 Machine l:‘i Stock - 1.‘ Work Zero ﬁ MNesting Report
B Post B8 aign - [0 2172 Axis Profiling

Ld. Shests = baterial _‘_"_1 Hesting Parameters

Machine Setup Stock Operations To Mest

EWE \achining Job

W Machine - 3 Auxis
i  Post - Laguna_BR_IQ)
3 Stock - Bex Stock

Machining
_ "‘E“; oy et Browser

: 21/2 Axis Profiling (Part 1)
' 21/2 Axis Profiling (Part 2)
' 21/2 Axis Profiling (Part 3)
. 21/2 Axis Profiling (Part 4)
=[] Mested Sheets

5 || Sheet1
8 || Sheet2
5 || Sheet3

B |of P o Bk

RhinoCAM - Machining Objects
[l Tools
| i g
=1 _ Objects
i FlatMil-0 25
Browser

Mo Sort "%
Profile-Nest Browser

4.3 Machining Browser

The Profile-NEST Operations Browser has two main modes of operation represented by tabs at
the top of the window. These are Nest and Simulate. Each tabbed view also incorporates a ribbon
toolbar at the top and a toolbar at the bottom. These toolbars group all of the functions

associated with the type of object in the tab.

© 2020 MecSoft Corporation
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Pruﬁle-NEST- Nest | Simulate & @

8 Machine 6; Stock - “ Work Zero E Mesting Report
% Post 5 Align » [0 21/2 Axis Profiling

Sheets = Material g Mesting Parameters

Machine Setup Stock Operations To Mest

= Machining Job
y Machine - 3 Axis
:2 Post- Laguna_BR_IQ
ﬂ Stock - Box Stock
= E Operations to Nest
G Mesting Pararneters
[__,l 2 1/2 Axis Profiling (Part 1)
) 21/2 Axis Profiling (Part 2)
| 21/2 Axis Profiling (Part 3]
) 21/2 Axis Profiling (Part 4)
- [1_| Nested Sheets
[ ] sheet1
[ ] sheetz
[ ] Sheet3

o o | o e

®H--H--E--E
—

Profile-NEST Browser

431 Toggle Browser Tabs

Tabs are available on the Machining Browser that allow you to toggle the display of both the
Machining Browser and the Machining Objects Browser.

[T] Browser Toggle Tabs

Profile-NEST| 'f3| Mest | Simulate o & @
I chine Stock T “ Work Zero E Mesting Report
] st lign - @ 2 1/2 Axis Profiling

Sheets = Material L‘_j Mesting Parameters

Machine Setup Stock Operations To Mest

Locating the Browser Toggle Tabs

| MILL|| TURN| | MILL-TURN| Profile-NEST|

Selecting this tab toggles between each module browser that you are currently licensed
to operate. Select the button to toggle to the Profile-NEST Browser.

© 2020 Mec Soft Corporation
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k2

Select this tab to toggle the display of the Machining Objects Browser.

432 NestTab

Selecting the Profile-NEST tab in the Machining Browser provides access to Machine, Stock and
Operations to Nest commands. These commands are listed in the ribbon bar when the Nest tab is
selected.

[ The Machining Operations (Mops) Browser, Nest Tab

Profile-NESTll'm Mest Simulate & & @

I Machine ﬁ Stock *  w™ Work Zero Q':[ Mesting Report
i% Post 83 nign - [0 2 1/2 Axis Profiling

E Sheets = Material E‘j‘ Mesting Parameters
Machine Setup Stock Operations To Mest

&1, Machining Job

y Machine - 3 Axis

22 Post- Laguna_BR_IQ

ﬁ Stock - Box Stock

= g Operations to Mest

L",_Iﬁ Mesting Parameters
| | 21/2 Axis Profiling (Part 1)
21/2 Axis Profiling (Part 2)
21/2 Axis Profiling (Part 3)
21/2 Axis Profiling (Part 4)

e R R |
e

B sk or | o8 5 5

Profile-NEST Browser

[T] Machine Setup Pane

This section allows you to define the Machine Tool, Post Processor and the Nested
Sheets.

. Machine Tool Setup: Sets the Machine for 2% axis, 3
|3 Machine | . . . .
axis, 4 axis and 5 axis operations.

© 2020 MecSoft Corporation
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Set Post-Processor Options: Allows you to set the
Current Post Processor, posted file naming
conventions, posted file extension, program to
display the posted file.

:;E? Post

E Sheets Add Sheets by defining sheet size parameters or
geometry.

1] Stock Pane

This section allows you to define the Machine Tool, Post Processor and the Nested
Sheets.

Create Stock Model: Allows you to create Stock
a Stock |~ geometry. User can also delete a Stock geometry by
selecting Delete Stock.

Align: Allows you to Align stock model to part and
locate WCS with respect to Part or Stock . This
@ Align |~ function is especially useful when the part model
and the stock model are created without regard to
their respective positional locations.

Define Stock Material: Allows you to select a

= Material : -
3= Materia material from the material list.

[1] Operations to Nest

This section allows you to create machining operations The Profile-NEST module allows
you to create multiple 2 Axis Profile machining operations in a part file. Thisis a
powerful feature that allows you to create an entire sequence of machining operations
thatis required in the nested sheet.

Add a Work Zero to set the current work coordinate

= Work Zere . e
location for machining.

Add a 2 Axis Profile toolpath operation to the Machining

00| 2 1/2 Axis Prefiling Tl

Set Nesting Parameters for the current Profiling Nesting

[r— .
|= 24 Mesting Parameters
A _ Machining Job.

E Mesting Report Generate a Nesting Report of the current Machining Job.

[ Display Toggle Toolbar

This toolbar is located at the base of the Machining Browser and has the following
controls:

© 2020 Mec Soft Corporation
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433

% Stock Model Visibility: Turn on/off stock model

&;: Material Texture Visibility: Turn on/off material texture
_ visibility

G Toolpath Visibility: Turn on/off toolpath display

5@ Hidden Toolpath Visibility: Turn the hidden portions of

toolpaths on/off.

5¢.~§ Display Toolpath Levels: Displays tool path by Z levels

World CSYS Visibility: Turns on/off of World Coordinate
System display.

ﬁ Machine CSYS Visibility: Turns on/off of Machine
Coordinate System display.

Simulate Tab

Select the Simulate tab to run cut material simulations and toolpath animations. This tab also
provides controls to vary the simulation speed, set the simulation preferences and toggle the
display state of various simulation components.

[T] Profile Nesting Browser, Simulate Tab

© 2020 MecSoft Corporation
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Profile-NEST| 3| Nest | Simulate

N AR N 7

t{.hl Preferences
" [ Play [ TeEnd
Simulate by Mowves m step ml Pause

Opticns Simulate

G Stock - EI Step Levels ﬂ Stop

El-1, -~ Machining Job

3 Machine - 3 Axis

f2 Post- Laguna_BR_IQ

ﬁ Stock - Box Stock

= E Operations to Nest

5 Mesting Parameters
[ 21/2 Axis Profiling (Part 1)
21/2 Axis Profiling (Part 2)
21/2 Axis Profiling (Part 3)
[ 21/2 Axis Profiling (Part 4)

H--FH--E

§
£

3]

18

= [3_| Nested Sheets
[ ] Sheet1
[ ] Sheetz
[ ] Sheet3

B oo | B Hls0 o7

Default hd

Profile Nesting Browser, Simulate Tab

[T] Simulate Tab Functions

The following controls are available on the Simulate tab:

|® Stock |~ |

Create Stock Model: Allows you to create Stock
geometry. You can also delete a Stock geometry by
selecting Delete Stock.

D piay|

Perform Toolpath Simulation or Animation: Allows
you to perform cut material simulation with tool
animation.

| Step|

Simulate Next Toolpath Block: Simulation is
performed in steps as defined by the display interval
in the simulation preferences.

| Step Levels |

Simulate Next Toolpath Z Levels: Simulation is
performed in separate Z levels.

|@TOEﬂd|

Simulate to End: Simulation is performed without
updating the display until the end of the toolpath.

© 2020 Mec Soft Corporation
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| Pause |

Pause Toolpath Simulation: Pause/Stop the
simulation.

| Stop |

Stop Toolpath Simulation: Exits Simulation Mode.
Pause simulation before exiting simulation mode.

E.

Simulation Speed: Varies simulation speed

o
| G=s Preferences |

Set Simulation Preferences: Provides access to
simulation preferences.

Simulate by Moves

Simulate by Moves: Switches from Simulate by
Distance to Simulate by Motions.

[T] Simulate Toolbar Functions

The following toolbar controls are available on the Simulate tab:

I;Hrl

Part Model Visibility: Turn on/off part model display
during simulation.

I%I

Stock Model Visibility: Turn on/off stock model

|

Material Texture Visibility: Turn on/off material texture
visibility

&

Toolpath Visibility: Turn on/off toolpath display

o

Hidden Toolpath Visibility: Turn the hidden portions of
toolpaths on/off.

B

World CSYS Visibility: Turns on/off of World Coordinate
System display.

I$I

Machine CSYS Visibility: Turns on/off of Machine
Coordinate System display.

IG:IIJI

Tool Visibility: Turn on/off tool display during simulation.

IG;’I

Holder Visibility: Turn on/off tool holder display during
simulation.

Simulation Display State: Use this to select the display
state for the simulation. Select from Default, Tool, Mop or
Texture. See Machining Operation Properties for setting
unique simulation colors for each Mop (Machining
Operation) in your Machining Job.

© 2020 MecSoft Corporation
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jﬁm{} 650,770 | i

The status bar displays the progress of the operation currently being simulated and
number of Goto motions.

4.4 Machining Objects Browser

The Machining Objects Browser has two tabs located at the top to work with Tools and Knowledge
Bases. Each tabbed view also incorporates a toolbar at the top. The toolbars on each tab group all
of the functions associated with the type of object in the tab.

The Machining Objects Browser can be toggled on and off by selecting the toggle button located at
the top left corner of the Machining Browser. This toggle button is shown below.

[T The Machining Objects (Mobs) Browser

Profile-NEST Mest Simulate o g~ & @
M Machine [} tock T “ Work Zero E Mesting Report
i Post %3 Aign - [0 2 1/2 Axis Profiling

Sheets = Material G Mesting Parameters
Machine Setup Stock Operations To Mest

3 Machine - 3 Axis
S_;ﬁ Post - Laguna_BR_IC

M T

Locating the Machining Objects Browser toggle tab

[ Tools
T O & Ty
= Itm Tools -
s J Flathill 0,25
B 275 4rL 2580 Lac)
B 75 4arL (1180 Loc)
-

QFEACL  _QFn | 1

Mo Sort = +%+ it

FlatMill: 0.25 | #2 | Dia:0.250, CRad:0.000, Taper:0.0 deg | RPM: 24446 | F: 14.7
The Machining Objects (MObs) Browser

The status bar displays the currently selected tool, spindle speed and cut feedrate.

[BallMill1 | #1 | Dia:0.5, CRad:0.25, Taper:0 deg | RPM: 24446 | F: 15

[1] Machining Objects Browser Tabs

© 2020 Mec Soft Corporation
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J' Tools tab: Allows you to create, edit, tools and tool
g Tools . .
libraries.

441 Tools Tab

Selecting the Tools tab under the Machining Objects Browser brings up the tool manager. It lists
all of the tools currently defined as well as the tools that are in use in machining operations. You
can edit a tool by double clicking the tool button in the browser. A tool can be deleted by
selecting the tool from the Tools browser, right click cut or use the delete key from the keyboard.

[T The Machining Objects (Mobs) Browser, Tools Tab

]' Tools

T8 5 Y
= Itm Tools -
% 0 Flatni: 0.25
B 375 4L (2580 Loc )

L3

d 75 4FL (1150 Loc )

A ATFEACL  _QFEN | 1 =

Mo Sort - +%+ i

Flatiill: 0.25 | #2 | Dia:0.250, CRad:0.000, Taper:0.0 deg | RPM: 24446 | F: 14.7
The Machining Objects (MObs) Browser, Tools Tab

RhinoCAM supports 2 types of tool library file formats *.vkb and *.csv (*.vkb is
recommended).

[T] Tools Tab Functions

]’ Create/Edit Tools: This button brings up the tool dialog that enables the
creation and saving of tools. All milling, drilling and user defined tools can be
created here. Refer to Tool section for a detailed description on creating tools
and defining tool parameters.

@J' Load Tool Library: The load tool library button enables the loading of a
previously saved tool library. Refer to the following section for additional
information - Load Tool Library

ﬁj’ Select Tools from Library: The select tool library button enables you to select
tools from a previously saved tool library. Refer to the following section for
additional information - Select Tools from Library

Lﬁj' Save Tool Library: This button enables the created tools to be saved in a tool
library file. The file can be saved in the desired directory and read in when
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required. Referto the following section for additional information - Save Tool
Library

th Unload Tool Library: This button will unload the current Tool Library.

Ilﬂj List Tools: The button brings up all the tool properties associated with the tools
currently recorded in the current MILL session. Refer to the following section
for additional information - List Tools

[T Right-click Options on Tools

You can right-click on a Tool listed in the Mobs Browser to perform various functions.
These are listed below:

= Itm Tools

e Flatin 025
L)

o §.375 4FL (2,550 Loc )
[ .3?54FL[1.1EE Edit
[
> R AN
> BEERRRL Rename
[ g
& oo Lo,
& a4
& sz2r s Copy
(5 .25D4FL[.?5E3 Paste
¢ s
& zozr s
[
;d ZE04FL[ .80 -
2E04FL(1.1
vAa  ___ . _. .. ___. e -
Right-click Options on aTool
Edit

Displays the Create/Edit Tool dialog allowing you to edit the Tool parameters.

Rename
Allows you to Rename the selected tool.

o Cut / Copy / Paste
These options allow you to Cut or Copy the selected Tool to the Windows Clipboard
@ and then Paste it back to the Tools list to create a new tool using the previous tool

[3 as a template.
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Add to Library
This allows you to Add the selected Tool to an exiting Tool Library *.csv data file.

Preview
This will display a Preview of the selected Tool in the Graphics Window similar to

how the Tool displays during Simulation. The Tool will display at the origin of the
MCS for the current operation.

[T] Tools Toolbar Functions

The following Tool Sorting rules (when set) will apply to both the Tools tab of the
Machining Objects Browser and the Create/Select Tools dialog.

Mo Sort - +%+ ,f

Sort by Mame >

Sorting Selector: This allows you to sort the tool list. You can select No Sort or sort by
Name, Number, Type and Diameter.

+%+ Sort in Ascending/Descending Order: This icon acts like a toggle to switch
between Ascending and Descending sort order.

o Liston the Tool used in Machining Operations: Toggle this icon to list ONLY the
tools currently assigned to an operation. Note: You must Generate an operation
for the assigned tool to be listed.

B If you do not see any of your tools listed, check to make sure this iconis
toggled OFF. If no operations are using tools yet and this icon is ON, then
no tools will be listed!
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x|

ST

=
=

= I'_m Tools
Ballrilll a Balltill
Borel

CenterDimill

CRILL - 1/4 IMCH

Crrilln

Flathdill1

FLATHILL-1/4 IMCH

REBorel

Rearner

Tapl

Thread Milll

Weehdilll

Tools Sorted by Used

Tools Sorted by Name

[T] Tools Status Bar

The status bar displays the currently selected tool, tool tip radius & angle, spindle speed
and cut feedrate.

Flat Mill-0.5 | #1 | Dia:0.5, CRad:0, Taper(0 deg | RPM: 3055 | R 61

4.5

Status Bar, Tools Tab, Machining Objects Browser

Docking Browsers

Both Machining Operations Browser and the Machining Objects Browser windows are dock-able
windows. This means these windows can be docked in any position in Rhino. This section
describes the procedure to be used to dock both of these windows such that they are stacked

vertically.

[T Step 1: Launch the MILL Browser

From the Rhino main menu, select the RhinoCAM menu and then pick MILL. This displays
the machining operations browser and by default is docked to the left half of the
application window next to the view bar.

Step 2: Display the Tools, Machining Objects Browser

Select the Tools Machining Objects button located on the Machining Operations Browser
just to the left of the Program tab. This displays the Machining Objects Browser next to
the operations browser.
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RhinoCAM - Machining Browser
Pmﬂle-NESTT'.[ﬂ Mest Simulate o 80
b | Mach-nellﬁ Stock = of® Work Zero E Mesting Report
|} Post ‘,ﬁ ﬁdlgn b4 E 2 172 Bxws F‘n;lflllng
E Shests = Material a Nesting Parameters

Machine Setup

Stock Operations To Nest

= Machinif Job

W Mackgpe - 3 Axis
i Post - Weguna_BR_I0)
5§ Stock - B Stack

5 "L Dperations g Mest

212 Axis Profiling Part 3)
212 Awis Prufiﬁ&m E
=[] Mested Sheets
o [ ] sheet1
o [ ] sheet2 ‘
# [ ] sheet3

B o | o 58 B &

RhinoCAM - Machiming Ubjﬂ#

rj Towls I

T orarer

) [-D L:t.l.ﬂ-l:l 5 :
& s erLizsoLec)

W
LA

Mo Sort -t i

Flathill-0.25 | &1 | Dia:0.250, CRac:0.000, Taper:0.0 deg | RPM: 20000 | F: 400.0
Toggle the Machining Objects (Mobs) Browser Display

[T] Step 3: Drag & Drop the Browser

Selecting the title bar and holding the left mouse button down and dragging the browser
window allows you to dock the browser to desired location. You can dock a browser
inside of another browser or have them docked side by side.

46 CAM Preferences

{8: Youcansetvarious CAM Preferences that will be saved even after you exit the program.
Select the Preferences icon from the Machining Browser. When you install a new RhinoCAM
update you are choose to import your CAM Preferences from one version to the next.

[T The CAM Preferences Icon (in the MILL Module)
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| Profile-NEST|'?J  Nest = Simulate o F 8@
W Machine f_:ﬂ Stock - “ Work Zero g Mesting Re @
’ = Pref
% Post B align - [00)21/2 Axis Profiling references
E Sheets 8= Material [© 4 Nesting Parameters Set CAM system
- preferences
Machine Setup Stock Operations To Mest

Set CAM System Preferences menu item

[1] The available Preferences include:

Geometry
Includes color preferences for Regions and Surfaces. Show the dialog.

Stock
These include stock colors, stock edge display and stock transparency. Show the dialog.

Cutting Tools
Includes Tool colors, Tool display states and the default Tool Library preferences. Show

the dialog.

Feeds & Speeds
Includes Feeds & Speed preferences such as default values and other options. Show the

dialog.

Machining
Includes Arc Output, Drill Cycle Output, Toolpath Resolution and the default machining
Knowledge Base preferences. Show the dialog.

Toolpath
Includes Toolpath Colors and Toolpath Display preferences. Show the dialog.

Simulation
Includes Simulation Type, Mode, Accuracy, Transparency and other preferences. Show
the dialog.

User Interface
Includes General, Stock Information and Ribbon Style preferences. Show the dialog.

Licensing
Includes network licensing preferences. Show the dialog.

46.1 Geometry

You can set the colors to display various objects using this dialog. To change each of the color
settings in this dialog select the colored button next to the item of interest. This will bring up the
color selection dialog, which can be used to choose the color needed. Once a color has been
selected the button will change its color to the selected one.
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46.2 Stock

You can set the simulation preferences using this dialog. Note: Some options are not available in
XPR (Xpress) configuration.

[T] Dialog Box: CAM Preferences > Geometry

[1]

1]

Preferences ot
I Geametry Region Colors Surface Colors

Stack Containrment - Drive -

Lt ool Riegion :l Surfaces

Ik
W e Avoid Region [N - gnﬁgtes [ -

Feeds & Speeds

b achining

Toolpath

Simulation

Ilzer Interface

Lizenzing

Cancel Apply Help

CAM Preferences >Geometry

Region Colors

Containment Region
Use this color selector to set the display color for Containment Regions (i.e., your Control
Geometry).

Avoid Region
Use this color selector to set the display color for Avoid Regions (i.e., your Control
Geometry).

Surface Colors

Drive Surfaces
Use this color selector to set the display color for Drive Surfaces (5 Axis).

Check Surfaces
Use this color selector to set the display color for Check Surfaces (5 Axis).

[T] Dialog Box: CAM Preferences > Stock

Users can set the simulation preferences using this dialog:
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Preferences >

Leometry Stock Colors Stock Edges Colors

| Stack Stock e - Sihouette: [T =

Cutting Toolz
CutStock | | ~ Sharp: [ -
Feeds & Speads
b achining Stock Edges Display
Silhouette edges
Toolpath

) ) Sharp edges Angle: :
Simulation

Uzer Interface Stock Model Display Transparency

Licenzing Opaque Tranzparent

Cancel Apply Help

CAM Preferences > Stock

[ Colors

Here you can set the stock colors. You can differentiate between cut and non-cut areas by
specifying different colors for them here.

Note: If the Simulation Display State is set to Mop " then the Color assigned
using the Machining Operation Properties is used to display the cut stock. Right-click on
an operation in the Machining Job tree and select Properties to set this color.

[1] Stock Edges Display

This section allows you to control the Stock Edges Display states. For example, you can
check the boxes to display Silhouette Edges and Sharp Edges as well as the Angle to
display for stock edges. Silhouette Edges and Sharp Edge colors are set using the Colors
section of this dialog. Experimentation is advised until you are comfortable with the way
your stock display.

[T] Stock Model Transparency

Use this slider to adjust the Stock Model Transparency when the Program tab is selected
(i.e., when you are not simulating).

4.6.3 Cutting Tools

You can set the Tool Library to load on startup and also specify the location of your Tool Library
files.
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[T CAM Preferences > Cutting Tools

Preferences >
Gienmetry Cutting Tool Colars
Stack ToolFltes | | = | ToolShark ([ -
Cutting Tools
Feeds & Speeds Tool Holder - e
Machini
Aenining Tool Dizplay
Toolpath
{®) Solid () Transparent (iwireframe () Mone
Sirmulation

zer Interface

Lizenzing

[ ] Display Tool Holder

Toal Library Preferences

Always load last lnaded toal library on startup

Drefault Tool Library

Clear

[T] Cutting Tool Colors

Cancel

CAM Preferences > Cutting Tools

Apply

Help

Use the color selectors to set the default display colors for the cutting tool. The Tool
Flutes, Tool Shank and Tool Holder can each be assigned a different.
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Halder —»

Shank —

Fultes —=

[T] Tool Display

The cutting tool can be displayed as either Solid, Transparent, Wireframe or None by
selecting the desired option. You can also toggle the display of the Tool Holder by
checking or un checking the box provided.

[T] Tool Library Preferences

This defines your Tool Library preferences:

Always load last loaded tool library on startup
If you check this box, every time RhinoCAM loads, the last loaded Tool Library will be
loaded automatically.

Default tool library path

Optionally you can specify the file path for your default tool library files. Note: Itis
recommended that you save your custom tool library files to a location outside of the
RhinoCAM install path. This will keep them from being overwritten when you install
new updates of RhinoCAM.

4.6.4 Feeds & Speeds

You can set the Feeds & Speeds preferences using this dialog.

[T CAM Preferences > Feeds & Speeds

© 2020 Mec Soft Corporation



RhinoCAM Profile-NEST 2020 Reference

Preferences ot
lieometry Load Feedrates for new operations from
Stock i® Tool () Feeds & Speeds File () Defaults
Cutting Toals

% = to use faor transfeming from computed cut feed
[ Feeds & Speeds ] d F

100 =
b achining Cut Feed I: b
Tookpath Plunge Feed B0 = 5
Sirmulation Approach Feed |75 = xz
|Jzer Interf
zer Interface Engage Feed IE = .
Lizenzing
Retract Feed 125 = o
Departure Feed | 180 = 4
Tranzfer Feed | 200 = 4

Feedz/Speed: Tracking Options

i

[ ] &ways rack Operation: Feeds/Speeds to uzed Tool

Cancel Apply Help

CAM Preferences >Feeds & Speeds

[T] Load Feedrates for operations from

This allows you to select a preference option for loading Feeds/Speeds from table or
from tool or use defaults when creating a new operation.

Tool
Selecting this option loads the feeds/speeds saved with the tool when creating a new
operation.

Table
Selecting this option loads the feeds/speeds based on the material selected when
creating a new operation.

Defaults

Selecting this option loads the feeds/speeds from the default knowledge base when
creating a new operation. If default knowledge base is set to undefined, the system
defaults would be used for loading feeds and speeds.

[T] % s to use for transfer from computed cut feed
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These % values apply when using the Load from File option (i.e., commonly referred to
as the Feeds & Speeds Calculator) from either the Create/Edit Tools dialog of from the
Feeds & Speeds tab of any of the toolpath operation dialogs. 100% of the Cut Feed
specified in this dialog is applied and a percentage of the Cut Feed is used to populate
the remaining feedrates for Plunge, Approach, Engage, Retract, Departure and Transfer.
You can set the % values to use here.

[1] Feeds/Speeds Tracking Options

When you select the Load from Tool option from any of the toolpath operation dialogs,
the Feeds & Speeds specified for the active tool are populated into the Feeds & Speeds
tab of the operation's dialog. You can check this box to perform this automatically when
new toolpath operations are created.

46.5 Machining

You can set the machining preferences using this dialog.

[T] CAM Preferences > Machining
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Preferences >
Geometry Arc Output
Stack [] Output arcs as linear segments
Cutting Toals Output spiral motionz as inear zegments
Feeds & Speeds COutput helix motions as inear segments
[ b achining ] Toolpath Arc Fitting Contral [IF requested in kMOp]

Taalpath b awirmum Arc Radive: |10 :

Congtraint Plane(z]
=7 Plane #Z Plane Y Plane

Simulation
Izer Interface
Lizenzing Drrill Cyele Output

[ ] &haays output as linear mations

T ool Programmed Paint [P]

(®) Tool Tip 1
() Toal Center

Toolpath Generation Settings

Part Sampling Rezolution

Standard F edium Fine

Alwmays generate taolpaths in multiple threads
Default Parameters
Default Knowledge Base | Undefined V

Source folder for Enowledge Baze:
|E:"~F'ru:ugramData"-.Meu:Su:uft CorporationVizualCakd 2020 for

Cancel Apply Help

CAM Preferences: Machining

[T] Arc Output

Some NC machine controllers do not have arc, spiral and helical output (for example G2,
G3). For such type of controllers, the arcs that are generated in the toolpath can be
output as linear segments by selecting these check boxes.

Output Arcs as Linear Segments
If your controller does not support arc g-code motions, check this box to output arcs as
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linear segments.

Output Spiral Motions as Linear Segments
If your controller does not support spiral g-code motions, check this box to output spiral
motions as linear segments.

Output Helix Motions as Linear Segments
If your controller does not support spiral g-code motions, check this box to output spiral
motions as linear segments.

[T] Toolpath Arc Fitting Control (If requested in Mop)

Some toolpath operations support Arc Fitting. If supported, the option is located on the
Advanced Cut Parameters tab of the operation's dialog.

Maximum Arc Radius
Some toolpath operations support Arc Fitting. You can enter here the Maximum Arc
Radius that can be created.

XY Plane

Check this box to Perform Arc Fitting . The system will attempt to fit arcs along the
computer toolpath if they lie within the three principal planes (XY Plane, XZ Plane or YZ
Plane).

Tolerance (t)

XZ Plane
Arcs can be fitted to linear toolpaths that lie on one of the three principal planes XY, XZ
or YZ. Check the box for which plane to fit arcs to.

Arc Fitting

YZ Plane
Arcs can be fitted to linear toolpaths that lie on one of the three principal planes XY, XZ
or YZ. Check the box for which plane to fit arcs to.
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[T]

[T]

[T]

[T]

Arc Fitting

Drill Cycle Output

This section refers to Hole Machining Drill Cycles.

Always output Drill Cycles as linear motions.
Check the box if your wish to always output Drill Cycles as linear motions.

Tool Programmed Point (P)

The toolpath can be output as the tool tip or the tool center. If Tool Centeris selected,
the toolpath will be offset by the difference in the height of the tool tip and tool center.
The default value is the Tool Tip.

T 3

n Changing machining preferences requires regeneration of machining operations to
apply the changes.

Toolpath Generation Settings

Part Sampling Resolution

This slider is used to control the display quality of the simulated model. Standard is
faster but with lower display quality. For large parts, use the Standard or Medium
options, while for smaller parts Medium or Fine options would work satisfactorily.

Always generate toolpath in multiple threads

Check this box to Always generate toolpath in multiple threads. The system will
distribute the computing of multiple toolpaths to different cores in your processor
simultaneously rather than sequentially. Refer to Multi-threading Manager section for
additional information.

Default Parameters

Default Knowledge Base

This allows you to select a Default Knowledge Base to load for creating machining
operations. Selecting a knowledge base as Default loads the operation parameters when
creating new operations. If no Default knowledge base is specified, the system defaults
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are used for machining operation parameters.

Source Folder for Knowledge Base
This is the source folder where the Default Knowledge Base are stored.

4.6.5.1 Multi-threading Manager

This distributes computing of toolpath to different cores in your processor simultaneously rather
than process them sequentially when regenerating multiple operations.

Multi-Threaded Machining Operations Regeneration Manager @
D M @
kachining O peration Statuz

Harizontal Roughing
Harizontal Finizhing
Pencil Tracing
Wallew Remachining

L]

1] |

Multi-threading Manager

To enable generation of toolpath using multi-threading manager, select Always generate toolpath

in multiple threads from Machining Preferences located under CAM Preferences in the Machining
browser.

Regenerating the Machining Job, Setup or machining operations displays the multi-threading
manager window and indicates the progress of the toolpath computation.

© 2020 Mec Soft Corporation



37

RhinoCAM Profile-NEST 2020 Reference

4.6.6
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Toolpath

These preferences relate to the graphical display of toolpath cut motions.

SN L

Multi-threading Manager window displayed

1] CAM Preferences > Toolpath

. Mok Tooks - Rerder Tools | Dewlieg © Hew i V5

00.@ WL,

You can still continue working with the application when the toolpath generation is in progress
with the multi-threading manager dialog active.
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Preferences x
Geometry Toclpath Calors
Stack Cut Mation :l ~ Flurge ~
Cutting Toals
Appraach - - Ergage - ~
Feeds & Speeds Fr o
b achining Fetract - Departure ~
[ |
Toolpath
Fapid e - Cut Arc B -
Sirmulation
Ilzer Interface Toalpath Display

Licenzing Toolpath Display |1 =

[+] DizplayT ool Positions Size [Piselz) [1 = I -
Dizplay T ool Axes Length (025 = [ -

Cancel Apply Help

CAM Preferences >Toolpath

[T] Toolpath Colors

Use the color selectors to define the display color for each motion in the toolpath. The
following can be set: Cut Motion, Plunge, Approach, Engage, Retract, Departure, Rapid
and Cut Arc.

1] Toolpath Display
These preferences control the display of the toolpath in the graphics window.

Toolpath Display
This refers to the graphical display of toolpaths. Enter a value to effect the size of the
toolpath during display.

Display Tool Positions Size (Pixels)

Check this box to display tool position locators. Each coordinate represents one tool
position. Then enter the Pixel Size for the locator point as well as the Pixel Color of the
position points. You can also use the color selector to assign a color to these markers.

Display Tool Axis
Check this box to display the Tool Axis line. You can then enter a Length for the axis line
and use the Color selector to assign it a color.
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4.6.7 Simulation

You can set the simulation preferences using this dialog. Note:

XPR (Xpress) configuration.

[ Dialog Box: CAM Preferences > Simulation

Preferences

Geometny

Stock,

Cutting T onls
Feeds & Speeds
kd achining

Toolpath

Sirulation
zer Interface

Lizenzing

Simulation kodel

(W ouel Model {®) Polygonal todel

Simulation Mode
(®) Simulate By Maoves i) Simulate By Diztance

Min . SER

b awirmurn Digplay [Htereal 100 =
[# of Moves/Distance]; -

Simulation Accuracy

Standard b edivimm Fine

Use Specified Spacing for Yoxel Model | 0.01

Stock Model Simulation Dizplay Transparency

Opagque Tranzparent

Removal OF Remnants

[] Remove Remnants During Simulation

Additional Options
Stop simulation on ermar

[] Disable advanced 0peniGL

[T] Simulation Model

In the RhinoCAM MILL module you can choose between two simulation models. One is

Cancel Apply Help

CAM Preferences >Simulation

called the Voxel Model and the other the Polygonal Model.
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Voxel Model

The Voxel Model is a fast simulation model that is primarily used for 3 axis applications.
Itis especially useful when there are large amounts of toolpath blocks to be simulated.
This model is fast but suffers from some accuracy limitations near vertical walls. The
display quality of this simulation might also be insufficient for some applications
especially when simulating near vertical walls.

Polygonal Model

The Polygonal Model on the other hand is a high quality simulation model. This model
uses more accurate simulation algorithms at the expense of speed. The speed of this
simulation can be relatively slow when compared to the Voxel Model. Additionally only
the Polygonal Model of simulation can be used for 4 and 5 Axis simulations. The Voxel
Model is limited strictly to 3 Axis applications.

Note: * This feature is notavailable in Xpress configuration.

Here is an example of a cylinder stock model representation with Voxel and Polygonal
model.

Simulation Model - Voxel Simulation Model —Polygonal

D:l Simulation Mode

You can set the simulation mode to Distance or by Motion. Simulate by Motion simulates
the toolpath based on the number of go to motions in the generated toolpath. Simulate
by Distance uses a distance based approach.

Note: * This feature is notavailable in Xpress configuration.
(1] Simulation Speed

You can control the speed of the simulation using the slider bar and the
Maximum display interval. When using Simulate by distance mode, the speed is
determined as # of Motions / Distance.

1] Simulation Accuracy

This setting is used to control the accuracy of display of the simulated model. You can
control the accuracy of the stock model by selecting from Standard, Medium or Fine. The
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1]

[T]

1]

finer the stock model accuracy results in slower performance and increases the
simulation time.

Use Specified Simulation Spacing for Voxel Model
When Voxel Model is selected (see Simulation Model above), you can also specify the
spacing for the Voxel model. Check the box and enter the Spacing distance desired.

Stock Model Simulation Display Transparency

Use this slider to adjust the Stock Model Transparency when the Simulate tab is selected
(i.e., when you are performing a cut material simulation).

Removal of Remnants

Check this box to Remove Remnants During Simulation. Any disassociated stock will be
removed from the simulation.

Additional Options

Stop Simulation in Error

Check this box to pause the Simulation at each error flag. If enabled, a message will
display asking if you wish to continue with the simulation. Selecting Play will simulate to
the next error flag and then pause. etc.

1: Setup 1
* Waork Zero
o B 212 fwis Packeting
(5 Contrel Gearnetry
[ Fraensin
3 Feeds/Speeds

[ Crearsnce
Parametess
Toclpath

&b In-process Stock v

B oo P of R

Mop: 2 172 Axis Pocketing, ®21625, T:1 hr 16 min o ox

Global Edits | Selection Edits

A A& v W

= Type LT ™
Af 1243 GOm0 4, 733772, 1. 255723,0, 500000
1244 QOT0 |, 73ITTE, 1. 356723,0, 500000

1245 MARSER cuT

1246 GOTO 4, 733772, 1.256723,0, 500000
AP 1247 GoTO 2, 212477, 1. 256713,0, 500000
Hp 124a ViR 24RO EOA000" RS R-SNON00, -

Stop Simulation at Error Flag
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Sirmulation Error 4

Holder fShank Colision Error. Do you want to continue 7
Do not show this dialeg again in this Play. o
Stop Simulation at Error Flag message

Disable Advanced OpenGL

Check this box only if you have an older graphics card adapter that does not support
advanced OpenGL (i.e., OpenGL 2). Some older cards may only support OpenGL 1 for
example. If you experience graphics instability checking this box may help resolve the

issue.

4.6.8 UserInterface

From here you can set the various user interface options.

[1] Dialog Box: CAM Preferences > User Interface
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Preferences >

Genmetry General User nterface Preferences

Stock Ilze Floating ‘Windows for MOp Dialogs
Cutting Toals ) )

[ ] Show Getting Started Dialog at Startup
Feeds & Speeds

[ Run Automatic: check for updates at startup
b achining

Show Configuration Selection Dialog at startup
Toolpath

Show Contest Tool Tipz
Simulation

[ Uset Intef ] Show Expression Result in Tool Tip
zer Interface

Li . Tool Tip Delay: = zec
icEnzing
Show [ngufficient M aching Aees \Warning when Pozsting

Show Load Settingz from File Dialog when opening file
Stack Information Dialog Dizplay

[ ] Irwoke *Stock Model Information' dialog
[ Invoke 'Fun Simulation After Regeneration' dislog

[ Invoke 'Stack from Selection Infarmation’ dialog

Ribbon Style

System e

Cancel Apply Help

Dialog Box: CAM Preferences > User Interface

[1] General User Interface Preferences

User Floating Windows for Mop Dialogs

Selecting this option displays machining operation dialogs as a floating window where
the dialog appears on top of the Machining Browser. If the above option is unchecked
the machining operation dialog is docked and is displayed over the Machining Browser
window.

Show Getting Started Guide at startup
This displays Getting Started dialog at program startup every time the program is loaded.
This dialog provides quick access to resources on MecSoft's website.

Run Automatic check for updates at startup
Selecting this option automatically checks for product updates when RhinoCAM is
loaded. This requires access to internet on the computer running RhinoCAM.
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Show Configuration Selection Dialog at startup

Selecting this option displays the product configuration dialog to run when the program
is loaded. User can select from the following MILL modules - Standard, Expert,
Professional and Premium.

Choose CAM module bo run n Diemo modse

W ML ¢ TURN v [ ] mest

Hpress -

Configuration Selection Dialog at startup

n This dialog appears at startup when RhinoCAM is running in demo mode.
Selecting a configuration loads RhinoCAM and provides the features available in
the selected configuration.

Show context ToolTips

Check this box to display Context ToolTips when the mouse moves over a parameterin a
dialog. A definition of the parameter will pop-up automatically. Note that Context
ToolTips may not be available for ALL dialogs. You can also set the ToolTip Delay in
seconds. This is the amount of time it takes to display the Context ToolTip when the
mouse activate it.

ut Juts ]

) % Tool Dia [5 = i
'ﬁ'l:li.ku
L

% Tool Diameter allows you to set the stepover
distance for the current operation as a
percentage of the active tool diameter

(Oiingide () Outsade :“" T
L] Abvesys Ko Tood Down

Show Expression Results in Tooltip

You can enter expressions in any dialog field that expects a numerical value and the
value will be computed and entered automatically. Check this box to pop-up the results
of any expressions in a ToolTip balloon. An example is shown below.
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Location of Cut Geometmy
(&t Top  (®) At Bottom

(O Pick Top 0 sk
Cut Depth Contral

Total Cut Depth: = I
Fough Depth:

nha = £

Show Expressions in ToolTip

Show Insufficient Machine Axis Warning when Posting

With this checked, you will receive a warning message if the Machine Setup definition is
not set to the required number of axis for the operation being posted.

Show Load Settings from File dialog when open file
CAM Preferences are saved individually with each part file. Check this box to display the

Load Settings from File dialog when afile is opened. This gives you opportunity to NOT
have your CAM Preferences overwritten by the opened file.

Load settings from file >

This file contains CAM system preferences. Would you like to use them?

[ ] Do not show this dialog again. YEes Mo

Load settings from file

[1] Stock Information Dialog Display

Invoke 'Stock Model Information' dialog
The Stock Model Information dialog is displayed when a stock geometry is created.
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Stock Model Information

Impartant notes about Stock models and Cut Matenial Simulation;

1.There are 2 types of Stock models that you can create - Yonxel and Polygonal. You
zah chooze the Stock model lepe in the Simulation Preferences dialog.

2. Pleaze make sure that vou uze Polvgonal Stack. model when warking with ratated
Setupz. The Worel Stock model can only be uzed when the Setup £ aris iz parallel to
the global £ awis.

3. Pleaze naote that Cut Material Simulation of rotated Setups is nat available in the
Standard configuration of the products,

[T Do nat show this dislog again. l oK ] l Cancel || Help

Dialog Box: Stock Model Information

You can turn off this dialog by selecting Do not show this dialog again located on the
bottom of the message window.

To display this dialog during stock creation, select CAM Preferences > User Interface and
select Invoke ‘Stock Model Information’ dialog.

Invoke 'Run Simulation After Regeneration' dialog
This dialogis displayed when you regenerate a Setup or the Machining Job.

Run Simulation After Regeneration

[ Run simulation after regenerating each Machinging Operation

[ Do not show this dialog again

Dialog Box: Run Simulation After Regeneration

Run simulation after regenerating each Machining Operation

Selecting this option simulates every machining operation in the Setup after the
operation is regenerated. This is generally selected when a re-roughing operation is part
of a Setup as it requires the in-process stock of the previous roughing operation to
generate the re-roughing toolpath.

ﬁ This process would take longer processing time to regenerate all operationsin a
Setup depending on the system resources and simulation preferences.

To display this dialog when regenerating a Setup, select CAM Preferences > User
Interface and select Invoke ‘Run Simulation after Regeneration’ dialog.

Invoke 'Stock from Selection Information' dialog
This dialog is displayed when creating Stock geometry using Stock from Selection.
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4.6.9

i =

Stock From Selection

Irmpartant hate abaut Stock fram S elction:

b ake sure the geometry selected for creating the stock model iz not vizgible when
pragrammitg hoalpaths.,

Some toolpath methodz conzider all vizible geometry az part geometry for toolpath
aeneration. Mot hiding the stock maodel can rezult in incarrect ar no toalpaths being
compuked.

[7] Do not show thiz dialog again. [ k. J [ Help

Dialog Box: Stock from Selection Information

To display this dialog again when creating Stock from Selection select CAM Preferences >
User Interface and select Invoke ‘Invoke Stock from Selection Information’ dialog.

[T Ribbon Style

This allows the selection of different themes that changes how the Browser windows
appear. The borders, colors, highlighting, and shadowing of standard buttons, dialogs,
and windows are controlled by which theme is selected.

;
MILL iﬂ Program Simulate & - i - @

8 Machine Q) Stock = o WorkZero 3o 4 Axis ~ 3§ ~
25 Post B8 atign - =V 2 ~ @ 50 - B2 -
Setup ~ §= Material '\.; 3 Axis Adv ~ Iﬁ Holes =

Machine Setup Stock Machining Operations

Example Ribbon Style: Office 2010 Silver

License

This dialog allows you to set Licensing Preferences for using a Proxy Server and/or a LAN Daemon
(for Network Licenses). This information would be provided by your network administrator.

[T] Dialog Box: License Preferences
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Preferences *
Geometny Prowsy Server Settings
Stock [ Using Prowy Server
Cutting Tacls Frosy IP Address
Feeds & Speeds Frosy Port # B0 =
b achining
Prowy Uzer Mame
Toolpath
_ _ Prosy Password
Sirmulation

Izer Interface

Lizenzing

LA Daemon Settings [for Nebwork, Licenses]

[] Using LAM D aemon

Daemon P Address | |

Draeman Part # 16700 ==

Daemaon User Mame |

Draemon Pazzswaord |

Metwork, Authentication Service Settings
[ Using Metwork Authentication
Service Server Settings
Server P Address

Server Port # 16700 *

[T] Proxy Server Settings

Corca | [ Aonh

Dialog Box: License Preferences

Help

Proxy Server Settings need to be set if your computer or network is behind a proxy. A
proxy serveris a computer that acts as an intermediary between the user's computer and
the Internet. It allows client computers to make indirect network connections to other

network services.

Using Proxy Server

Check this box to enable Proxy Server Settings and complete ALL of the following fields
accurately. This information would be provided by your network administrator.

Proxy IP

This is the IP Address for your Proxy Server. This information would be provided by your
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network administrator.

Proxy Port #
Enter the Port Number for your Proxy Server. This information would be provided by
your network administrator.

Proxy User
Enter the Proxy Server user name. This information would be provided by your network
administrator.

Proxy
Enter your Proxy Server password. This information would be provided by your network
administrator.

LAN Daemon Settings (for Network Licensing)

LAN Daemon Settings are used for Network licenses. On each client machine you would
need to enter the following information in the fields provided.

Using LAN Daemon

Check this box to enable LAN Daemon Settings and complete ALL of the following fields
accurately. This information would be provided by your network administrator. DO NOT
check this box if you are running a node-licked license. Node-locked refers to a single
user license.

The following message is displayed when this box is unchecked:

| License settings saved! The licensing system will be
re-initialized to enable licensing/re-licensing of product.

OK

Daemon IP
This is the IP Address of the server that hosts the license server. This information would
be provided by your network administrator.

Daemon Port #
Enter the port # being used by the license server. This information would be provided by
your network administrator.

Daemon User Name
Enter the user name used to set up the account on the license server. This information
would be provided by your network administrator.

Daemon
Enter the password used to set up the account on the license server. This information
would be provided by your network administrator.

[T] Network Authentication Service Settings
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Network authentication is a security process required when a computer on a network
tries to connect to the serverin order to use its resources. If the user's identity has been
stored by the server, entering a valid username and password completes the connection.

Using Network Authentication
Check this box to enable Network Authentication. Then complete the Service Server
Settings provided here.

Server IP Address
For Network Authentication, enter the Service Server's IP Address here.

Server Port #
For Network Authentication, enter the Service Server's Port # here.

[T] Troubleshooting and Messages
Here are some troubleshooting messages that you may encounter.
If you have node locked license activated and you select Using Lan Daemon, this will

display the following message and release your node locked license.

| License preferences are incompatible! Please change settings
inthe license preference dialog and try again.

If Using Lan Daemon is checked and you are entering a valid node locked activation code
in the license dialog, the following message is displayed. Make sure Using Lan Daemon
is unchecked before activating a node-locked license.

| License preferences are incompatible! Please change settings
in the license preference dialog and try again.
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Machining Methods

The Profile-NEST module includes the one most used 2% Axis machining method, 2/ Axis
Profiling. In Profile-NEST, this operation includes all of the same parameters available within
the MILL module.

5.1 2 Axis Profiling

I:l This method machines open and closed regions by tracing along one side of their

— contours. You can define offsets so that the tool makes multiple passes relative to
Profiling = the regions. Profiling can be used as a finishing operation after a Pocketing or Facing
toolpath, or it can be used alone.

[ 2% Axis Profiling Operation Example

An example of the Profiling toolpath is shown below:

2% Axis Profiling Operation

1] 2% Axis Profiling Stock Simulation Example

The stock simulation:

2% Axis Profiling Stock Simulation
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Create Machining Operations

Creating machining operations in the Profile-NEST module is a very simple process. You load the
part, the stock geometry if necessary, selects a tool, and specify the feeds and speeds to be used
in the Profiling operation. Generation of the toolpath begins when you select Generate from the
Profiling operation dialog. Once generated the Profiling operation will be created and displayed
under the Machining Job in the Machining Operations (Mops) Browser. Itis also displayed
graphically on the screen.

6.1 Machine Tool Setup

j‘g Machine  This option on the Program tab allows you to manually setup your Machine Tool
Definition.

[1] Machining Browser: Machine Menu Item
The dialog can be displayed by selecting Machine from the Program tab.

= g ! . 5
Profile-NEST| 3| Mest Simulate o & @
I Machine fﬂ Stock - ‘.' Work Zero Q Mesting Report

% Post % B3 nign » [0 2 1/2 Axis Profiling
E Sheets = Material _:1 Mesting Parameters

Machine Setup Stock Operations To Mest

Machine

y Machine Tool Setup

= tﬂ Operations to Nest
j Mesting Parameters

*xis Profilir-

Machining Browser: Machine menu item

6.1.1 Manual Definition

This dialog allows you to setup your Machine Tool Definition. Refer to each section below for
more information.

[T] Machine Tool Definition

Manual Definition
This option allows you to manually setup your Machine Tool Definition. Referto each
section below for more information.
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See Load From File, Machine Tool Setup for more information.

Machine Tool Setup >

tachine Tool Coordinate Systern Machine T ool Definition

(®) Manual D efinition Load From File
M achine Type
Murmber of Axes | 3 Axiz o

General Parameters

Tool Change Pt ||:|

s

S

L z|o =i
Output all coordinates in local Setup Coordinate System
Tranzlational Lirmits

i [500 31 (500 ) 2 [mo00 |3
Maw (5000 |5 v [s000 | z: Iy

Ath Az [Primary Axis) Parameters
1] = 1] = I =

- - -

Dialog Box: Machine Tool Setup - Manual Definition
11 Machine Type

Number of Axis
e Select 3 Axis for both 2% and 3 Axis machining methods.

1] General Parameters

For all Machine Types, the following General Parameters are available.
General Farameters

Tool Change Pr # |':|

s

SRaL

Sz Sl
Qutput all coordinates in local Setup Coordinate System
Tranzlational Lirnitz

SHEIIEIE
Szl D

Min: 3¢ |-200

“ |-2nn

-

= Y|2nu

-

Maw ® | 200

Tool Change Point

To define a Tool Change Point, specify a coordinate location in X, Y and Z. or use the
Pick button to select a point from your 3D model. The MILL module will output this

coordinate location for every tool change. Note that the tool change variables must
be configured in the Post Processor.

Output all coordinates in local Setup Coordinate System
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Check this box if the G codes need to be output in the Machine Coordinate System
(MCS) setup. Uncheck this box to output the G-code in the World Coordinate
System (WCS).

Translational Limits

This will be the Minimum X and Maximum XYZ direction Translation Limits allowed
by your machine tool. Note: These parameters are not applied and are reserved for
future use.

This will be the Minimum X direction Translation Limit allowed by your machine
tool. Note: These parameters are not applied and are reserved for future use.

6.2 Profile-NEST Geometry
6.21 Part Geometry

Part Geometry is the CAD design geometry that exists in the part file. This design data could
consist of both 2D and 3D data. Part geometry is utilized in the computation of toolpathsin the
module. Geometry is used in utilized differently in each of the machining operations in MILL.

2% Axis Profile Typically uses 2D wireframe geometry. 3D wireframe geometry is used in some
operations and the 3D surface and/or mesh data as well as the 3D features can be optionally used
for certain computations.

6.2.2 Stock Geometry
6.2.2.1 Box Stock

@ stock |~ You can define the raw stock model as a simple box by selecting the Box Stock option
from the Stock menu under the Program tab in Machining Browser.

[T] Machining Browser: Box Stock menu item
T 1 T,
Profile-NEST| 'f3| Mest | Simulate & i@

M Machine ﬁ Stock |~ ‘.' Work Zero E Mesting Report

xis Profiling

i Post

B Sheets
] Part Box Stock ]
Machine Setup Operations To Mest

Box Stock
I} g Parameters

=] Machin Delete Stock A
:y Machine - 3 Axis
:_;:i' Post - Laguna_BR_IO
I__d‘?' Fre-cl - Bo Stock

Machining Browser: Box Stock menu item
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1] Box Stock Dialog

Use this dialog to define your box stock. Corner position and dimension parameters are
provided. Referto the parameters below. When you pick OK, a stock model based on
your definition will be created and displayed.

Box Stock pod

Stock Geometny

Height (H)

k"f Length (L) O
X

Cormer Coordinates

xeld  [Hved [Tz R
Dimenzions

s Jm wBs J3 wpes

| Copy kodel Bounding Box |

] Ignore ‘wWireframe Geometry in Bounds Computation

k., || Cancel || Help

Box Stock Dialog

1] Starting Corner

Select a location from the dialog image to use as the origin to measure your stock from.
Forexample:

Set the Bottom South West corner of the Stock should serve as the origin to measured
from. The Stock shown on your display will dynamically update accordingly.
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Bottom SW

ED Corner Coordinates

Alternatively, you can enter the world coordinates to determine where the corner of the
Stock Box should be located. Your Stock Dimensions will be measured from this
coordinate point (Xc, Yc, Zc).

You can use the Pick button to select a point from your drawing or model.

Stock Corner Coordinates

[D Dimensions

You can use these fields to enter the Length (L), Width (W) and Height (H) of your desired
Box Stock.

Stock Dimensions

1] Copy Model Bounding Box

The system calculates the bounding box extents of the part model and displays the XY Z
Coordinate values under Dimensions L, W and H.

Calculate Bounding Box
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[T] Ignore Wireframe Geometry in Bounds Computation

If you check the box Ignore Wireframe Geometry in Part Bounds Computation, any
wireframe geometry in your part will be ignored when calculating the Part Bounds.

Make sure to click Copy Model Bounding Box after you check or uncheck Ignore
Wireframe Geometry in Bounds Computation.

6.2.2.2 Part Box Stock

a stock |~ You can define the raw stock model as a simple box that surrounds your part. This
option is available from the Stock menu under the Program tab in Machining

Browser.

[1] Machining Browser: Part Box Stock menu item

meile-NESTI'J:ﬂ Mest Simulate & & - & @
¥ Machine f_:ﬂ Stock|”| o™ Work Zero E Mesting Report
i Post Box Stock xis Profiling

E Sheets ig Parameters

) Part Box Stock
Machine Setup I}

Operations To Mest

= [[L Machin Delete Stock -
‘y Machine - 3 Bxis
:_E:i' Post - Laguna_BR_IC
ff] Stock - Box Stock
(= = : n

Machining Browser: Part Box Stock menu item

[T] Dialog Box: Part Box Stock

The system calculates the bounding box of the part model as the XYZ extents of
geometry of the part model. You can then define offsets in any of the three coordinate
directions to apply to the computed bounding box. The system will expand the bounding
box by the offset amount in each of the coordinate directions. When you click on the OK
button, a stock model based on your definition will be created and displayed.
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Part Bounding Box Stock >

Stock Geometny

£ offset (z)

X offset (x)
¥ offset (v)

Offzetz
=] =] =]
J I < IR AT = N2 LI =
Z Offzet Direction
(®) Both +7 and = (042 Orily () Z Only

[] Ignare Wireframe Geometry in Bounds Computation

k., || Cancel || Help

Dialog Box: Part Box Stock
[ Offsets

X Offset
Enter the X Offset value for sizing your Part Box Stock. The system will expand
the part model bounding box by the offset amount in the +/- X direction.

Part Offset X

Y Offset
Enter the Y Offset value for sizing your Part Box Stock. The system will expand
the part model bounding box by the offset amount in the +/- Y direction.
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o

vA
Part Offset Y
Z Offset

Enter the Z Offset value for sizing your Part Box Stock. The system will expand
the part model bounding box by the offset amount in the +Z direction.

¥

Z

Part Offset Z

[T] Z Offset Direction
Both +Zand -Z / +Z Only / -Z Only

You can choose to apply the Z Offset value entered in this dialog to either the +Z
direction, the -Z direction or both +Z and -Z directions.

[T] Ignore Wireframe Geometry in Bounds Computation

Check this to ignore all 2D and 3D curve geometries present in the part from
stock bounding box computation.

6.2.2.3 Delete Stock

a stock [~| You can delete the stock geometry by selecting Delete Stock from Create Stock
Model under the Program tab in Machining Browser. The stock model can also be
deleted by selecting the stock entry under Machining Job, right mouse button click and select
Delete Stock.

[T] Machining Browser: Delete Stock menu item
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Profile-NEST| 'f3| Mest | Simulate o & @
M Machine @ Stock |~ “ Work Zero a Mesting Report
i Post Box Stock xis Profiling

E Sheets ig Parameters

] Part Box Stock ]
Machine Setup Operations To Mest

-4 Machin Delete Stock N
3 Machine - ¥ Bxis
:_;:i' Post - Laguna_BR_IO
fij Stock - Box Stock
A- " —

B L

Delete Stock Menu Item

6.3 Operations to Nest (Setup)

ﬁ This icon allows you to modify the orientation of the Operations to Nest Setup (referred to as

the Machine Coordinate System or MCS) in relation to the Work Coordinate System (WCS),
the active Construction Plane or another curve or surface.

[1] Coordinate Systems Triad Displays

The Operations to Nest Setup (MCS) is displayed on your screen as a triad Blue
representing the Z-axis, Red representing X-axis and Green representing the Y-axis. The

W(CS (World Coordinate System) is displayed the same way as but with XYZ axis letters
labeled on top of it. These are shown below.

X

MCS wcs
[T] The Default Operations to Nest Setup (MCS)

When the Profile-NEST module is loaded a default Operations to Nest Setup (MCS) is
defined for you that is aligned with the World Coordinate System (WCS).
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=1, Machining Job
y Machine - 3 Axis
:_;,.‘i' Post - Laguna_BR_IC
ﬁ Stock - Box Stock
Dperations to Mest

55?

Mesting Parameters

2 1/2 Axis Profiling (Part 1)
21/2 Axis Profiling (Part 2)
2 1/2 Axis Profiling (Part 3)
21/2 Axis Profiling (Part 4)
He-sted Sheets

[ ] Sheet1

[ ] sheet2

[ ] Sheet3

Operations to Nest (Setup)

R m'L 'l

m
EHHHH

[ To Modify the Default Setup Orientation

In PRO and higher configuration, the orientation of the default Operations to Nest Setup
(MCS) can be modified by double-left-clicking on the Setup icon to load the Setup dialog
(shown below).

-1, Machining Job

y Machine - 3 Axis

:2 Post- Laguna_BR_IQ

ﬁ Stock - Box Stock
Qx@ @ EE

W "4 Mesting Pararneters

[ 2 1/2 Axis Profiling (Part 1) Y
[ 2 1/2 Axis Profiling (Part 2)
[ 21/2 Axis Profiling (Part 3)
[ 2 1/2 Axis Profiling (Part 4)
Nested Sheets
o[ | Sheet1
[ ] sheetz

[ ] Sheet3

Double-left-click to Edit Setup

MCS/WCS

EHHIH

=

Editing an Operations to Nest Setup (MCS) displays the Setup dialog. This dialog allows
you to modify that Setup orientation.
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Setup

Define Setup Orientation

1
~

Aligr ka

I kachine Coordinate Syztem |

[Geometmy

Active Conzstruction Plane

Select Surface: % Select Planar Curve: %

Set Orientation parallel ta

Whiorld &= Wharld wharld £

Fotate about

Spin Angle: :

# Az T Az £ Bz

Fezet to Original

Generate Cancel Save

Dialog Box: Setup, Define Setup Orientation tab
[T] Align to

Use the controls in this section to align the Z Axis of the Operations to Nest

Setup (MCS).
Aligr ta

i achine Coordinate Sustem

Geometry

Select Surface: | B

Active Conztruction Plane

Select Planar Curve: | B

Help

62
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[T]

1]

Machine Coordinate System
This will orient the clearance plane parallel to the defined Setup XY (Work
Coordinate system).

Active Construction Plane
This will align the new Setup Coordinate System to the active view's
Construction Plane (C-Plane).

Select Surface
Use this option to align to a selected surface. The surface can be selected
by using the Pick button.

Select Planar Curve
Use this option to Align To a selected curve. The curve can be selected by
using the Pick button.

Set Orientation Parallel To

Use the controls in this section to align the Z Axis of the Operations to Nest
Setup (MCS) to one of the WCS (World Coordinate System) axes.

Set Orientation parallel to

Whorld = World v Wiorld &

For the Set Orientation parallel to options, you can select either the World X
World Y or World Z buttons to along the MCS parallel to the select axis.

Rotate About

Use the controls in this section to rotate one axis or the Operations to Nest
Setup (MCS) incrementally by a defined Spin Angle.

Note: One click of either of these Axis buttons rotates the that setup axis by
one increment.

Rotate about
Spin Angle: Sl wwis ||| | Z dwis

Spin Angle

This is the incremental Spin Angle that is applied when the either the X Axis, Y
Axis or Z Axis buttons are selected from this dialog. The spin angle can be
positive or negative.

X Axis
Rotate the Machine Tool Coordinate System one Spin Angle increment about
the X Axis. Each pick of this button rotates one Spin Angle increment.

Y Axis
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Rotate the part one Spin Angle increment about the Y Axis. Each pick of this
button rotates one Spin Angle increment.

Z Axis
Rotate the part one Spin Angle increment about the Z Axis. Each pick of this
button rotates one Spin Angle increment.

[1] Reset to Original

Pick Reset to Original to reset the MCS orientation to the current WCS
orientation.

[T Things to Remember about Setups

n Setups cannot be edited in Xpress, Standard and Expert configurations.

n Selecting Setup edits the default Setup in Professional and Premium
configurations.

6.4 Align Stock

% Align| | Itis typical to need the ability to position stock geometry in some geometric

relationship with the part geometry. A typical scenario is that you have modeled the
part with a pre-determined origin. In such cases it would be desirable to locate the stock with
respect to the already positioned part without having to go through actually calculating the
transformation delta values.

[T] Machining Browser: Align Stock menu item

This dialog can be invoked by selecting Align and Align Stock from Program tab under the
Machining Browser.
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Profile-NEST| 'f3| Mest | Simulate & i@
M Machine f_:ﬂ Stock - “ Work Zero a Mesting Report
i Post #3 Align|-| (O] 2 1/2 Axis Profiling

E Sheets | arameters

Machine Setup align
—_— 5
= [[L Machin I},
3 Mach @ Align Part and/or Stock
iz Post-| align G‘Eﬁ;:ftr}r
@ Stock Stock
= E Operations to Nest

Lhesting T gt b

Set dperations To Mest
tock worldC.5 = ¢

Machining Browser: Align Stock menu item

[T] Dialog Box: Align Part and/or Stock Geometry

Once both part and stock geometry are loaded, use this dialog to perform the relative
positioning. Both Z and XY alignment of different faces of the part with respect to the

stock are possible. Select the necessary alignment options using the appropriate radio
buttons in this dialog.
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Align Part and/or Stock Geometry ot

Align Stock about Part

£ Alignrment

® Top (JCenter () Bottam

#1 Alighment
() Northwest () Marth () Morth E ast

() Midwest (®) Center (") Mid-E ast
() Southwiest () South () South East

[ ] Ignore wWireframe Geometry in Part Eounds Computation

Cancel Help

Dialog Box: Align Part and/or Stock Geometry

1] X Alignment

Top
Specify the Z Alignment of the Stock to be at the Top of the part. The Stock preview will
be dynamically updated on your screen.

Align at Top

Center
Specify the Z Alignment of the Stock to be at the Center of the part. The Stock preview
will be dynamically updated on your screen.
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Align at Center

Bottom
Specify the Z Alignment of the Stock to be at the Bottom of the part. The Stock preview
will be dynamically updated on your screen.

Align at Bottom

1] XY Alignment

North West
Specify the XY Alignment of the Stock to be at the North West of the part. The Stock
preview will be dynamically updated on your screen.

Top Center Bottom
North West North West North West

North
Specify the XY Alignment of the Stock to be at the North of the part. The Stock preview
will be dynamically updated on your screen.

Top Center Bottom
North North North

North East
Specify the XY Alignment of the Stock to be at the North East of the part. The Stock
preview will be dynamically updated on your screen.
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Top Center Bottom
North East North East North East

Mid-West

Specify the XY Alignment of the Stock to be at the Mid West of the part. The Stock
preview will be dynamically updated on your screen.

Top Center Bottom
Mid West Mid West Mid West

Center

Specify the XY Alignment of the Stock to be at the Center of the part. The Stock preview
will be dynamically updated on your screen.

Top Center Bottom
Center Center Center

Mid-East

Specify the XY Alignment of the Stock to be at the Mid East of the part. The Stock
preview will be dynamically updated on your screen.

Top Center Bottom
Mid East Mis East Mid East

South West

Specify the XY Alignment of the Stock to be at the South West of the part. The Stock
preview will be dynamically updated on your screen.
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R AL

Top Center Bottom
South West South West South West

South

Specify the XY Alignment of the Stock to be at the South of the part. The Stock preview
will be dynamically updated on your screen.

Top Center Bottom
South South South

South East

Specify the XY Alignment of the Stock to be at the South East of the part. The Stock
preview will be dynamically updated on your screen.

ey~
LA A

Top Center Bottom
South East South East South East

D:J Ignore Wireframe Geometry in Bounds Computation

If you check the box Ignore Wireframe Geometry in Part Bounds Computation, any
wireframe geometry in your part will be ignored when calculating the Part Bounds.

6.5 SetWorld CS

|@ Align|~ | You can set the location of the World Coordinate System (WCS) origin with respect

to the geometry. An alternative way of thinking about this is to transform all loaded
geometry to an appropriate location. This Locate WCS dialog offers you a variety of ways of
accomplishing this.

1] Machining Browser: Set World CS menu item

This dialog can be invoked by selecting Align and Set World CS from the Nest tab under
the Machining Browser.
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Prufile-NEST. Nest | Simulate & @

M Machine 6; Stock - “ Work Zero E Mesting Report
& Post 84 Align|-| [0 2172 Axis Profiling
Sheets & | grameters
Machine Setup align Set dperations To Mest
B Stock WorldC.S | = F
-4 Machin
y Machine - 3 Axis % Locate World Coordinate
sz Post- Laguna_BR_IO System
= Locate WCS
[Ei Stock - Box Stock World ¢.5 -PeEtE

= E Operations to Nest
5 3 Mesting Parameters
Machining Browser: Set World CS menu item

[1] Dialog Box: Locate World Coordinate System

The Locate WCS dialog appears as shown below
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Locate Werld Coordinate System >

Locate WS with respect to Part or Stock,

S

Set WS Ongin
() Pick (@) SettoStock Box () Set to Part Box

Zem Face
(®) Highest Z CiMidZ () Lowest

Zern Pogition

(®) Morth \west () Morth () Morth E ast

) et () Center () East
() Southwest () South () South East

s |0 R s Z |02 :RE

Cancel Help

[T] setwcs origin

You can set the origin by explicitly picking a point or can set it with respect to the Part or
Stock geometry bounding boxes.
Pick

If you select the Pick option, the button with the pick cursor close to the bottom of
the dialog will be activated. You can then click on this button to graphically select a point
to align the WCS origin to.

X/Y/Z/ Pick

You can set the X, Y, Z values of the WCS (World Coordinate System) manually
here. Optionally, you can select the Pick button to select a point. It's XYZ
coordinate values will be added to this dialog.
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Set to Stock Box

Selecting this item will activate the Zero Face and the Zero Position sections of the
dialog. You can then select the Z and the XY locations, with respect to the bounding box
of the stock geometry, by choosing the appropriate selections in the dialog.

Set to Part Box

Similar to the previous selection, selecting this item will activate the Zero Face and the
Zero Position sections of the dialog. You can then select the Z and the XY locations, with
respect to the bounding box of the stock geometry, by choosing the appropriate
selections in the dialog.

[T] Zero Face

Make a selection to locate the Z zero of the WCS. This is referred to as the Zero Face.
Highest Z

This tells the system that the Zero Face should be at the Highest Z location of either the
Stock or Part, depending on which Set WCS Origin option is selected.

Mid z
This tells the system that the Zero Face should be at the Mid Z location of either the
Stock or Part, depending on which Set WCS Origin option is selected.

Lowest Z
This tells the system that the Zero Face should be at the Lowest Z location of either the
Stock or Part, depending on which Set WCS Origin option is selected.

[T] Zero Position

Make a selection to locate the Zero Position of the WCS. You can select one of the
cardinal directions listed below.

North West
Locate the WCS in the XY North West position.

PSP

North West (High/Med/Low 2)

North
Locate the WCS in the XY North position.

PSP

North (High/Med/Low 2)

North East
Locate the WCS in the XY North East position.
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TS

North East (High/Med/Low Z)
Mid-West
Locate the WCS in the XY West position.

S

West (High/Med/Low 2)
Center

Locate the WCS in the XY Center position.

Center (High/Med/Low Z)
Mid-East
Locate the WCS in the XY East position.

el

East (High/Med/Low Z)
South West
Locate the WCS in the XY South West position.

e

South West (High/Med/Low 2)
South
Locate the WCS in the XY South position.

S

South (High/Med/Low Z)
South East
Locate the WCS in the XY South East position.
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South East (High/Med/Low Z)

6.6 Material

3= material  This allows you to assign a Material for Stock geometry. You can select a material
from the available list of materials. Each Material has a texture that is applied to the
stock geometry and can be displayed during simulation. Material is also used as a variable within
the Feeds & Speeds Calculator.

[T] Machining Browser: Material menu item

This dialog can be invoked by selecting Material from Program tab under the Machining

Browser.

Profile-NESTll'm Mest Simulate & & @
I Machine ﬁ Stock * W™ Work Zero Q':[ Mesting Report
i% Post 83 nign - [0 2 1/2 Axis Profiling

E Sheets = Material E‘j‘ Mesting Parameters

Machine Setup Stock Operations To Mest

B4 Machin  poerial

y I

r ;: Define Stock Material
& pd S

(J) Stock=poxSTOCK

R Orcriors o new
I

FA N ing ™ amete-e

Machining Browser: Material menu item

[T] Dialog Box: Select Stock Material

Choose Stock Material dialog appears as shown below.
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Select Stock Material 4

Choose Stock Material

Material File

FeedsSpeedsDatalMCH.xml

Material

ALUMINUM - 2024 w

Material Texture

Source folder for material files:

aramData MecSoft Corporation

Cancel Help

Dialog Box: Select Stock Material

Dj Material File

This points to file where all materials are defined.

This xml contains the list of materials, texture, feeds and speeds. The file is
located under Materials folder in RhinoCAM. (C:\ProgramData\MecSoft

Corporation\RhinoCAM 2018 for Rhino x.x\Materials).
The Materials folder contains the following files

e FeedsSpeedsDatalNCH.xml

e FeedsSpeedsDataMM.xml

If part unitis set to Inches, RhinoCAM automatically loads

FeedsSpeedsDatalNCH.xml and when part unit is set to MMV,

FeedsSpeedsDataMM.xml is loaded.

The material file is an .xml file format, which can be edited using any text editor

to add newer materials.
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[T]

[T]

See Feeds and Speeds for information on the format of the material file and
adding new materials.

Material

This lists all materials available in the selected Material File. Selecting a
Material from the list displays the material name and material texture.

Material Texture

A preview of the Material Texture is displayed for reference.

[T Material Texture Visibility

&;5 Once you have defined a Material, click the Material Texture Visibility icon under
Program or Simulate tab in Machining Browser to display the texture applied to the
stock model.

Note that the Material texture only displayed when Machining Job or the Operations to
Nest is selected from the Machining Browser.

=-{, - Machining Job

=

m

6.7 Work Zero

Mested

‘y Machine - 3 Axis Sheet

:;Ej- Post - Laguna_BR_IC
@ Stock - Box Stock

Z Mesting Parameters

S

«f Pats

SC

| | 21/2 Axis Profiling (Part 1)

| | 2172 Axis Profiling (Part 2]

| | 21/2 Axis Profiling (Part 3) Material

|} 2172 Axis Profiling (Part 4) Texture

[ ] Mested Sheets

|:| Sheet 1 Material Texture Displayed

o[ ] Sheet2
[ ] Sheet3

Operations to Nest (Setup)

=

‘.' work Zero, Work Zero defines the work coordinate (part or stock) origin. This is typically done
after the MCS orientation is defined under Setup. Work Zero translates the MCS
origin from the Setup to the desired location. This can be set to any location on the part or stock

geometry.

Refer to Machine Tool Coordinate System for orienting the Machine Coordinate System.
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[T] Machining Browser: Work Zero menu item

[1]

The Work Zero dialog can be invoked by selecting Work Zero from Program tab under the
Machining Browser.

Profile-NEST| 'fJ  Nest | Simulate & & @

I Machine f}ﬂ Stock * o™ Work Zero g':[ Mesting Report
i% Post B Align ~ @Izsz&Pmﬁnng

E Sheets = Material E‘j‘ Mesting Parameters

Machine Setup Stock Operations To Mest

= [[L Machining Job Work Zero
y Machine - 3 Axis

2 Post- Laguna_BR_
fi Stock - Box Stock
R Op<retion o Nt
5 Mesting Parameters
el A2 s Profiling (Pe1)

‘l Set Current Wark:
Coordinate Zero

Machining Browser: Work Zero menu item

Dialog Box: Work Zero

Set Work Zero dialog appears as shown below. You can set the origin by explicitly picking
a point or can set it with respect to the Part or Stock geometry bounding boxes. Each
option is described below.
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Work Zero >

SetWark Zero

(JPick () SettoStock Box () Set to Part Box

Zerm Face
Higheszt &£ bid & Lowest £
Zern Pogition
Marth Y'est Marth Marth E ast
West Center East
South West South South East
® 0 =kl . z0 L

| gnore YWireframe Geometry in Part Bounds: Computation

[ ] Output 'work Offset
Wwhork, Offzet Register Mumber: |54 :

Cancel Save Help

Dialog Box: Work Zero
[ pick

If you select the Pick option, the button with the pick cursor close to the bottom of
the dialog will be activated. You can then click on this button to graphically select a point

to set the Work Zero to.
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® PFick () SettoStock Bow () Set to Part Box

Zem Face
Highest £ blid & Lowest &
Zer Pogition
M arth Wwest Harth Marth E ast
Wlest Center East
South West Sauth South Ea*
%0 v Sz SR

lanore “Wireframe Geormety in Part Boundz Computation

Work Zero Pick Option

y Youcan use object snaps located in Visual CAD’s status bar to snap to part
geometry.

[1] Set to Stock Box

Selecting this item will activate the Zero Face and the Zero Position sections of the
dialog. You can then select the Z and the XY locations, with respect to the bounding box
of the stock geometry, by choosing the appropriate selections in the dialog.

() Pick | @) Setto Stock Box | () Set bo Part Box
Zem Face

(® Highest Z (I MidZ () Lowest 2

Zern Pogition
(@ Motk wWest () Marth () Morth E ast
) wiest i) Center i East

() Southwest () South () South East
el ! Sz 04 = t;s
lanare YWireframe Geormetny in Part Bound: Computation
Work Zero - Set to Stock Box
(] Set to Part Box

Similar to the previous selection, selecting this item will activate the Zero Face and the
Zero Position sections of the dialog. You can then select the Z and the XY locations, with

respect to the bounding box of the stock geometry, by choosing the appropriate
selections in the dialog.
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(JPFick () SettoStock Boy |@ Set to Part Box
Zero Face

(®) Highest Z iMidZ i Lowest Z

Zer Pogition

(®) Morth \west () Morth () Morth E ast
) et () Center () East
() Southwest () South () South East

w BTS2 vy (311322 Z [0 LR

-

[ Ignore ‘Wireframe Geometry in Part Bounds Computation

Work Zero - Set to Part Box
Selecting Ignore Wireframe Geometry in Bounds Computation ignores all 2D and 3D
curve geometries present in the part for bounding box computation.
[T] Output Work Offset

This allows you to specify a Work Coordinate Offset number which is then output in the
posted code. This is set under Work Offset Register Number.

Work offsets are used to set work piece origin on CNC machines and this is assigned to a
register number G54, G55 etc...

Cutput ‘work, Offset

Whork, Offzet Register Mumber: :

Work Zero - Output Work Offset

For example:
e Tooutput G54, set the Work Offset Register number to 54.

e The Work Offset Prefix “G” is set in the post-processor generator.

[T] Generate

Click Generate and Work Zero is now listed under Operations to Nest and also under

Nested Sheets in Machining Browser. The MCS origin is now translated to the specified
location.
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=1, Machining Job
‘y Machine - 3 Axis
i Post- Laguna_BR_ICQ
@ Stock - Box Stock
o--Fid Operations to Nest

S |

E Mesting Parameters
‘.' Work fero ‘—
| | 21/2 Axis Profiling (Part 1)
| | 21/2 Axis Profiling (Part 2)
| | 21/2 Axis Profiling (Part 3)

| | 21/2 Axis Profiling (Part 4)
= [5_| Nested Sheets

‘.' Work Zero +

[ ] Sheet

[ ] sheetz

[ ] Sheet3

Work Zero displayed in the Machining Browser

-~

[ Work Zero Example
In the example shown below Work Zero is set to
e Set to Stock Box
e Zero Face —Highest Z

e Zero Position —South West
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Work Zero

SetWark Zero

() Pick (@) SettoStock Box () Set to Part Box
Zerm Face

() Highest Z IMidZ (® Lowest 2

Zero Pogition
(JMorth'west () Motk () Morth E ast
i wiest () Center () East

i Southwest () South (®) South East
v |36 | *Zz00 - t;s

- -

| gnore YWireframe Geometry in Part Bounds: Computation

Qutput “wéark, OFfzet

Whorlk, Offzet Register Number: :

Cancel Save Help

Dialog Box: Work Zero

World (WCS) @
>

Work Zero (MCS) —

Example Work Zero

82
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6.8

Machining Regions

Machining Regions also referred to as Control Geometry are curves or surface boundary edges that
already exist in your model or separate new curves you create that coexist within your part. Be
sure to read the Important Notes below before proceeding.

[ Important Notes about Machining Regions

n Machining Regions must be selected before they can be used in a

Profile operation. It should be noted that regions can be created
and be presentin a part file but if they are not selected in a Profile
operation they will be ignored during toolpath computation. So
creating a region does not make it active; you must use one of the
Selection buttons on the Control Geometry tab of the Profile
operation dialog before Generating the toolpath.

n Multiple regions can be defined and selected in a Profile
operation. This is a very powerful feature and affords you fine
control over the manufacturing process.

n There are two ways of working with Machining Regions. The first

is by creating/deleting regions in a part file. The second is
selecting regions from the Profile operation dialog. These are both
unique processes and each have independent methods of being
invoked.

[ Machining Region Types by Product Configuration

.. Product Configuration
Machining

Region Type Xpress Standard Expert Professional Premium
(XPR) (STD) (EXP) (PRO) (PRE)
Curve .ﬂ" ',.r y"’ u’r u’r
Surface Boundary/Edge v o v v v
Flat Area 4 v v v v
Avoid Regions y"r '; u’f u’f

[T] Creating Regions

To create regions select the Curve option from the main menu. This will bring up the
curve creation tools in Rhino. You will be able to create rectangular, circular and
polygonal regions using this toolbar. Regions can also be extracted from the 3D model
using the tools available under Curve > Curve From Objects & Curve Edit Tools.
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6.8.1

1]

1]

[T]

Multiple Regions

Multiple and nested regions can be selected, but not regions that intersect. Nested
regions are handled according to the following rule: The tool will remain inside an outer
region and outside an inner region. A region within an inner region is considered to be
an outer region. In the following picture, the shaded areas are where the tool motions
occur:

Outer Region

Inner Region

Outer Region

Inner Region

Multiple Regions

Deleting Regions

Regions can be deleted using the tools available in Rhino .

Editing Regions

Regions can be deleted by selecting them graphically in the display window or by using
Edit > Select Objects tools from the menu bar. To delete the graphically selected
regions, select Edit > Cut. You can also hit the Delete key on the keyboard to delete the
active selections.

Selecting Curve/Edge Regions

You can select curves & edges as machining regions for any Profile operation. You can pre-select
the regions or select the Select Curve/Edge Regions button from the Control Geometry tab of the
Profile operation dialog.

1] Criteria for selecting Regions

e Openand closed curves (Lines, Polylines, Arcs, Circles, Polycurves) can be
selected as regions in Profile operations.

e Thereis nolimit on the number of curves that can be selected as regions.

e Closed curves can be nested within each other.

© 2020 Mec Soft Corporation



85 RhinoCAM Profile-NEST 2020 Reference

[T] Selecting Regions

L¥ select a part Region first before selecting an Avoid Region. Regions can be selected
using one of the following options:

1. Selectregions using the Select button on the menu bar.
2. Selectregions graphically in the display window.

3. Multiple regions can be selected by pressing the CTRL button. These selected
regions can be used to create Profile operations. The regions can be unselected
using the None option (Select > None).

4. Selectregions when creating or editing a Profile operation from the Control
Geometry tab of the operation's dialog box shown below using:

Multiple Selections:

Multiple regions can be selected by pressing the CTRL button. These selected regions can
be used to create machining operations. The regions can be unselected using the None
option (Select >None).

Chain Selections:

You can automatically select a chain of curves or edges by pressing the <Shift>key while
performing a left-click selection. This works with any curves or edges that are connected
end-to-end.

Chain Select (<Shift> + Left-click)

6.8.2 Selecting Flat Area Regions

For flat areas, you can select the Select Flat Area Regions button from the Control Geometry tab of
the Profile operation dialog. Refer to the example below.

[T Flat Area Selection Example

Example
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Selecting a Flat area Feature for Profiling Profiling Toolpath generated for the Flat Area Feature

6.8.3 Selecting Avoid Regions

You can define regions to be avoided by the cutter during machining. These regions will be
defined by 2D curves and selected from the Avoid Regions sub-tab of the Control Geometry tab of
the Profile operation dialog.

[T] Important Notes about Avoid Regions

[ select curve(s) as a Part Regions first, before selecting an avoid
region.

n Note that the toolpath uses the avoid regions as trim regions.
Which means, the toolpath will be trimmed by the avoid
regions after generation.

[T Example of Avoid Region
Toolpath is Trimmed at the Avoid Region

Avoid
Region

Example of Avoid Region

© 2020 Mec Soft Corporation



87 RhinoCAM Profile-NEST 2020 Reference

6.8.4 Editing Regions

In order to use machining regions in a Profile operation, they must be first selected and made
active. This can be done in several ways.

[ Types of Regions
Here are the types of machining regions you can choose from:

1. PartRegions
These are part curves that drive the location of the tool. Defined from the Part
Regions sub-tab of the Control Geometry tab for each operation.

2. Avoid Regions
These are 2D curve regions to be avoided by the cutter during machining. They
are defined from the Avoid Regions sub-tab of the Control Geometry tab for each
Profile operation.

[ Editing Regions

Once a Profile operation is created, new regions can be selected or existing regions can
be removed from the operation as well.

To edit the list of regions used in an existing Profile operation, expand the folder
corresponding to the Profile operation in the Machining Browser window. Then double-
click on the Control Geometry icon (1) or on the Profile operation folder (2). This will
display the Control Geometry tab for that operation.

= Machining Job
¥ Machine - 3 Axis
¢ Post- Laguna_BR_ICQ
f‘:ﬂ Stock - Box Stock
= ti’ Operations to Nest

Z Mesting Parameters

(= 2 1/2 Axis Profiling (Part 1)
ﬂ Control Geometry +
[ Flatmili: 0.25 1

2 ? Feeds/Speeds

€I Clearance
Parameters
To Edit Control Geometry
Now you can edit the list of regions using:

e Remove All to remove all the selected regions.

e Move Up/Move Down - these allow you to move a selected Drive Region Up or
Down in the list

© 2020 MecSoft Corporation



Create Machining Operations 88

e Remove Active by selecting a region from the list of Selected Machining
Region(s)

e Selectregions using the Select buttons in the dialog.

[T] Displaying Regions
The display of the regions in the part file can be toggled on/off using the Layer Manager.

[T Saving/Loading Regions

Rhino allows you to save/export regions as curves in 3dm, Dxf, Dwg & other supported
formats. Such a file can then be loaded into any part file to generate machining
operations. To access the Export and the Import functions look under the File menu bar
entry.

[T Dialog Box: Control Geometry tab, MILL Operations
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6.9

2 1/2 Axis Profiling >
Advanced Cut Parameters Cornerning Parameters Sorting Mesting Parameters
Clearance Plane Cut Parameters Cut Levels E ity /E it
Contral Gearmetry Taoal Feeds & Speeds

Fart Regions  Awoid Begions

#  Selected Machining Region(z)]
1 DnveRegion 1
2 [DriveRegion 2
3 DriveReqgion 3 -
4 DriveReqgion 4 : /-’ 0 L
5  DiriveReqgion &
6 DriveReqgion B
Part
Regions . Awvoid
Ihn-} Wy Region
'F:!_ e \
. .| W /\/ .
Move Up | [l Move Down \\\- - I
> BRemovesll | 2 Remaove Active

Rg Select Curves/Edoge Regionz

Select Surface Boundary

by
Rs Select Flat Area Regions
5

Select Pre-Defined Reagions

Cancel Save Help

Profile Operation Dialog Box: Control Geometry tab

Cutting Tools

MILL module allows you to define, use and archive various types of milling and drilling tools. The
tool types that are currently supported are Ball, Flat, Corner-radius or bull, VeeMill, Chamfer,
Taper, Face, Dove Tail, Fillet, Lollipop, and User Defined.

[T Tool Types by Configuration
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Xpress | Standard Expert Professional Premium

(XPR) | (STD) (EXP) (PRO) (PRE)
Ball Mills v v v v v
Flat Mills v v v v v

Corner Radius Mills

= o oX| <= 0 0 @
<
<
<,
<,
<

Vee Mills
Chamfer Mills v v v v
Taper Mills v v v v
Face Mills v v v v
Dovetail Cutters o v v v v
Fillet Mills ' v v v v
Lollypop Cutters 0 v v v v
User Defined Cutters | |2 | v v v v

6.9.1 Create/Select/Edit Tools

I To create a tool, you either selects the Create/Edit Tool option under the Tools tab in
Machining Objects Browser or alternatively by selecting the Create/Edit/Select Tool button
under the Tool tab in the machining operation. This brings up the following dialog box that you
can utilize to create and edit tool definitions.

Note: See Cutting Tools for a list of tools supported by Profile-NEST.

1] Create/Select Tools Dialog

1] Dialog Box: Create/Select Tools
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Create/Select Tool n
/B AV HHYELIVOZBBTNNREY
Tocks n Sessien Holder Taper Praperties Feeds & Speeds
JATS4FL [1.050 Loc | -
HZZFLIES0Lec) Holder Huolder Mateiisl CARBIDE ~
250 4FL [ T50Loc ) Diameler el Cut Material Color -
250 2FL[.T50Lee ) - =
87 4FL 650 Loe) Shank - Noambes of Fes |4 -
BT 2FL [ E50 Lioc ) Diameter Tool Mumber 0 :
375 4FL [ 520Loc ) ) r =
ATS2FL( EQ'IJL:] I fufush Register 0 2
250 2 FL \Wood Roughter | Cutcom Fiegister |0 =
370 2 FL Wood Riousghber . -
250 Rasp Dii Port Side Grinds I e el ° -
105 Dueemel 1732 Bal | Coolart | None -
B 2FL[ 50Loc) T : .
D62 2FL[.365Lec ] ,
S 4FL[ S0Loc)
106 Diemel 053 146 Tool Diameter
105 Dreamal 0281732 r
062 4FL[ .35 Loc Hame | 3754FL[1.080Loc )
0312 2FL (150 Loc | Hodder Da.  HolderLen  H. Taper
03Z4FL(150Loc) 15 = ] o 2
ShankDis Toollen  Shoubderlen |
035 2 [1s 3 [1s 3
Fitelen  ToolDia
108 (2l [oam [z
e ot Mew To Save Edis o Tool Delete Tool
< > Cencel Help
Dialog Box: Create/Select Tools
L] Create Tools Toolbar
The tool icon bar on the top of the dialog displays the all various types of tools
available in MILL module. Different tool types can be defined by selecting the
desired icon in the dialog box.
Note: The actual tools that you will see listed in this toolbar will depend on what
module and what configuration you are currently running.
M E | I | i3 N
8/ 88V 4998 L4 T NEREPY
Create Tools Toolbar
L] Tools in Session

The dialog box shows the tool name of the current selection if there is one
selected in the list-box under Tools in Session. If there is no selection then the
tool name will be the name used for a new tool definition. The list box itself lists

all of the tools of the corresponding type.
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Create/Select Tool
g/ 28/ Vg8 @ LI @O BB|E
Toolz in Session

AR 4 FL[1.050 Lo

Halder

A122FL[.850 Loc |

2504 FL[.750 Loc | Eﬂﬁfgter Length |-
2502 FL[.750 Lac ] A, = EE
187 4 FL[ .E50Lac ] Shank

J87F 2FL [ .650 Loc Diarmeter EE
375 4FL[.520Loc ) Toal

375 2FL[.520 Loc ) Length
280 2 FL Wood Raoughter Shoulder _T_

370 2 FL “Wood Raoughter Length 1
2080 Razp Drill Paint Side Grinder Flute H—+
105 Dremel 1/32 Ball Length

125 2FL[.530Lac ] [+
062 2FL[.365 Lac l

1254 FL[.530 Loc

106 Dremel .053 1/16 Tool Diameter
jDDEEEi"ET?_'EDEEEBS:i Name [.3122FL (850 Loc] | |
0212 2FL[.150 Lac ) Holder Dia.  HolderLen.  H. Taper L
0312 4 FL {150 Loc ] =i Sk 2]

Shank Dia.  Toal Len. Shoulder Len.
0375 2 2 dojoes 2

-

Flute Len. Tool Dia.

4|k

0es 2 [0.37

£ >

Toolsin Session

1] Standard APT Parameters for Tool Definition

The geometry definition of the tool contains edit boxes for the diameter, corner
radius, taper angle, flute length and the tool length. These definitions are
standard APT parameters for the tool definition. The flute length denotes the
cutting length while the tool length denotes the total length of the tool to the
tool holder.

[1] Save/Edit/Delete Tool

Save As New Tool
Saves a new tool and lists under Tools in Session. If a tool of same name already
exist under Tools in Session, Save as New tool button will be grayed out.
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Save Edits to Tool
Saves edits or changes made to tool parameters.

n When you Save Edits to Tool, each Mop in the Machining Job tree that
uses the Load from Tool option, will be updated with the new
feeds/speeds for that tool automatically.

Delete Tool
Deletes the selected tool. A tool will not be deleted a tool if is being used in a
machining operation.

[T] Tool Preview

As the tool geometry is defined, a preview of the tool is shown in the graphics
window.

Tool Preview

[1] The Properties tab

The Properties tab to the right side of the tool preview allows you to set the Tool
Material, the Cut Material Color (for that Tool), Number of Flutes in the tool, Tool
Number, Adjust Register, Cutter Compensation Register, Axial Offset, Coolant
Type. The Number of Flutes is used in Feeds & Speeds calculations. The tool
number is used when post processing toolpaths.

n The Cut Material Color selector will allow you to assign colors to each Cut

Material created by this tool. seta you Save Edits to Tool, each Mop in
the Machining Job tree that uses the Load from Tool option, will be updated
with the new feeds/speeds for that tool automatically.
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Cut Material by Color

Properties  Feeds & Speeds

Material | CAREIDE v|

Cut M atenal Calar
Murmnber af Flutes

T ool Hurmber

EE\@H@H@|H

Adjuzt Reaister

Cutcom Register 0

dusial Offset
Coolant | MHane o |
Comments

The Propertiestab

[T The Feeds & Speeds tab

The Feeds & Speeds tab located next to Properties tab allows you to set feeds and
speeds for each tool.

Refer to the Feeds and Speeds section for additional information.
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Cut Depth

¥ You can set the Cut Depth specific for each tool you create. If you set this
value here, you will see a Depth From Tool icon next to the Rough Depth/Cut

parameter in the Cut Levels tab of each operation where it applies. Selecting the

icon will use this value for Rough Depth/Cut. If Cut Depth is left at 0in this dialog,

the icon will not appearin the Cut Levels tab.

Properties  Feeds & Speeds

Spindle Parameters
Speed 14667 = RPM

Direction (@ Cw () COW

Feed Rates [in/min]

Plunge Approach  Engage
23468 2] (117342 BB 2

Cut Retract Departure
11734 2 (B8 2 (234682

Transfer
(® Use Rapid () Set 23468 2

Feed Rate Reduction Factors

Plunge between levels 100

First ¥ pass 100

S 1L || 1L

—
[
=

3
i

Bottamn £ Lewvel

Cut Depth 0 ==

Load from File ..

The Feeds & Speeds tab

[T] Taper Angle

Taper Angle is set for VeeMill, ChamferMill and TaperMill. This angle is the
included angle. For a 60 degree taper tool, the Taper Angle is set as 30.
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Taper Angle

(1] Flat Diameter Examples

Flat Diameter is set for ChamferMill and TaperMill. When Flat diameter is set =0,
the tip converges to a point.

To define a ball mill with taper, set Flat diameter =0and Corner Radius =tool
radius.

In the example shown below, Flat Dia =0and Corner Radius = 0.25. This creates a
0.5” ball mill with a 10 degree taper.
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Huolder Taper .-*f

Haolder-«
Diarmeter

Shank
DiameterT

Shaulder
Length

Caorner L,

Radius
Flat Diameter Taper Angle

Mare |'|I:|5 Dremel 1432 Ball [ 3432 shank

Holder Dia.  Holder Len.  H. Taper
IE= L 2 | 2

- -

Shank Dia.  Tool Len. Shoulder Len.
jno2e 2 175 ooz 2

Flute Len.  Flat Dia. Corner Rad.
jno2e : (oo i o042

Taper Angle
| 10 =

Properties tab for Taper Mill

Taper Mill

In the example shown below, Flat Dia =0.5 and Corner Radius =0.25. This creates a
taper tool with a 10 deg taper angle, 0.5” flat diameter and 0.25” corner radius.
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Huolder Taper .-*f

Haolder-«
Diarmeter

Shank
DiameterT

Lenagth
Shaulder

Length

carner
Fadius —/‘

Flat Diameter

Mame |Ta|:-erh-1ill1

Holder Dia.  Holder Len.  H. Taper

L3S (12 2D 2
Shank Dia.  Tool Len. Shoulder Len.
12722 2| |2 S5 B
Flute Len. Flat Dia. Corner Rad.
1 Sps 2 jos 2
Taper Angle

|1n 2

Properties tab for Taper Mill

6.9.1.1 Feeds & Speeds
6.9.1.1.1 FS Calculator

This loads the Feeds & Speeds values from the Feeds & Speeds Table file. This will display the
Load Feeds from Table dialog box to make your selections.

[1] Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to the Feeds &
Speeds tab. The plunge, approach, engage, retract and departure feeds are determined
using a percent of the cut feed. The percent to use for transferring the computed cut
feed can be set under Feeds & Speeds Preferences.
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Feeds/Speeds >

Load Feeds from Table

[rata from T able

Stock Matenal ALUMIMUR - 2024 w

T ool Material CAREIDE w

Surface Speed 1600 : ft. ity
Feed/Taoath 0.004 =

Input Y ariables

Tool Diarmeter: | 0.5 = in
# af Flutes: 2 =

bl awirmurn Limits for Compution

tax Spindle Speed 14000

RPk

Aff*] ] A *

bax Cut Feed 200 it

Computed W anablez

Spindle Speed 12223 : RPM

Cut Feed [Cf) 97 = inmin

Cancel Help

Dialog Box: Load Feeds from Table

[T] Data from Table

These selections and calculations are defined in a feeds and speeds data file which can
be edited to add newer materials. See our blog post How to Customize Materials Data
for Feeds & Speeds Computation for more details.

Stock Material
Select the desired Stock Material from this list to use in Feeds/Speeds calculations.

Tool Material
Select the desired Tool Material from this list. CARBIDE, HSS CERAMIC are supported.
The material is used in the tool's Feeds/Speeds calculations.

Surface Speed

Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.
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Feed/Tooth

Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.

[T] Input Variables

The input variables Tool Diameter and Number of Flutes are automatically loaded based
on the tool selected for the operation. Based on these parameters, the program
computes Spindle Speed and Cut Feedrate. Changingthe Spindle Speed modifies the
Cut Feedrate.

[T] Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values. Once these two
values are set, the Spindle Speed and Cut Feed calculated by this dialog will not exceed
these values even if you attempt to enter higher values into the Computed Variables
fields. To exceed these values, change them here or you must edit the operation or tool
parameters manually. This value WILL NOT exceed the High Value set in your current
post-processor selection. To do so you must edit the post using the Post-Processor
Generator (Program tab > Post > Current Post Processor > Edit > Feedrate > High Value).

[T] Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based on the
selections made in this dialog but will not exceed the values set in the Maximum Limits
for Computation section of the dialog. These values are then assigned to the active
toolpath operation or tool. You can override either of these variables and the other will
update automatically. Since this dialogis a Feeds & Speeds Calculator, you cannot
override both values. To do so, you must edit the operation or tool parameters
manually.

6.9.2 Load Tool Library

bﬁ]’ This allows you to load a previously saved tool library.

1. From the Tools tab of the Machining Objects Browser, select the Load Tool Library button
Note: The actual icons you see in this dialog will depend on what module and what
configuration you are currently licensed to operate.
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r Tools
| @rﬁr e Al

bt L

Mo Sort 15, | ¥

Machining Objects Browser, Load Tool Library

2. Browse to the folder, double click on the desired file to load it into Profile-NEST module.
The folder of the last loaded tool library is displayed by default.

3. The loaded tool list will be seen under the tool button in the Machining Objects Browser.
r Tools
K r % |
I | Gor O &7 V|l
=)

°H

Flathdill 0.25
375 4FL [ 2550 Loc |
375 4FL [ 1.150 Loc |
375 4FL [ 950 Loc |
375 2FL [ 1.180 Loc |
375 2FL [ 900 Loc |

(Y YRy Ry Y

Mo Sort = +%+ ik

The loaded tool list will be seen under the tool button in the browser

4. To perform the Edit, Rename, Cut, Copy or Paste operations on any of these tools, hit the
right mouse button while highlighting the desired tool.

6.9.3 Unload Tool Library

l“«r This allows you to unload the current Tool Library. From the Tools tab of the Machining
' Objects Browser, select the Unload Tool Library button.

Note: The actual icons you see in this dialog will depend on what module and what configuration
you are currently licensed to operate
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r Tools
T3 oy "7y
ER)! g ~

Unload Tool Library

Flattill: 0.25
375 4FL [ 2550 Loc )
75 4FL (1150 Loc )
375 4FL[.950 Loc )
A7 2FL (1180 Loc )
375 2FL (.900 Loc )

B

(JeY ey sy ey ey

Mo Sort 15, | ¥

Machining Objects Browser, Unload Tool Library

6.9.4 Add ToolLibrary

You can right-click on a Tool listed in the Mobs Browser to Add the Tool to an exiting Tool Library
*.csv data file.

Note: The actual icons you see in this dialog will depend on what module and what configuration
you are currently licensed to operate

I'r Tools

TGy

> JEETGA NI

375 4F

Rename
75 4F
Rt

cfb ':th

75 2F

Copy
22 EE] Paste

Add to Library [},

Preview
25':' 4 | [y [ Sy S Sy |

¥ 1

I0E0C O X QX QC XX X

Add Tool to Library

6.9.5 Select Tool from Library

ﬁr This allows you to select tools from a previously saved tool library.
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1. From the Tools tab of the Machining Objects Browser, select the Select Tools from Library
button ﬁr

Note: The actual icons you see in this dialog will depend on what module and what
configuration you are currently licensed to operate

\ fg Tools
T ey vy

S

Select Tools from Library i
Flathilror2s

From the Tools tab of the Machining Objects Browser, select the Select Tools from Library
button.

2. The list of tools will now be displayed under Select Tools(s) from list dialog and you can
drag and drop the tools from the selection list to the cutting tools browser.

m Tools Select Tool(s) from List

r @f @r l‘:.r lﬁ] Drag & Drop selections inta main Tool Browser window

=0 125 4FL [ 750 Loc | A
125 2FL [ 750 Loc |
125 4FL [ 520 Loc |

Flattill: 0.25

J25 2FL [ 520 Loc )

]
l 125 2FL( 5201
54 ( oc) 375 4P [ 520 Loc |

““ “&ﬁz L[ .5201.0¢)
P

o/

The list of tools will now be displayed under Select Tools(s) from list dialog.

3. To Edit, Rename, Cut, Copy or Paste on any of these tools, use right mouse button click
after selecting the tool under Tools tab.
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r Tools
T e vy
= Itm Tools

e Flati 025

o §.125 2FL [ 520 Loc |
Edit
® N
Rename
Erlb ':th

Add to Library

Preview

Right-click to edit aTool in your Tool List

6.9.6 Save Tool Library

Lﬁr This allows you to Save your tools to a Tool Library file. The file can be saved in the desired
directory and read in when required.
1. From the Tools tab of the Machining Objects Browser, select the Save Tool Library button
v
Note: The actual icons you see in this dialog will depend on what module and what
configuration you are currently licensed to operate
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]' Tools
TG & e Ty
= Lm ) |bga~.-'e Tool Library I -
Flattill: 0z

375 4FL [ 2550 Loc )

75 4FL (1150 Loc )

375 4FL[.950 Loc )
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From the Tools tab of the Machining Objects Browser, select the Save Tool Library button

O QX X 0 10 X

2. Use the File Save As dialog box to save the Tool Library file. The folder of the last saved
tool library is displayed by default.

File Types Supported: MILL Module supports *.vkb and *.csv. tool library file formats. Both
formats save and load tools with the feeds and speeds assigned for each tool.

3. Specify afile name and click Save.

6.9.7 ListTools

Ilﬂﬂ This allows you to List and Print your tools.

Y
1. From the Tools tab of the Machining Objects Browser, select the List Tools button Ig .

Note: The actual icons you see in this dialog will depend on what module and what
configuration you are currently licensed to operate
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1] Tools
AT g = TN
:

m
° &

B

Flattill: 0.25

375 4FL [ 2550 Loc )
75 4FL (1150 Loc )
375 4FL[.950 Loc )
A7 2FL (1180 Loc )
375 2FL (.900 Loc )
A7 4FL(1.050 Loz )
A122FL(.850 Lo ) v

Mo Sort & *‘%4, f

From the Tools tab of the Machining Objects Browser, select the List Tools button

O QX X 0 10 X

2. The button brings up all the tool properties associated with the tools currently recorded in
the current session. From the Cutting Tools Information dialog box, you can view or Print
your Tool List.
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From the Cutting Tools Information dialog box, you can view or Print your Tool List
3. Pick OK to close the dialog.

6.9.8 UserDefined Tools

Available in: Xpress Standard Expert Professional Premium

v v v v

The MILL module allows creation of special purpose tools like form tools. These can be defined
under user defined tool in the create/select tool dialog.

y User Defined Tools can be used in Drill operations to allow multi-
function tools to be defined as user defined tools and used in
drilling operations. See User Defined Tools for more information.
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1] Steps to create a user defined tool

Steps to create a user defined tool

Steps to create a user defined tool:

1. Draw half the tool profile from the top view (XY plane of the world coordinate
system) as shown in the picture above and then join the curves to form a single

curve.

2. Make sure one end of the curve (tool tip) is at origin (0,0) and the other end at
X0, Y<value>.

3. From the Tools tab under the Machining Objects Browser, click Create/Select
Tool and select User Defined Tool.

888 YiduuLieon

click Create/Select Tool and select User Defined Tool

IU\II\EI'H

4. Click Load selected tool profile curve.

Load selected tool profile curve ... |
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Holder Diameter

Mame |JzerDefhdill

Holder Dia.  Holder Len.
1 =) 15 =]

| el | -

Load zelected tool profile curve ... |

Click Load selected tool profile curve

5. Specify the Holder Diameter, Holder Length, Properties, Feed & Speeds and Click
Save as New Tool.

[T] Preview your Tool

Preview Tool allows you to preview the highlighted tool in the workspace as seen below.
The tool is previewed at the WCS origin.
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6.9.9

Preview your Tool

Cutter Compensation

Cutter Compensation is used typically to compensate for the difference in the dimensions of the
actual cutter used in machining and the cutter used for programming in MILL module. For
example, if the cutter used in programming in MILL module is 0.25 inches and due to tool wear the
actual cutteris only 0.24 inches in size, you can compensate for this in the controller rather than
having to re-program the operation again. Refer to the 2% Axis Control Matrix for information
about which toolpath operations support Cutter Compensation.

[T] Enabling Cutter Compensation
To do this you need to do the following:

1. Turn cutter compensation on in the Operation Set Compensation to Auto/ON or
Control/ON.
Note: Setting the Compensation to Auto/ON or Control/ON has the same
behaviorin MILL module.

2. Specify the cutter compensation value and the compensation registerin the
controller (the controller needs to be capable of doing this)

[ A few things to watch out for:
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n Cutter compensation makes sense only in 2-1/2 axis operations.
If you are using roughing (pocketing and facing) the
compensation will be turned on only in the final passes.

n Make sure you are not using Zig-Zag cut traversal in any of the
methods that you want to turn compensation on.

n Make sure you have a linear motion for the controller to turn on
the compensation value on. If your first motion is an arc the
controller will not be able to turn on the compensation. Thus, in 2-
1/2 axis profiling, make sure there is a linear entry motion for the

controller to be able to turn compensation on.

[1] Select the Post Processor from the Post Processor generator

Select the Post Processor from the Setup tab in Machining Browser by selecting Utilities
and Post Processor generator.

( Pest-Processcr Generabor  Haas_ with cut_cemp.spm E

Gereeal
Stat/E el Citter Compensation Leit
;:l‘pl:moe [SEQ_PRECHARTSEQNUMIGATG_CODE | -JHEXT _HOMMIL_ ] YTHEXT_NORMDL ] DITOOL_NUs]
Speie
Fead Aste
Hiction
Crcla
HedealSorsl
Mt iz Mofion
L M otaon Slant/E rud Cratter Comgeansation Fight
#1- Cycles |SEQ_PRECHARTSEQNUMIGAG CODE | =HEXT ROMMDL ] YTHEXT_NONMDL_] DTODL_NUM]
Wipg
W

Citer Comgesriaation 0N
[SEQ_PRECHARTSEQMNUING S0[G_CODE | =JHEXT_HOMMDL_x]THEST_NOKMDL ]

Post Processor generator

6.10 Feeds and Speeds

The following Feeds & Speeds tab is displayed for all Mill operations. It allows you to select the
appropriate Feeds & Speeds for the current Mill operation. In this tab, Spindle Parameters and
Feed Rates can be specified. Speeds & Feeds can also be loaded from a File or from the Tool.

[1] Feed Rates Explained
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Feed Rate is one of the most important factors to consider when
implementing any CNC strategy. Simply put, feed rate is the speed
at which the cutter engages the part and is typically measured in
units/minute. Suggested cut feed rates will vary depending on the

type of material you are cutting (i.e., aluminum, steel, wood, acrylic, etc.), the material
of the cutter (carbide, high speed steel, ceramic, etc.) and many other cutting factors
including desired surface and the characteristics of the CNC machine itself.

Read the full article...

[T] Dialog Box: Feeds & Speeds tab

Foughing Cut Levels Facing Entry/E it

Control Geometmy Tool

Spindle Parameters

Speed BOO0 = RPM

Direction (Cn' () Cow

Feed Rates

Plunge [Ff] 20 = in/min
Approach [&f] (48 = ifdrmin
Engage [Ef] 45 = infmin

Cut [CF] B0 = infmin
Fetract [Fif] 73 = in/min
Departure [Df] |30 = ifdrmin

Transfer [TF] (@) Uze Rapid () Set
120 > indmin

Feed Rate Reduction Factors

Flunge bebween levels a0 =
Firgt =7 pazs 100 =
Bottom 2 Level 100 =

Load from T ool Load from File ..

Generate

Advanced Cut Parameters

Feeds & Speeds Clearance Flane

Coolant

MHaone

i

i

Cancel Save

Dialog Box: Feeds & Speeds tab,2 Axis Drag Knife

Help
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[T] Spindle Parameters

These parameters refer to the spindle on your machine.

Spindle Speed
This is the rotational Speed (S) of the milling spindle expressed in RPM.

Spindle Direction (CW)
This sets the spindle rotation to be Clockwise (CW).

Spindle Direction (CCW)
This sets the spindle rotation Direction to be Counter Clockwise (CCW).

[T] Feed Rates

These are the feedrates (in Units/Min) that will be applied to the current toolpath
operation. If the values are currently populated from your Tool definition (Load from
Tool), Feeds & Speeds table (Load from File) or from your Knowledge Base, you can
override them for this operation.

Plunge (Pf)
This is the rate is the feed before the tool starts to engage in material. This is always
vertical.

Approach (Af)

This is the Approach (Af) feedrate (in Units/Min) used to prepare the cutter just before
it starts to Engage into material for cutting. Approach motions are dependent on the
method of machining.

Engage (Ef)
This is the Engage (Ef) feedrate (in Units/Min) used when the tool is Engaging the
material just prior to cutting.

Cut (Cf)
This is the Cut (Cf) feedrate (in Units/Min) used when the tool is Cutting material.

Retract (Rf)
This is the Retract (Rf) feedrate (in Units/Min), when the tool is performing a Retract
move away from material.

Departure (Df)
The is the feedrate (in Units/Min), when the tool Departs from the material.

Transfer (Tf) Use Rapid

This is the Transfer (Tf) feedrate (in Units/Min) used for Transfer motions. If you select
Use Rapid the posted G-Code will output a rapid motion (GO) with no feed rate. Note:
For more accurate machining time estimates, use the Set option and enter the feed
rate to use.

Transfer (Tf) Set
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This is the Transfer (Tf) feedrate (in Units/Min) used for Transfer motions. If you select
Use Rapid the posted G-Code will output a rapid motion (GO) with no feed rate. Note:
For more accurate machining time estimates, use the Set option and enter the feed
rate to use.

Feed Rates Reduction Factors (Hole Operations Only)

This section of the dialog allows you to specify Feed Rate Reduction Factors for specific
tool motions.

Plunge between levels
This is a percentage of the Cut (Cf) feedrate to use when the tool is plunging between Z
levels.

First XY Pass
This is a percentage of the Cut (Cf) feedrate to use on the first XY cut motion when the
toolpath uses the full width of the cutter.

Coolant

Here you can override the Coolant that is specified by the Tool. Coolant can be set to
Flood, Mist or Through. Coolant codes are defined in the post processor generator
under Misc tab.

Load from Tool
Load the Feed & Speeds values that are saved with the currently selected Tool.

See: Create/Edit Tools

Load from File

This loads the Feeds & Speeds values from the Feeds & Speeds Table file. This will
display the Load Feeds from Table dialog box to make your selections.

[T] Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to
the Feeds & Speeds tab. The plunge, approach, engage, retract and departure
feeds are determined using a percent of the cut feed. The percent to use for
transferring the computed cut feed can be set under Feeds & Speeds
Preferences.
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Feeds/Speeds *

Load Feeds fram T able

Drata from T able

Stock Matenal ALUMIMUIM - 2024 w

T ool Maternial CAREBIDE w

Surface Speed 1600 : ftAmin
Feed/Toath 0.004 ="

[nput % ariables
Tool Diameter: | 0.5 =y
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Max Spindle Speed 14000 = EPM

b ax Cut Feed 200 = in/min
Computed Vanables

Spindle Speed 12223 s BPM

Cut Feed [Cf) 97 = in/min

Cancel Help

Dialog Box: Load Feeds from Table

[T] Data from Table

These selections and calculations are defined in a feeds and speeds data file
which can be edited to add newer materials. See our blog post How to
Customize Materials Data for Feeds & Speeds Computation for more details.

Stock Material
Select the desired Stock Material from this list to use in Feeds/Speeds
calculations.

Tool Material
Select the desired Tool Material from this list. CARBIDE, HSS CERAMIC are
supported. The material is used in the tool's Feeds/Speeds calculations.

Surface Speed
Selecting a Stock Material and Tool Material displays the Surface Speed and
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[T]

Feed/Tooth. This information is contained in a feeds and speeds data file
which can be edited to add newer materials.

Feed/Tooth

Selecting a Stock Material and Tool Material displays the Surface Speed and
Feed/Tooth. This information is contained in a feeds and speeds data file
which can be edited to add newer materials.

[ Input Variables

The input variables Tool Diameter and Number of Flutes are automatically
loaded based on the tool selected for the operation. Based on these
parameters, the program computes Spindle Speed and Cut Feedrate.
Changing the Spindle Speed modifies the Cut Feedrate.

[T] Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values. Once
these two values are set, the Spindle Speed and Cut Feed calculated by this
dialog will not exceed these values even if you attempt to enter higher values
into the Computed Variables fields. To exceed these values, change them
here or you must edit the operation or tool parameters manually. This value
WILL NOT exceed the High Value setin your current post-processor selection.
To do so you must edit the post using the Post-Processor Generator (Program
tab > Post > Current Post Processor > Edit > Feedrate > High Value).

[ Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based
on the selections made in this dialog but will not exceed the values setin the
Maximum Limits for Computation section of the dialog. These values are then
assigned to the active toolpath operation or tool. You can override either of
these variables and the other will update automatically. Since this dialogis a
Feeds & Speeds Calculator, you cannot override both values. To do so, you
must edit the operation or tool parameters manually.

The Milling Feeds & Speeds Calculator

Did you know that MecSoft’s MILL Module plug-ins have a built-in ¢
Feeds & Speeds Calculator? That’s right, you can ask the programto  *
suggest feeds & speeds values based on your current stock

material and active tool parameters! Once a Cut Feed is calculated,
you can then choose to automatically assign feed rate values for Al
the various toolpath motions in your operation including Plunge, -
Approach, Engage, Retract and Departure! The percentages of the

Cut Feed to assign are all controlled from the CAM Preferences
dialog. The Milling Feeds & Speeds Calculator...
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Read the full article...

(1] Customizing Feeds & Speeds

MILL module allows you to customize the feeds and speeds based on the stock material
being machined, the material of the cutter employed and also the operation type. This is
done by archiving your desired feeds and speeds settings in an external data file.

A default implementation of this table has been included with the RhinoCAM product
and can be found in a folder called "Materials" under the product installation directory.

This xml contains the list of materials, texture, feeds and speeds. The file is located
under Materials folder in the RhinoCAM install directory. (C:\ProgramData\MecSoft
Corporation\RhinoCAM 2020 for Rhino x.x\Materials).

Materials folder contains the following files
e FeedsSpeedsDatalNCH.xml
e FeedsSpeedsDataMM.xml

The Feeds and speeds file is an .xml file format, which can be edited using any text
editor to add newer materials. These values can then be recalled at any time to
compute the feeds/speeds to be used in the current program.

The format for this file is shown below.

<Units>Imperial</Units>

<FeedsSpeeds>

<Material>
<Name>Stock Material</Name>
<TextureFile>Texture Bitmap</TextureFile>
<FeedsSpeedsRecord>Operation type, Tool Material,

Surface Speed, Feed per Tooth</FeedsSpeedsRecord>

</Material>

</FeedsSpeeds>

An example entry is shown below.

<Material>
<Name>ALUMINUM - 2024</Name>
<TextureFile>ALUMINUM.bmp</TextureFile>
<FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00,
0.0200</FeedsSpeedsRecord>
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<FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00,
0.0200</FeedsSpeedsRecord>

<FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>
</Material>

n If part unit is set to Inches, MILL module automatically loads
FeedsSpeedsDatalNCH.xml and when part unit is set to MM,
FeedsSpeedsDataMM.xml is loaded.

[T] More on Customizing Materials Data

Note: This blog post is intended for advanced users who are »~-&a
familiar with XML text editing and have administrative access to o ok Zee g s - R
their Windows Operating System. MecSoft’s CAM plug-ins have a i ‘:f""’ﬂ ) ‘}’ “ b
built-in Feeds & Speeds Calculator that can suggest Spindle Speeds =~

and Cut Feed Rates based on your stock material and active tool -
parameters! However, what if you are cutting stock material thatis | ;..o
currently notin our Materials Library? Or what if you don’t like Qpesion:

what is currently assigned for the material of your choice in the

Materials Library? This post will show you how to customize MecSoft CAM to add and
manage multiple material files as well to add your own stock materials. If you are new to
MecSoft’s CAM plug-ins, you can review my earlier post on the Feeds & Speeds
Calculator and how it works.

Read the full article...

6.10.1 Load from File

This loads the Feeds & Speeds values from the Feeds & Speeds Table file. This will display the
Load Feeds from Table dialog box to make your selections.

[T] Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to the Feeds &
Speeds tab. The plunge, approach, engage, retract and departure feeds are determined
using a percent of the cut feed. The percent to use for transferring the computed cut
feed can be set under Feeds & Speeds Preferences.
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Feeds/Speeds >

Load Feeds from Table

[rata from T able

Stock Matenal ALUMIMUR - 2024 w

T ool Material CAREIDE w

Surface Speed 1600 : ft. ity
Feed/Taoath 0.004 =

Input Y ariables

Tool Diarmeter: | 0.5 = in
# af Flutes: 2 =

bl awirmurn Limits for Compution

tax Spindle Speed 14000

RPk

Aff*] ] A *

bax Cut Feed 200 it

Computed W anablez

Spindle Speed 12223 : RPM

Cut Feed [Cf) 97 = inmin

Cancel Help

Dialog Box: Load Feeds from Table

[T] Data from Table

These selections and calculations are defined in a feeds and speeds data file which can
be edited to add newer materials. See our blog post How to Customize Materials Data
for Feeds & Speeds Computation for more details.

Stock Material
Select the desired Stock Material from this list to use in Feeds/Speeds calculations.

Tool Material
Select the desired Tool Material from this list. CARBIDE, HSS CERAMIC are supported.
The material is used in the tool's Feeds/Speeds calculations.

Surface Speed

Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.
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6.11

Feed/Tooth

Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.

[T] Input Variables

The input variables Tool Diameter and Number of Flutes are automatically loaded based
on the tool selected for the operation. Based on these parameters, the program
computes Spindle Speed and Cut Feedrate. Changingthe Spindle Speed modifies the
Cut Feedrate.

[T] Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values. Once these two
values are set, the Spindle Speed and Cut Feed calculated by this dialog will not exceed
these values even if you attempt to enter higher values into the Computed Variables
fields. To exceed these values, change them here or you must edit the operation or tool
parameters manually. This value WILL NOT exceed the High Value set in your current
post-processor selection. To do so you must edit the post using the Post-Processor
Generator (Program tab > Post > Current Post Processor > Edit > Feedrate > High Value).

[T] Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based on the
selections made in this dialog but will not exceed the values set in the Maximum Limits
for Computation section of the dialog. These values are then assigned to the active
toolpath operation or tool. You can override either of these variables and the other will
update automatically. Since this dialogis a Feeds & Speeds Calculator, you cannot
override both values. To do so, you must edit the operation or tool parameters
manually.

Clearance Plane

The clearance plane is an XY plane wherein all transfer motions between a retract and engage
motion takes place. In the case of 4 axis operations, the clearance plane is a cylinder and defined
along the axis of rotation. Typically you would define this plane at a certain safety distance above
the part geometry. This is done to prevent the tool from touching the part being machined during
transfer motions since these motions usually use a very fast or rapid feed rate.

[T Dialog Box: Clearance Plane tab
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Cut Parameters Cut Levels Engage/Retract Advanced Cut Parameters
Contral Geometry Tool Feeds & Speeds Clearance Plane

Clearance Plane D efinition

£ Stock Max £

(®) Automatic

() Part Max Z + Dist 0.25 zl
() Stock Max Z + Digt | 0.25 zl

() Absolute ZYalue | 0.25 EI

[ 1 Ignore ‘wireframe Geometry in Bounds Computation

Cut Tranzfer Method
' Clearance Plane

() Skim | / g
Skim Clearance [Z) |0 zl

(®) Clearance Plane

| Generate || Cancel || Save || Help

Dialog Box: Clearance Plane tab, similar for all Milling operations

D:I Clearance Plane Definition

This selection defines the Clearance Plane for the current toolpath operation.

Automatic
Allow the system to calculate a the clearance plane height automatically based on the

part and stock geometry.
A ~€— Ajtomatic

N

Automatic

Part Max Z + Dist
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Set the Clearance Plane height to the maximum Z height of the Part plus this added

distance.
v,
Dist
A Part Max Z
|
|
(|
Part Max + Dist
Stock Max Z + Dist

Select this option to use the Stock's Maximum Z height and then enter a Distance value
to add to this for the total Z height for the Clearance Plane.

L

Dist

IA A

~4€— Stock Max Z

Absolute Z Value
Select this to specify the absolute Z clearance height to use and then enter Z height
value. Be sure that the value you specify clears your part geometry.

a

Absolute Z Clearance

Stock Max + Dist

Ignore Wireframe Geometry in Bounds Computation

Check this box to ignore all wireframe geometry when calculating the Clearance Plane
definition. When checked, the Automatic and Part Max options for defining the
Clearance will be calculated from actual surface geometry.

Ignore Wireframe Geometry in Bounds Computation
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D:I Cut Transfer Method

This section allows you to control the tool's motions when it needs transfer to another
region to begin cutting.

Clearance Plane
Select this option to move the tool to the Clearance Plane and then perform the
Transfer motion to the next cut location.

‘ Clearance Plane
4 L4

Transfer at Clearance Plane

Skim

Select this option to perform transfer motions at a Skim plane. The system
automatically determines a safe height and then adds this Skim Clearance (C) to the
computed Z value to perform the Transfer Motions.

! Clearance Plang '

5

Transfer at Skim

1] Display of Clearance Plane for Milling operations

When the clearance plane dialog is active, specifying a clearance plane definition,
displays the clearance plane on the partin the view port.

Display of Clearance Plane for Milling operations
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6.12 Tools and Utilities

44 - CAMsystem Tools and Utilities provides access to G-Code Editor/Analyzer and Post
process generator. To access the functions, select the "Utilities" option under the
Machining Browser.

1] Tools & Utilities Menu

Profile-NESTl‘iﬂ Mest Simulate & | |- ek @
I Machine @ Stock ~  w™ Work Zero E M G-Code Editor/Analyzer ...
% Post 83 align ~ | [O)21/2 Axis Profiling

- ) —_— ) Post Processor Generator ...
E Sheets = Material =z Mesting Parameters

Machine Setup Stock Operations To Mest Explode Cabinet Design ...

Export to VCP

CAM System Utilities Menu Item

G-Code Editor/Analyzer ...

Loads the NC editor. By default this is set to notepad. This is specified under Program to
send posted file to which can be found in Set Post-Processor Options dialog. Refer to Set
Post Options for additional information.

Post Processor Generator ...
This Loads Post Processor Generator utility.

6.12.1 Shop Docs

This creates a Shop Document (i.e., a Setup Sheet) for the programmed part which includes screen
captures, estimated machining time, tool list and the machining operations list as well as stock
size and other important information. The document can be saved in HTML or Excel format.

[T] Select Shop Documentation from the Right-click Menu

Shop documentation can be generated by selecting Setup under the Program tab, right
click and select Shop Documentation.
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y Macl nﬁ Regenerate All

W Post Be postal

Elﬁ. Setug Simulate All
f mq_k‘ Save to Knowledge Base

|L 2 3 Information
Shop Documentation
e Delete All

Select Shop Documentation from the Right-click Menu
(Mill Module Shown)

=-{, " Machining Job

¥ Machine - 3 Axis
2z Post- Laguna_BR_IQ
ﬁ Stock - Box Stock
=] ﬁ Operations to Nest
5 Mesting Parameters
| | 21/2 Axis Profiling (Part 1)

| | 21/2 Axis Profiling (Part 2)

| ] 21/2 Axis Profiling (Part 3)

| | 21/2 Axis Profiling (Part 4)
=RFE] Nested Sheets

|:| ShE' Regenerate

5[] She(

|:| S-hEI 'Jl' Post

@ Simulate
q') Information

Shop Documentation

R

Rename

Select Shop Documentation from the Right-click Menu
(Profile-NEST Module Shown)

[T] The Setup Sheet is Saved and Displayed

124

You can select from an assortment of HTML Templates and an Excel Template from the
Save Shop Documentation File dialog and then pick Save to generate shop
documentation. This is saved as an external file and can be printed and handed over to
the operatorin preparation for the part to be machined on the CNC machine.
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Sample Shop Document using Template 2

6.12.2 Toolpath Viewer

Once a machining operation is created, you can step through the toolpath motions using the
Toolpath Viewer. To display the viewer, expand the operation folder in the Machining Browser
and right-click on the toolpath icon. The toolpath viewer is a dockable dialog bar that will be
initially docked below or next to the Machining Browser.

[ The Toolpath Viewer Displayed
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Profile-NEST| '} Mest | Simulate o & @

M Machine 6; Stock - “ Work Zero E Mesting Report
i Post B3 nign » [0 2 1/2 Axis Profiling

Sheets = Material L‘_j Mesting Parameters

Machine Setup Stock Operations To Mest

=}, Machining Job ~

3 Machine - 3 Axis
f2 Post- Laguna_BR_IQ
[Ei Stock - Box Stock
= E Operations to Nest
E Mesting Parameters
= [ 21/2 Axis Profiling (Part 1)
Control Geometry
[ Fiathill-0.25
Feeds/Speeds

% Clearance

Parameters |

-
Toelpath -‘
A In-process Stock \ o

BovP B “
i

Mop: 2 1/2 Axis Profiling (Part 1), #:922, T:0.22

Type Value w 2

L

1 MODE UNIT, 1

2 CUTTER  0.250000,0.000000,0.125000,0.000000,0,000000,0.000000

3 LOADTL 1,LENGTH, 4.000000

4 TLDATA 1,2,1,1,0.000000

5 CUTDIR  RIGHT

3 MARKER  TRANSFER

7  SPINDL RPM, 20000,CLW

8 GOTO 5.360334,26.236751,0.500000 v
£ >

The Toolpath Viewer Displayed

[ Previewing Setup Information in the Toolpath Viewer

If the Toolpath Editor/Viewer is currently displayed, selecting Operations to Nest will
display the setup location and orientation. Errors are flagged and displayed in the
toolpath editor/viewer if the setup orientation is not achievable.
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Profile-NEST "m Mest Simulate o i@

I Machine Ei Stock - “ Work Zero E Mesting Report
i Post B3 nign - [0 2 1/2 Axis Profiling

Sheets i= Material L‘_j Mesting Parameters

Machine Setup Stock Operations To Mest

=, Machining Job ~

y Machine - 3 Axis
22 Post- Laguna_BR_IQ
EEi Stock - Box Stock
o % -
"4 Mesting Parameters \ )
= [ 21/2 Axis Profiling (Part 1) \ @
Control Geormetry

\
[ Fiatmill-0.25
E Feeds/Speeds ‘
Clearance ‘
S Parameters .
Toolpath
@ In-process Stock i o
Esd P 2B :
Setup: Operations to Mest ‘
£ Type Value ;
1 SETUP Operations to MNest
M55 0.000000,0,000000,0,000000, 1,000000,0,000000,0,000000,0,

3 SETUFT... 0

Setup Information is displayed in the Toolpath Viewer

1] Previewing a GOTO Motion in the Toolpath Viewer

Select a GOTO motion in the Toolpath Viewer to view the tool motion for the generated
toolpath.

Make sure to turn on Iﬁ:‘I|Toolpath Visibility.
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Mogp: 2 1/2 Axis Profiling (Part 1), #:922, T:0.22 min Tool

* Type vie Tool Motion Coordinates *
3  MARKER CuT

4 GOTO 4625000, 26. 133202,0.000000

205 CIRCLE 5. 000000, 26. 13320 2,0, 00000, -0 SN0, -0, 00000, 1000
205 GOTO 5.375000, 26. 133202,0,000004 )(

207 CIRQE 5. QO0000, 26. 133202,0,000004

210 MARKER  TRAMSFER
211 GOTO 4.625000, 26. 133202,0, 500000

Perspective  Perspective  Front  Right &
Previewing a GOTO Motion in the Toolpath Viewer

6.12.3 Get Information

This displays a dialog box with the following information about the selected Operation, the Setup
or the entire Machining Job:

Status

Tool Name
Cut Feed Rate
# of GOTOs

Machine Time

1] Select Information from the Right-click Menu

Machining Operations Information can be viewed by selecting a Setup, right mouse
button click and left click on Information.
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=1, Machining Job

y Machine - 3 Axis

S_;‘,.i' Post - Laguna_BR_IC

Ei Stock - Box Stock

= 3 Operations to Nest

G Mesting Parameters
t_ 2 1/2 Axis Pre lﬁ Regenerate
| 212 Axis Prd ey poct
| 21/2 Axis Pr
Nested Sheets @ Simulate

[] Sheet Simulate Until
[ ] sheet2 -
|:| Sheet 3 ';llr_;j Information I}

N et

Select Information from the Right-click Menu

m
HHHEHHHH

[T Dialog Box: Machining Operations Information (MILL Module)

Machining Operations Information b
Mops Information
Hame Status Toal Tool 8  Cut Feed #of GOTOs Machine Time
2142 Boda Profiling (Part 1)  Clean Rathll: 025 2 14 67 in/min 1168 745 min
£ »
Prirt

I

Dialog Box: Machining Operations Information

[T] Optimize Machining Time Estimates!

In any MecSoft CAM product you can get an Information report ®
about a selected toolpath operation, a Setup or all operations in
the Machining Job. This report contains some very useful

information that includes the Tool #s used, the Cut Feed, the #of F Machine Tima
GOTO motions and most importantly, the estimated Machining S
Time. 10 20 min

Read the full article...
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6.12.4 Save as Defaults

Save As Defaults allows you to set default parameters for machining operations. This allows the
reuse of the machining parameters without having to enter the same parameters when creating
new machining operations on same part or new part files.

To Save As Defaults:

[T] Step 1: Create or Select a Machining Operation

Create or Select a machining operation under the Program tab in Machining Browser.

Profile-NEST|'f3| Nest | Simulate o & @

I Machine ﬁ Stock - “ Work Zero g':[ Mesting Report
i Post B3 nign - [0 2 1/2 Axis Profiling
E Sheets i= Material E‘j Mesting Parameters
Machine Setup Stock Operations To Mest
I8 Machine - 3 Axis A

I;;:i' Post - Laguna_BR_IC
ﬁ Stock - Box Stock
= E Operations to Nest
L"__Iﬁ Mesting Parameters

2 1/2 Axis Profiling (Part 1)

x|
—

21/2 Axis Profiling (Part 2)
21/2 Axis Profiling (Part 3)
21/2 Axis Profiling (Part 4)

EH--&--E
e

B o oo o

Step 1: Create or Select a Machining Operation

[T] Step 2: Save As Defaults

Right mouse button click on a machining operation and select Save As Defaults.
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=1, Machining Job
y Machine - 3 Axis
i Post- Laguna_BR_ICQ
@ Stock - Box Stock
= E Operations to Nest
IE Mesting Parameters
;
| )21/ 2 Axis P ﬁ Regenerate
| ] 212 AxisP|
[ 21/2 AxisP|

= E Nested Sheets Simulate

|:| Sheet 2 Simulate Until
|:| Sheet 3 {_;!;_:J Information

ﬁ Edit

Rename

- H--H

Post

3]

é Suppress

":"'.b Cut

2 con
[3 Paste

Save As Defaults

IjJ Properties

Step 2: Save As Defaults

[

[ Step 3: Specify a File Name

This displays a Save As dialog when a default knowledge base is not specified under Set
Machining Preferences.

Specify a file name Click Save.

This creates a default knowledge base for the profiling operation and is saved to the
DefaultKB.vkb file.

The saved knowledge base is automatically set as the default knowledge base to load
under Machining Preferences and the parameters defined in the knowledge base are
used when creating a new Profile machining operation.
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Default Parameters

Default Knowledge Base | DefaultkB w

Source folder for Enowledge Baze:

| C:A\ProgramD atahhecSoft Corporation®,

Set Machining Preferences

[T] Step 4: Things to Remember

y Save As Defaults can be set for all machining operation types.

y Once adefault Knowledge base is specified under Machining

Preferences, selecting Save as Defaults appends additional
parameters to the same Default knowledge base file.

y Ifadefaultfora specific operation type does not exist, the
system defaults are used.

Changing the parameters saving as defaults overwrites the
default parameters with the new one.

N

Multiple Default Knowledge bases can be created and saved.
This could come in handy when machining different types of
materials, which requires different cutting parameters. You could
create one for machining Steel, Aluminum, Wood, etc...

|

[T] Step 5: To Create a NEW Default Knowledge Base
To create a new default knowledge base:

1. Under Machining Preferences, change the Default Knowledge Base to Undefined.

Default Parameters

Default Knowledge Base: | Undefined w

Source folder for Enowledge Baze:

C:AProgramD ata'MecSaft Corparatian’,

2. Select a machining operation under the Machining Job, right mouse button click
and select Save As Defaults.

3. Specify a new file name and click Save. The saved knowledge base is now set as
the default knowledge base to load under Machining Preferences and the
parameters defined in the knowledge base are used when creating a new
machining operation.

n Only one Default Knowledge base can be loaded at one time. You
can change the default knowledge base to load before creating a
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new machining operation.

Default Parameters

Cefault Knowledge Baze | Undefined -
Source folder for Knowledge AvailableHoleMOpsiN
C:\ProgramD atahMecSoft C AvailableH oletd 0 petd b

DefaultkB

HoleFeaturek B

KB1

kB2
byl efaultk B

[ Refer to Machining Preferences for more information on selecting
a default knowledge base.

6.12.5 Post Process Generator ...

This utility can be used to edit and set up new post-processors to be used in RhinoCAM. The
default location of the Post File Names is selected. Pick Browse ... to select a different location.
Select a post processor from the list and click Edit to display the Post Processor Generator dialog
box.
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Post-Pracessor File Browser

Past File Mame

C:AProgramD atahid ecSoft Corporation®,

Select Post Processor to Edit:

Browse ...

AhilityS yatems
AbilityS petemzdTC
Acromatic100E
At

Acurite G2

Adept

Aeratech

Bhha
AllenBradiey
AMCE

Anilarm F300mk,
Anilarm S000M
Anilam-Cruzader M
Anilamn

Anilarn 3000k
Anilarmd200T
Animatics

APT CLS LK
BAPT CLS
AutoGray

Awiorm Precizion CHC
B T-ATC-AZMC
A EATCAZMC_MHK
B E-ATC

S -Fouter
AL

Az Code

Edit Cloze

Dialog Box: Post Process Generator

6.12.6 Explode Cabinet Design ...

This utility is ONLY available when the MILL or Profile-NEST module is loaded. You can use this
utility to explode and layout a Cabinet Design in preparation for the NEST or MILL modules. In the
example below, a Cabinet Design file Base.skp (created in SketchUp) was opened in Rhino. This
utility is then used to explode and layout each planer component in the 3D part. Once the
component geometry is exploded, you can arrange them for machining.

Help
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—-—

Explode Cabinet Design

[ This utility will be affected by the CAD system's Absolute
Tolerance. If you find that one or more geometry groups are

not being exploded, try increasing the CAD system's tolerance
settings and try again.

1] Explode Cabinet Design Menu Item

(Profile-NEST/'f3| Nest | Simulate o (26 @

i Machine a Stock *  w™ Work Zero M G-Code Editor/Analyzer ...
i Post @ Align = @EUEA:cis Profiling
Sheets = Material Mesting Parameters

Machine Setup Stock Operations To Mest Explode Cabinet Design ...

Post Processor Generator ...

Export to VCP

CAM System Utilities Menu Item

1] Dialog Box: Component Decomposition Control Parameters
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Explode Cabinet Control Parameters X
Geometry Selechon Comporent Placement
D) Explode ol viskie (8} Single row along X };
) Epiode selected Pick () Sngle column along ¥
() Explode only folowing layers () aeray with foed datance slong X
| () Aevay with fooed distance along ¥ D
g L]
O Space betweon componenis . =
u S 001 =
0 :
| =
LJ
Cutput peometry
(#) Create both X0 peometry and 20 curves (®) Create geometry in parent lyer
(ChCreate only 20 arves () Create geometry in new Lyer

(_)Create ordy 10 geometry

[ Hide eriginal geometry [ Place curves on one pane
[ Create separate group for each component ] sarve prometry colors

—— -

Dialog Box: Component Decomposition Control Parameters

[T] Geometry Selection

You can use this section of the dialog to limit the selection of geometry to explode.
You can select from the following:

Explode all visible
This option will select all visible geometry in the file for use with this utility.

Explode only following layers

This option allows you to select only geometry located on certain layers that reside
in the file. When this option is selected, all layers present in the file are listed. You
can check the box next to the layer(s) whose geometry you wish to select. The
Select All and Clear All button can be used to assist in selecting layers.

Explode selected
This option will allow you to select the geometry you wish to explode. With this
option selected, select the Pick button and then select the geometry to explode.

] Component Placement

These options allow you to control the array placement of components on the XY
plane after exploding. Select from the following:

Single row along X
Select this option to arrange all components in a single row in the X direction on the
XY Plane. Enter the Spacing between the components (refer to this value below).

Single column along Y
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1]

Select this option to arrange all components in a single row in the Y direction on the
XY plane. Enter the Spacing between the components (refer to this value below).

Array with fixed distance along X

Select this option to arrange the components along the X direction but at a fixed
distance. This means that if the next component exceeds the Fixed Distance a new
row is created. Enter the Spacing between components and the Fixed Distance
(refer to these values below).

Array with fixed distance along Y

Select this option to arrange the components along the Y direction but at a fixed
distance. This means that if the next component exceeds the Fixed Distance a new
row is created. Enter the Spacing between components and the Fixed Distance
(refer to these values below).

11 Space between components

These values are available depending on the Component Placement selection
above:

Spacing
This is the minimum distance between all components in the layout.

Fixed Distance

This is the maximum distance allowed for the component array. If a
component causes this distance to be exceeded it is moved to another row of
components.

Output Geometry

These options determine the type of geometry that is created and on what layer
they are placed. Select from the following:

Create both 3D geometry and 2D curves
If this option is selected, both 2D curves and 3D geometry is created.

Create only 2D curves
If this option is selected, only 2D curves are created.

Create only 3D geometry
If this option is selected, only 3D geometry is created.

Create geometry in parent layer
If this option is selected all 2D curves and/or 3D geometry is placed on the parent
layer of each component they were extracted from.

Create geometry in a new layer
If this option is selected all 2D curves and/or 3D geometry is placed on a new layer
with a system generated layer name.
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Hide original geometry
Check this box to hide the original component geometry.

Create separate group for each component
Check this box to separate each decomposed component into its own geometry
group.

Place curves on one plane
Check this box to project all curves onto the XY plane located at the world origin.

Create separate group for each component
Check this box to group each component separately.

Save geometry colors
Check this box to save the original geometry colors for each component.

1] More Information

The Explode Cabinet Design utility creates curves from 3D geometry to represent
features of interest in machining. The following features are detected and
curves associated with these features are created with predefined colors:

Through Holes RGB (255,0,255)
Blind Holes RGB (192,0. 192)
Through Pockets RGB (128,0,128)
Blind Pockets RGB (255,64,255)
Dados RGB (255,128,255)
Outer Periphery RGB (64,0,64)

6.12.7 Exportto VCP

You can use this utility to export the current RhinoCAM part file (*.3dm) to a Visual CADCAM part
file (*.vcp) retaining all part geometry and existing toolpath operation definitions.

Profile-NEST|'f3| Nest | Simulate o |- 8 @
I Machine 6]3 Stock - “ Work Zero 1= G-Code Editor/&nalyzer ...
% Post B3 nign - [0 2 1/2 Axis Profiling

Post Processor Generator ...
E Sheets i= Material C‘j Mesting Parameters

Machine Setup Stock Operations To Mest Explode Cabinet Design .

£l Machining Job Export to VCP %«
L I TR T S, T T

CAM System Utilities Menu Item - Premium Configuration shown
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6.13 Error Messages

The following are some error messages that you might encounter along with some tips when
generating toolpaths using RhinoCAM.

I:D Invalid tool definition.

iéi Invalid tool definition!

When creating/editing tools for all tools types make sure:
e Flute Length value is set smaller than Shoulder Length and Flute Length
e Shoulder Length value is set smaller than Tool Length

For Dove Tail tools check values for Tool Diameter, Flute Length and Taper Angle:

e Make sure these values are geometrically correct. Hint: Use the preview window
to see if a preview of the Tool for the specified values can be seen.

e See Create/Edit Tools.

[T] Could not find valid data. Internal algorithm failure.
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l . Could not find valid data. Internal algorithm failure.

For 2 axis Profiling, if the toolpath you are trying to generate is on the inside of a closed
curve/sketch check:

e |f Tool Diameter is larger than the width of the selected drive geometry

For 2 Axis Re-machining when the reference Tool Diameter under the cut parameters tab
is set to be the same or less than the Tool Diameter of the tool being used for the current
operation.

[T Object(s) used in Machining Operation(s)! Skipping them.

l . Object(s) used in Machining Operation(s)! Skipping them.

This error can occur when attempting to delete a tool that is currently associated with
machining operation:

e Inthe Machining Objects Browser, expand the Tool icon by selecting the + sign (

lﬁl ) to see there are any operations associated with that tool.

[T Out of Sync
l % Outofsync

This error message tells us that Rhino's database and RhinoCAM's are not in sync. This can
occur sometimes when you have other 3rd party plug-ins running in Rhino and the
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information is not shared between RhinoCAM & the other Rhino plug-in. Save the file in
Rhino, close and reopen RhinoCAM and regenerate the your toolpaths.
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Create Nested Sheets

Creating nested sheets of your toolpaths is performed automatically when a toolpath or the
Operations to Nest setup are regenerated. Be sure to first define your sheets using the Add
Sheets dialog and then define your Nesting Parameters.

7.1 Nesting Parameters

This dialog is used to define the sheets in your nest. Itis divided into two parts. The Sheets List at
the top and the Sheet Definition at the bottom. Defining a sheet and then selecting the Add
Sheet(s) button will create the sheet and add it to the list. Once listed, you can further control
parameters for the sheet defined by each column in the list. Referto each option listed below.

[ Nesting Parameters Dialog
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Mest Params >

Mesting Parameters

Part Options

Crientation Step Angle =
[] allow Part inside other parts
[ ] Use for engraving & sign making

Mesting Options

Distance Part to Part EI =
Digtance Part to Sheet IZI =
Owverflow Minimum Utilization %6 IZI =

High Accuracy Low Accuracy

Auto Tag Options

Tag nested curves automatically
Auto-tag Output
@ Annotation O Geometry

Tag text height =

Mested Sheets Layout
(®) along X () along Y () stack

Spacing between sheets :

Output Sorting
Sort MOps by Default V

Estimate # of Sheets Execute Mest

Cancel Help

Neting Parameters

[T] Part Options

This section controls how toolpaths are grouped and oriented.

Orientation Step Angle
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This allows rotation of the parts to nest and can be defined by specifying orientation step
angle. For example, specifying a Step Angle of 90 would allow rotation of all parts by a
step increment of 90, which could be 90, 180 or 270 to fill the sheet optimally.

Orientation Step Angle (True Shape Nesting)

Allow Parts inside other Parts
Check this box to allow parts to be nested inside the cutouts of other parts to maximize

sheet utilization.

Checked UnChecked

Use for Engraving & Sign Making

Check this box to use nesting for engraving & sign making. This allows the ability to nest
curves inside a hole as shown below. In this example, the outer rectangle would be the
part and the exterior & interior of the letters would be treated as holes.

Use for engraving & sign making

[:[:] Nesting Options
This section controls distances and accuracy of the nested toolpaths.
Distance Part to Part

This parameter defines the minimum distance between each part within a sheet. In the
example below, Distance Part to Part is set = 0.25. and Distance Part to Sheet=0.
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Distance Part to Part

Distance Part to Sheet
This parameter defines the minimum distance between parts to the edge of the sheet. In
the example below, Distance Part to Partis set =0.25. and Distance Part to Sheet =0.50.

Distance Part to Sheet

Overflow Minimum Utilization %

This defines the minimum percent of material utilization that is permitted on any sheet
in the nest. If set, then the % of utilization of material for each sheet must exceed this
value. If the % of utilization for any sheet is below this value, that sheet will be
suppressed from the nest.

Q This can be used to eliminate remnants on the last sheet
used which typically has the lowest % of utilization.

Accuracy

Move this slider to adjust the Simulation Accuracy (Standard, Medium and Fine). This
refers to the display accuracy. For example, in Polygonal Mode, more polygons will be
added, thus increasing display accuracy.

Auto Tab Options

Use this section to auto tag your nested toolpaths.

Tag Nested Curves Automatically
Tagging allows you to identify nested parts. Check this box to turn Tagging On.
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Auto Tag Output
Annotation - The tag number is shown on the screen as graphics display text only. The
height of the annotation text is dynamically controlled by the Tag Text Height value.

el

\/5 /2 7 /‘ﬂzzr
RN = R
[_h—| [_]3|—1
m"w—l [—]sl—l

Annotation Tagging

+A

Geometry - The tag number is created as geometry curves, which are selectable as
geometry. Enter the Tag Text Height for tagging.

Geometry Tagging

Tag Text Height

This value is the Text Height for each generated Tag. When Annotation is selected, the
Tagis only displayed graphically on the screen using the Text Height value. When
Geometry is selected, the Tag geometry will equal the actual Text Height value.

[T Nested Sheets Layout

Use this section to define the layout of the nested sheets.

Along X
Pick Along X to layout the nested sheets along the X direction (left to right) beginning at
the XY origin.

Along Y
Pick Along Y to layout the nested sheets along the Y direction (bottom to top) beginning
at the XY origin.

Spacing between Sheets
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If either Along X or Along Y is selected, enter a distance value for the Spacing Between
Sheets.

[ Output Sorting

Use this section to determine how the machining operations (Mops) are listed in the
Machining Job tree. The sorting is performed within each nested sheet folder in your
Machining Job.

Sort Mops by
Select a sorting method:

Default
Mops are sorted in the order they appear in your Operations to Nest setup.

Tool Size ASC
Mops are sorted by ascending tool size (smaller tool diameters first).

Tool Size

Mops are sorted by descending tool size (larger tool diameters first).

(1] Estimate # of Sheets

Select this button and the system will estimate how many sheets are needed and allow
you the opportunity to update your sheet count.

Estimated # of Sheets >
# Mested Sheet Estimated # of Sheets
1 Sheetl 3

Ipdate Sheet Count

Estimate # of Sheets

[1] Execute Nest

Pick Execute Nest to calculate the final Nest based on all parameters and selections you
have made. You are then moved to the Preview Nest tab automatically.

7.2 Add Sheets to Nest

This dialog is used to define the sheets in your nest. Itis divided into two parts. The Sheets List at
the top and the Sheet Definition at the bottom. Defining a sheet and then selecting the Add
Sheet(s) button will create the sheet and add it to the list. Once listed, you can further control
parameters for the sheet defined by each column in the list. Referto each option listed below.
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[T] Select Sheets Dialog
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Select sheets
Sheet Selection
Total # selected:
% |Mame Count | Thickness Starting Corner Mesting Direction Grain Direction
1 RectSheet 0.000 Lower left
2 RectSheetd 1 0.000 Lower left Along X Mone
3 RectSheet3 1 0.000 Lower left Along X Mone
Select Curve(s) Remaove All Remove Active
Sheet Definition
Mame | Rectsheet |Lengﬂ1| a6 Height = Thickness| 0.5 | = Countl 1 | =
Add Sheet{s)
Cancel Help
Add Sheet to Nest

[1] Sheets List

Description

#

Sheets are automatically numbered at the time of creation.

Name

This is the name of the sheet provided when it was created.

Count

This is the total quantity for this sheet.

Thickness

This is the designated thickness for the sheet.

Starting Corner

This is the starting corner for the toolpath operations nested on this sheet.

Starting Corner

Lower left e
Laower right E!
Upper left

Upper right

Starting Corner

Nesting Direction
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This is the direction that toolpath operations will be nested on this sheet. For example,
beginning at the Lower Left, operations would nested from left to right (Along X).

Mesting Direction
Along X v

Aleng Y g

Nesting Direction

Grain Direction

This is the grain direction for the sheet. It can be used to control how toolpath
operations are oriented on the sheet. For example, if you select Along X here and then
select Along Y for Grain Direction on the Nest Parameters tab of the toolpath operation
dialog, then that toolpath would be rotated 90 degrees on this sheet.

Grain Direction

Mone “
Along X [!
Along ¥

Grain Direction

Select Curve(s)

Pick this button to select geometry to be used as Sheets. You may window-select all
closed curves and press <Enter> or <Right-Click>to add them to the selection list.
Selecting open profiles is not supported. Sheets are Only periphery shapes and cannot
contain holes or cutouts. test

S0

Closed Curve Selected ——
for Sheet Definition

§
8 ==L

Remove All
Pick this button to remove ALL items from the list.

Remove Active
Select the Remove Active button to remove the currently selected item from the list.

[T] Sheet Definition
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Use these controls to define the parameters for a new sheet. Once the fields are
defined, pick the Add Sheet(s) button to add the sheet to the list above.

Name
This will be the Name of the defined sheet.

Length
This will be the Length of the defined sheet measured in the default drawing units.

Height
This will be the Height of the defined sheet measured in the default drawing units.

Thickness
This will be the Thickness of the defined sheet measured in the default drawing units.

Count
This will be the Count total for the defined sheet.

Add Sheet(s)
After entering the sheet dimensions and attributes, select this button to add the sheet
to the sheets list.

7.3 Nesting Report

This dialog display a report of the current nested sheets. First regenerate your Operations to Nest
setup. This will update your nested sheets. Then display this report to get information on the
Nested Sheets results.

[ Nesting Report Dialog

Mesting Report X
#  Mested Sheet 2% Utilization 2 1/2 axis Profiling (Part 1) 2 1/2 Axis Profiling (Part 2)

1 Sheet1-1 64.63 15 1

2 Sheet1-2 67.87 10 10

3 Sheet1-3 53,85 0 14

< >

Nesting Report
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2 Axis Profiling

ﬁ 2 Axis Profiling is a toolpath method that employs
) regions and can be used either as a pre-finishing
Profiling = operation or as a finishing operation. These regions are
treated as the tops of vertical walls spanning from the Z ‘
values of the regions down to your specified cut depth.

)

This system does not consider any part surface geometry during
computation. The tool types commonly used in this method are Flat F'art_
End Mills. The operation cuts in parallel XY planes until the desired Regions > Awvoid

depth is reached. —-Regions

As the cutter follows these horizontal planes, it can maintain a climb, w2 /-\) :

conventional o mixed cut direction. H\‘a /’ I
[T] 2 Axis Profiling Example Profiling, 2% Axis

2% Axis Profiling

[T 2 Axis Profiling Menu Item

The Profiling toolpath method is invoked by selecting the Program tab and clicking on
the 2% Axis Profiling operation menu selection.
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|

Profile-NEST|'fJ| Nest | Simulate o g~ & @
M Machine Ei Stock - “ Work Zero E Mesting Report

iS5 Post % Align ~ @ijﬁispmﬁﬁng
Sheets = Material Mestifg Parameters

Machine Setup Stock Operations To Mest
3 Machine- 3 Axis | 3 172 Axis Profiling "
- Post- L BFR.
& Post- Laguna BR_ Profile a curve in 21/2 Axis
8 Stock - Box Stock Machining Mode
= ﬁ Operations to

Mesting Parameters
7 is Profilin art
| 21/2 Axis Profiling (Part 1)
] iz Profilin art
| 212 Axis Profiling (Part 2)
7 is Profilin art
| 21/2 Axis Profiling (Part 3)
| -} 21/2 Axis Profiling (Part 4
| Nested Sheets
[ ] Sheet1
[ ] sheet2

CFLr

2% Axis Profiling Menu Item

&3

[1] 2 Axis Profiling Dialog

Here is a typical 2 Axis Profiling operation dialog with the Cut Parameters tab selected.
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2 1/2 Axis Profiling >

Entm/Ewit  Advanced Cut Parameters  Comering Parameters Sorting Mest Parameters
Control Geometry  Tool Feeds & Speeds  Clearance Plane  Cut Parameters  Cut Levels

[3lobal Parameters

Region
- & =
Tolerance: (10001 = T
_ = A ‘L Toolpath
Stock: IZI L |/ Tolerance
Competisation: |.-5'-.L|TEI£NEINE w | o e stock
Cut Direction

(3 Climb [Dawn Cut]
() Conventional [Up Cut]

(®) Mixed

Cut Start Point for Clozed Curves
IJze kid-Paint of longest side

Cutting Side
(®) Speciy () Determine using 30 Mode

(®) Fight of Curve () Left of Curves

[] Uze Outside/Inzside for Closed Curve

Outzide [mzide

[ sltemate using Nesting

Stepover Contral ﬂ

T otal Cut Wwidth: D: N
StepACut: IZI: N
Cut =

. Width

[ ] Perform Comer Cleanup

Cancel Save Help

Cut Parameters Tab, 2 Axis Profiling
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8.1 Control Geometry
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Control Geometry refers to the part geometry that controls the current operation. 2 Axis
operations can use 2D and even 3D curves and surface edges as Control Geometry. For 2 Axis
operations, Control Geometry is divided into two possible categories: Part Regions and Avoid
Regions. The Control Geometry tab has sub-tabs for selecting each of these categories of

geometry from your part.

n Regions must be selected before they can be used in an
operation. It should be noted that regions can be created and
be presentin a part file but if they are not selected in a machining
operation then they will be ignored during toolpath computation.
So creating a region does not make it active; you must use one of
the select button from the Control Geometry tab of the Profile

operation before you select Generate.

[T] Region Types by Configuration

Region Type Xpress Standard Expert Professional Premium
(XPR) (STD) (EXP) (PRO) (PRE)
Curve p'r / f v" /
Surface Edge .ﬂ" f f u"r u’r
Flat Area ..ﬂ'r / f u"r u’r
Avoid Regions .f f y"r ',r

Note: Some region types are not supported by all operation types.

[ Dialog Box: Control Geometry tab
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2 1/2 Axis Profiling >

Entm/Ewit  Advanced Cut Parameters  Comering Parameters Sorting Mest Parameters
Control Geometty  Tool  Feeds & Speeds  Clearance Plane  Cut Parameters  Cut Levels

Fart Regions  Awoid Begions

#  Selected Machining Region(z)]

< >

Move Up | [l Move Down
> BRemovesll | 2 Remaove Active

Rg Select Curves/Edoge Regionz
Rg Select Surface Boundary
Rs Select Flat Area Regions

Select Pre-Defined Reagions

Cancel Save Help

Control Geometry tab, Profiling, 2 Axis

Part Regions tab

The Part Regions tab displays in all 2)4 Axis and some 3 Axis operations. Itis used to drive
the tool during the operation. Use one of the Select... buttons in this dialog to add Part
Regions to the Selected Machining Region(s) list.

See Select Part/Containment Regions for more information.

Avoid Regions tab

The Avoid Regions tab lists the geometry (i.e., Regions) to be avoided by the cutter
during the current Mill operation. The outer diameter of the tool will not enter this
region.
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Note: This feature is notavailable in Xpress configuration.

See Avoid Regions for more information. This tab is available on the following operation
dialogs: Facing, 2: Axis, Pocketing, 2% Axis, Profiling, 24 Axis

Move Up
This button moves the selected item up (i.e., higher) in the list. Items are machined in
the order listed.

Move Down
This button moves the selected item down (i.e., lower) in the list. Items are machined in
the order listed.

Remove All
If your controller does not support spiral g-code motions, check this box to output spiral
motions as linear segments.

Remove Active

Pick this button to Remove the selected Active region from the list. You can select
multiple Regions from the list using the Ctrl key and then pick this button to remove
them all. The geometry itself is not deleted from the part model.

Select Curve/Edge Regions

Pick this button and the dialog will minimize, prompting you to make a selection from
your part. You can select curves or face edges. After completing the selection, the dialog
will re-appear with your Region selections listed.

Select Surface Boundary

Pick this button and the dialog will minimize, prompting you Select surface for boundary.
You can select one or more part surfaces. After completing the selection, the dialog will
re-appear with each surface edge boundary listed in the Selected Machining Region(s)
list.

Select Flat Area Regions

Pick this button and you are prompted to make a selection from your part. You can select
flat planar face geometry. After completing the selection, the dialog will re-appear with
your region selections listed.

8.2 Cut Parameters

This Cut Parameters tab is similar for the Mill operations listed below. It allows you to define the
cut parameters for the current Profiling operation. You can set Global Parameters, Cut Direction
and the Stepover Distance via this tab of the operation dialog. The Global Parameters section
allows you to set the tolerance value to be used in machining. A uniform thickness or stock that
needs to be left around the part can also be specified here. Refer to each option below.

[T] Dialog Box: Cut Parameters tab, Profiling Operations
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2 1/2 Axis Profiling >

Entm/Ewit  Advanced Cut Parameters  Comering Parameters Sorting Mest Parameters
Control Geometry  Tool Feeds & Speeds  Clearance Plane  Cut Parameters  Cut Levels

[3lobal Parameters

Region
Tolerance: |[0.001 : o _lf .
: oolpa
- 'l‘ ...
stock IZI = ‘L Taolerance
Compensatian: |-'5"-L|TEIHNEINE v| 3 T stock

Cut Direction
(3 Climb [Dawn Cut]
() Conventional [Up Cut]

(®) Mixed

Cut Start Point for Clozed Curves
IJze kid-Paint of longest side

Cuiting Side /)
(®) Speciy () Determine using 30 Mode
(®) Fight of Curve () Left of Curves

[] Uze Outside/Inzside for Closed Curve

Outzide [mzide

[ sltemate using Nesting

Stepover Contral ﬂ

T otal Cut Wwidth: D: N
Step/Cut; IZI: r

. Width

[ ] Perform Comer Cleanup

Cancel Save Help

Cut Parameters tab, Profiling Operations

[T] Global Parameters
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The Global Parameters section allows you to set the tolerance value to be used in
machining. A uniform thickness or stock that needs to be left around the part can be
specified here.

Tolerance
This is the allowable deviation from the actual part geometry plus the Stock allowance
(if any). In 2 Axis methods, this Tolerance is applied to XY motions only.

Region
f Toolpath
fafl
e
- |+ Stock
Tolerance
[T] How to Increase Tool Path Accuracy

Tolerances play a vital role in both design engineering e
and digital manufacturing. In design, the goal isto allow = “37._ r ‘“\

the broadest tolerance range possible while meeting
your design specifications. This is because, generally ;
speaking, there is a direct correlation between tighter 1=
tolerances and higher manufacturing costs.

Read the full article...

Stock

This is the thickness of the layer that will remain on top of the part after the toolpath is
complete. Roughing operations generally leave a thin layer of stock. For finishing
operations this value is zero.

Region
; Toolpath
/ Tolerance

-+ feoe]

Stock

Compensation
This enables cutter compensation. The compensation direction, left or right, is
determined by the Cut Direction selected (Climb or Conventional).

[T] Cut Direction

Climb (Down Cut)
Select Climb (Down Cut) and the tool will be maintained in a downward motion into
the stock.
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—_—

_’ \
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¥
t.

x
Climb (Down Cut)

Conventional (Up Cut)
Select Conventional (Up Cut) and the direction of the tool will be maintained in an

upward motion out of the stock.
e O3 —
-
y
tx
Conventional (Up Cut)
Mixed

Select Mixed and the direction of cutting is alternated between each parallel plane.
This is a mixture of both Climb and Conventional cutting of the stock.

1—)—»

¥
tox

Mixed

[T] Understanding Climb vs Conventional Milling

One of the basic concepts to understand in any milling
operation is Cut Direction. It can be characterized by
how the flutes of the cutting tool engage the stock
material and form the chip that is removed during
cutting. In many of MecSoft CAM’s 2% & 3 Axis toolpath
strategies you will see that Cut Direction is defined by
selecting one of three options, Climb, Conventional or
Mixed. Let’s take alook at the characteristics of each
option.

Read the full article...

For Z Level Cuts:

When Mixed is selected, zigzag motions are applied between step downs to eliminate
tool retracts between z levels. If Climb or Conventional is selected, retract between z
levels are applied. Referto the images below:
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Climb or Conventional Mixed

[:D Cut Start Point for Closed Curves

160

Check this box to move the cut start point to the mid-point of the longest side of a

closed curve.

Use Midpoint of Longest
Curve

1] Cutting Side
[ Specify
Select this option to activate the Cutting Side parameters in this dialog.

Right of Curve / Left of Curve

Right or Left determines the side of the curve to cut. This can be set for both

open and closed curves. Right or Left is determined by the start point and

direction.

Curve
Curve

Start Cirection
F'oint\ T
Left @ {f_rs» Right

Cut Start Side

Use Inside/Outside for Closed Curves

Select this option if you have a closed curve region. Then select Inside or

Outside to have the tool cut on that side.
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>

Outside

Inside

Alternate using Nesting
If your control geometry has nested curves, check this box to alternate the cut
side (i.e., Outside/Inside or Inside/Outside).

N\

e

On off

[T] ste pover Control

This is how wide your cut should be. The Step/Cut determines your stepover. For
example if Total Cut Width is set to 1.0 and Step/Cut is set to 0.25, there will be 4 passes
created.

Total Cut Width

This will determine the stepover for each cutting pass beginning at your total cut width
and ending at your control geometry.

Total Cut Width

[T] Corner Cleanup

Check the Corner Cleanup box to automatically detect corners that the tool could not
reach between each pass. The system will then add a toolpath based on the uncut area
detected.
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8.3 Cutlevels

The following Cut Levels tab allows you to define the location of the Cut Geometry and various
Rough and Finish Cut Level parameters. Referto each of the sections below for more information.
MecSoft Tech Blog: Understanding Cut Levels in 2% Axis Machining.

[ Dialog Box: Cut Levels tab
2 1/2 Az Profiling >

Entm/Ewit  Advanced Cuk Parameters  Camering Parameters Sorting Mest Parameters
Control Geometry Tool  Feed: & Speed:  Clearance Plane  Cut Parameters  Cut Lewvels

Location of Cut Geometry
@& Top (At Bottom

. I:I el
() Pick Top = L.\f., Rough Cut Geometry at Top
Depth
Cut Drepth Cantral 1' _E Rough
- Total 3 e — Depth/Cut
Total Cut Depth:; | 0.25 = Cut —— 1
Depth e s T
Fough Depth: Finizh D epth: Finizh E-I:;:-E’::s'tut

- -

Fraugh Depth/Cut . Finish Depth/Cut: E .
A ]

[]Uze 30 Model to Detect Depth

Cut Levelz Ordering w

{®) Depth First Q_L 5
N 2 <]

i) Lewel First — i

Cancel Save Help

Cut Levels tab, MILL Operations

[1] Location of Cut Geometry

The Location of Cut Geometry can be set to At Top (top Z level), At Bottom (bottom Z
level) or Pick Top (specifying the Z location) by entering a Z value location or by
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selecting the pick button and selecting the point on the part.

j:l At Top

This uses the Z location of the selected Machining Feature/Region as the top of
cut. The generated cuts will start at this Z location and cut down in Z to the
specified total cut depth. At Top is typically used when you select the top edge as
your machining region.

Feature/Region at Top Feature/Region at Top - Toolpath

j:l At Bottom

This uses the Z location of the selected Machining Feature/Region as the bottom
of cut. The generated cuts will be above the selected machining region and last
cut would be at the Z location of the specified region. At Bottom is typically used
when you select a pocket bottom at your machining region.

2% Axis Facing Operation Examples:

Feature/Region at Bottom Feature/Region at Bottom - Toolpath

1] Pick Top

This allows you to specify the Top of Cut for the selected Machining
Feature/Region and is typically used when the selected region is not at top or
bottom. The generated cuts will start at this specified Z location and cut down in Z
to the specified total cut depth. This would be useful when the selected
machining region is at the bottom edge of a fillet or chamfer.
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When two or more curves are selected as Machining Features/ Regions, and using
Pick Top for Location of Cut Geometry, sets the Top of cut for all regions at the
same Z level.

2% Axis Facing Operation Examples:

Feature/Region pick Top Feature/Region pick Top - Toolpath

(1] Cut Depth Control

The Cut Depth Control section provides controls for defining the depth of the cut. First
define the Total Cut Depth. Then, enter the Rough Depth and Finish Depth values. You
can then define the Depth per Cut for both Rough and Finish passes by entering values.

Total Cut Depth

Enter the Total Cut Depth or select the Pick button and select two points on your
part. The depth will be calculated automatically and added to this dialog. Refer to

the illustration below for reference. You can then divide this into a Rough Depth and

Finish Depth.
Rough Cut Geometry at Top
Deptlh _l: Rough
Total 3 s ~= Depth/Cut
Cut _I_ —=— 1
Depthi=—s Trinish
Finish Depth/Cut
Depth
Total Cut Depth
Rough Depth

AFTER the Total Cut Depth is specified, enter your Rough Depth value. For example, if
you enter 1.0 for the Total Cut Depth, the Rough Depth and Rough Depth/Cut will
automatically default to 1.0. If you then enter 0.75 as the Rough Depth, the Rough
Depth/Cut will default to 0.75 also until you adjust it.

Finish Depth

AFTER the Total Cut Depth and the Rough Depth are specified, you can enter a Finish
Depth value. This value is optional. You can then proceed to enter a Finish Depth/Cut
value.

Rough Depth/Cut
AFTER the Rough Depth is specified, you can use the Rough Depth/Cut field to tell the
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8.4

system how deep to cut each level until the Rough Depth is achieved.

# Select this icon to assign the Cut Depth value that is defined by the tool that is
currently active for this operation. Note: This icon will ONLY appear in this dialog if
the currently active tool has a Cut Depth value assigned to it. Edit the tool definition if
desired.

Finish Depth/Cut
AFTER the Finish Depth is specified, you can use the Finish Depth/Cut field to tell the
system how deep to cut each level until the Finish Depth is achieved.

¥ Select this icon to assign the Cut Depth value that is defined by the tool that is
currently active for this operation. Note: This icon will ONLY appear in this dialog if
the currently active tool has a Cut Depth value assigned to it. Edit the tool definition if
desired.

Clear Island Tops

Check this box to insert an extra cut level at the top of any innerislands or connected
step regions.

Use 3D Model to Detect Depth

Check this box ONLY when a 3D model is being used. When checked, the bottom most
level of the partis detected (if there are multiple depths) and cut levels will be added
to this depth level. Only the Finish Depth (under Cut Depth Control) needs to be
specified. The Rough Depth is automatically determined. For multiple pocket
selections, the Location of Cut Geometry should all be the same level (i.e., either all At
Top, At Bottom or Picked Top).

Cut Level Ordering

Depth First allows you to order the Cut Levels in this operation so that the entire Z
depth of each feature is machined before moving on to the next feature.

Level First allows you to order the Cut Levels in this operation so that all regionsin a
single Z level are machined first before moving on to machine the next cut level.

Entry/Exit

The following Entry/Exit tab is similar for the Mill operations listed below. Entry and Exit
determines the way in which tool enters and leaves the part geometry. MILL Module allows you to
specify how the cutter approaches, engages, retracts and departs when starting and stopping a

[T] Dialog Box: Entry/Exit tab
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2 1/2 Axis Profiling >
Contral Geometmy Tool Feeds £ Speeds Clearance Plane Cut Parameters
Cut Level:  Enty/Exit  Advanced Cut Farameters  Comering Parameters Sarting

E nkry b ations

® Lines & Arcs () Along Path () Maone
Linez & Arce

Length [L] =

(I Momal (8 Tangent () Speciy

Approach kation

Angle [A] 0 :
"~ Engage
Engage Motion .
() Linear Length(L) 0125 2 e
Angle [4) 20 - i* A
Radial Radius (A] |0.25 = +
(® Radia adius [R] = Approach
Engage Ramp Height III =
Alang Path 30 Entry
Along Path Angle (&) 10 *  AlongPathHeight(H) 005 =

E wit Mations
(@ Lines & Arez () Mone

. Lines & Arcs
Retract Mation
() Linear Length [L] 0.25

Angle [B] 20

@ Radial  Radius [R)
Retract Ramp Height IZI: Retract /?
L

Departure Motion

Length (L] .

(I Momal (@) Tangent () Specify
Angle [A] 0 :

Al K[ 4| K[k

— R

+ A

.
Departure

[ ] &pply entro/exit at each cut level Owerlap Dist for Clozed Profiles EI :

Cancel Save Help

Dialog Box: Entry/Exit tab, 2% Axis Milling operations

[T] Entry Motions

You can set different feeds for plunge, approach, engage, cut, retract and depart
moves. The tool moves to the position above the approach point with a plunge
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feed, then uses the approach feed rate for the vertical approach motion and
engage feed rate for the engage motion.

Lines & Arcs
This is a 2D entry motion consisting of an Approach Motion and an Engage Motion.

For the Approach Motion, enter the approach Length (L). Then, depending on the
stock material and cut pattern select the approach angle as either Normal, Tangent
or Specify Angle (A) with respect to the stock.

For the Engage Motion select Linear or Radial. Inthe Linear motion the cutter
follows a linear ramp motion, Ramping back and forth from a user specified height
to the engage point. The Length (L) of this move, as well as the Angle (A) of this
motion can be specified.

~ Engage

= L«“‘:‘:I-Engage — 4
T R
?
l;_a A |__'
+ 1
Approach Approach
Linear Radial
Along Path
The Entry path can be defined as a 3D Entry along a specified Path Angle with a
Path Height.

Along Path

None
No entry motion is defined for the current operation.

— LY
Entry Point on Path

None

[T] Exit Motions

The Exit motion consists of a Retract Motion followed by a Departure Motion. The
departure motion is a linear motion.

Lines & Arcs
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The 2D Exit motion consists of Approach Motion and an Engage Motion. You can
set the Retract Motion to Linear and then enter the Length (L) and the Angle (A).
Likewise you can select Radial and then simply enter the Radius (R).

LA Refract -

- = R
Retract /7';
Lilen
Departure 3
Departure
Linear Radial

For the Departure Motion, enter the departure Length (L). Then, depending on the
stock material and cut pattern select the departure angle as either Normal,
Tangent or Specify Angle (A) with respect to the stock.

None
No exit motion is defined for the current operation.

— LY
Exit Point on Path

None

[T] Apply entry/exit at each cut level
Check this box to apply the Entry/Exit Motions to each cut level.

[T] Overlap Dist for Closed Profiles

This option allows you to specify an overlap distance for closed profiles to avoid
leaving small tool marks at the start point of the part. The toolpath will start as
specified, follow the closed profile back to the start point and then continue past for
the specified distance. The overlap distance will be restricted so that it cannot exceed
the profile length.
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Overlap Distance not set Overlap Distance set

8.5 Advanced Cut Parameters

The following Advanced Cut Parameters are similar for the Mill operations where the tab is
available. Some parameters listed below may not be supported for every applicable operation.
These parameters can be used to control the cuts for high speed machining and are designed to
reduce rapid acceleration and deceleration of the machine during the cutting process. They allow
smoothing of the toolpaths by introduction of arcs.

y Youcan use these parameters even if the controller does not

support arcs. In this case, make sure that the outputis set to Linear
output. This can be set in the Set Machining Preferences dialog located
on the Machining Browser under CAM Preferences.

[ Dialog Box: Advanced Cut Parameters tab

L some options shown below are not available for all operations.
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2 1/2 Axis Profiling >
Control Geometmy Tool Feeds & Speeds
Clearance Plane Cut Parameters Cut Levels E ity /E it
Advanced Cut Parameters Cornering Parameters Sorting Mesting Parameters
Cut Corner Rounding Options f:: D

r
[ Perfarm Cut Rounding r
~ r
Rounding Fadius [r] 0.1 = .y,
Cut &rc Fitting
Perform &rc Fitting AR
Fitting Talerance [t] 0m :

Sroath Cut Transitions

[ ]Use Smooth Cut Connections

Bridges/Tabs

iMane () Triangular (@) Rectangular

Bridae Height (H) 01 s _HDLH_
Bridge Length (L) 0.2 =

[]Reduce feed on descending mation 1
(®) Mumber of Bridges =

() Dist. between Bridges 1 :

Cancel Save Help

Dialog Box: Advanced Cut Parameters tab, Profile Operation

[T] Cut Corner Rounding Options

Check this box to round sharp corners in the toolpath and specify a Rounding
Radius (r). Fillets of the specified radius will be introduced in sharp corners if
possible. These fillets will only be introduced on planes parallel to the XY plane.
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Perform Cut
Rounding

[T] Cut Arc Fitting

Check this box to Perform Arc Fitting . The system will attempt to fit arcs along the
computer toolpath if they lie within the three principal planes (XY Plane, XZ Plane
orYZ Plane).

Tolerance (t)

[1] Smooth Cut Transitions

Check this box to add "S" or "C" shaped cut transitions between two successive offset
cuts that lie parallel to the XY plane. These Smooth Cut Connections reduce rapid
acceleration and deceleration on the machine and extend tool life.

|

Smooth Cut Connections

[ Bridges/Tabs

For the 2% Axis Profiling operations, select None, Triangular or Rectangular to create
bridges along the part boundary. These bridges can be used to hold the part on the
table during the actual machining operation. The following parameters are supported:

e Bridge Height (H): See illustrations below.
e Bridge Length (L): See illustrations below.

e Reduce feed on descending motion:

Check this box to reduce the feed rate for the descending motion after each tab. The
reduction is governed by the Plunge between levels percentage value defined by the
Feeds & Speeds tab of the operation.
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Reduce o
Feed

!

Reduce Feed when
Descending

o Number of Bridges: See note 1 below.

e Distance between Bridges: See note 1 below.

T e T I
z z F

k. k. &

< ] >< T
i | e & . Lk (=
H H
None Rectangular Tabs Rectangular Tabs

[T] Bridges-and-Tabs-Explored

You may have heard the term Bridges & Tabs mentioned often W -'H
enough during our many videos and blog posts. Let’s take a . '
moment to explore exactly what they are and how they can be ey J@

used effectively. Because CNC machining is a subtractive 4
manufacturing process, stock material needs to be removed by the o ~
cutter until the resulting part’s shape is achieved. During this i

process, the remaining part needs to be fixed and stable on the bed of the CNC machine
tool so that accuracy is maintained during the entire machining process.

Read the full article...

8.6 Cornering Parameters

The following Cornering Parameters are available for all Profiling operations. You can control
both External Corners and Interior Corners. You can also filter which corners these controls are
applied to by specifying a corner angle range. Please be sure to read the notes below before
using these parameters and perform cut material simulations to fully understand how they affect
cutter movement.

@ Important Note: These Internal and External Corner Types require

that the Control Geometry selected for the Profiling operation be
closed regions or open poly-lines. If your Control Geometry is a single
line or multiple disconnected lines, you must use the Default
selections or an error message will be returned.
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y Youcan use these parameters even if the controller does not

support arcs. In this case, make sure that the outputis set to Linear
output. This can be set in the Set Machining Preferences dialog located
on the Machining Browser under CAM Preferences.

y Tip: Location of Start Points: If the start point is at a vertex where
the corneris being applied, it is automatically moved to the corner.

[T] Dialog Box: Cornering Parameters tab
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2 1/2 Axis Profiling >
Control Geometmy Feeds & Speeds
Clearance Plane Cut Parameters Cut Levels E ity /E it
Advanced Cut Parameters Carnering Parameters Sarting Mesting Parameters

External Comer Type

() Bound [Default]

(®) Sharp

() Sharp Limited

() Loop

Extermal Cormer Filters

Minimum Angle: | 180 = M axirurn Angle: | 270 =

[ntermal Carner Type

(®) Sharp [Default]
() Dog Bone

()T Bone

|nternal Corner Filkers

Mirirnum Sngle: D =

Generate

Maxirmurn Angle: | 135 =

Cancel Save Help

Dialog Box: Cornering Parameters tab, Profiling, 2 Axis

[1] External Corner Type

The External Corner Type selected will be applied to all corners measured
between the Minimum Angle and Maximum Angle values provided.

Round (Default)

This the default External Corner Type. The tool rolls around the sharp corner.
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Depending on the toolpath Tolerance, this method can cause rounding of the sharp
corner. NOTE: This option must be used if your Control Geometry is not closed or
is not a ploy-line!

Round

Sharp

This External Corner Type will force the tool to proceed past the corner vertex.
When the tool diameter becomes tangent with the projected edge direction, it
proceeds along the secondary edge.

Sharp

Sharp Limited

This External Corner Type will force the tool to proceed past the corner vertex by a
specified Overshoot Length. If the Overshoot Length is specified as a distance less
than the tool radius, a round is added at the corner. The radius of the round is
equal to the tool radius minus the Overshoot Length. If the Overshoot Length is
equal to or greater than the tool radius the Sharp Corner Type is used.

Sharp Limited

Loop

This External Corner Type will force the tool to proceed past the corner vertex by a
specified Loop Radius before it proceeds tangent to the secondary edge. The
radius is measured tangent to the secondary edge.

Loop

© 2020 MecSoft Corporation



2 Axis Profiling 176

[1] External Corner Filters

Minimum Angle

This is the Minimum Angle for corners to be considered for an External Corner
Type. Corner angles below this value will use the default round method for
external corners.

Maximum Angle

This is the Maximum Angle for corners to be considered for an External Corner
Type. Corner angles above this value will use the default round method for
external corners.

[T] Internal Corner Type

The Internal Corner Type selected will be applied to all internal corners measured
between the Minimum Angle and Maximum Angle values provided.

Sharp (Default)

This is the default Internal Corner Type. The tool will change directions when it meets
the approaching edge. NOTE: This option must be used if your Control Geometry is not
closed oris not a ploy-line!

Sharp

Dog Bone

In this Internal Corner Type, the tool will stop when it meets the approaching edge and
then proceed directly to the corner vertex point. The tool will then reverse direction
back to the previous point and proceed tangent with the approaching edge.

Dog Bone

T-Bone

In this Internal Corner Type, the tool will stop when its diameter meets the
approaching edge and then continue tangent until it reaches the corner vertex. The
tool will then reverse direction back to the previous point and proceed tangent with
the approaching edge.
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8.7

T-Bone

[T] Internal Corner Filters

Minimum Angle
This is the Minimum Angle for corners to be considered for an Internal Corner Type.

Corner angles below this value will use the default sharp method for internal corners.

Maximum Angle
This is the Maximum Angle for corners to be considered for an Internal Corner Type.

Corner angles above this value will use the default sharp method for internal corners.

Sorting

The following tab allows you to define Sorting parameters for the current Profiling operation. If
No Sort is selected, operations will be performed in the order in which the regions were created
or selected. The Minimum Distance Sort and Directional Sort options are described below.

[ Dialog Box: Sorting tab
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2 1/2 Axis Profiling >
Control Geometmy Tool Feeds & Speeds
Clearance Plane Cut Parameters Cut Levels E ity /E it
Advanced Cut Parameters Comering Parameters Sarting Mesting Parameters

(Mo Sort (®) Minimum Distance Sort () Directional Sort

Mirirmum Diztance Sart
Start Paint

() Upper Left ) Upper Right
(®) Lower Left () Lower Right

Directional Sort
Primary Sort Direction (P)

Start dngle (4] [ =

Secandary Sart Direction [5]

Lo to High High to Low Start End
Foint Paint

Traverzal Pattemm
£ig Finfan

[ ] Perfarm clustering

Cut Order
| nzide/Out Outzideddn

Cancel Save Help

Dialog Box: Sorting tab, similar for 2% Axis Hole Making, Pocketing & Profiling Operations

[1] No Sort

If No Sort is selected, operations will be performed in the order in which the regions
were created or selected.

[1T] Minimum Distance Sort

This option sorts based on the shortest distance between regions based on the start
point of the regions. This option allows you to set the sort based on the Start point.
This start point can be one of the following:
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Start
Point

End
Point

Start Point - Lower Left

Start
Point

/

End
Point

Start Point - Upper Left

[T] Directional Sort

Start
Point

N

End
Point

Start Point - Lower Right

Start
Point

End
Point

Start Point - Upper Right

The directional sorting is performed according to the Primary and Secondary sort
directions. The Primary Sort Direction (P) is defined by Start Angle (A).

The Secondary Sort Direction (S) is always perpendicular to primary direction and can
be defined to go from Low to High value or from High to Low value. In addition to this
the traversal of the cutter can also be defined as either Zig (one way) or ZigZag (two
ways). Refer to the dialog box images below:

End
Paint
d'/-
e
.
Start -
Paint \ _y
Sha TFC
P A

Low to High, Zig Pattern

Poiﬂt
....--r....
A\
X -
\ &
Start
(P
) e
P T A

Low to High, ZigZag Pattern
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Start 7 Start \
F'oi?t___'__.---' / Pgir!t-.-'___.-' ] q
X } . \
rd Y/ ¥
L /
/" _~End Y " End
. A Point \ Y Point
5 - S =
A Ta "va T
High to Low, Zig Pattern High to Low, ZigZag Pattern

[T Perform Clustering (not available for all operation types)

These parameters allow you to sort machining regions by clusters. A clusteris when
one region is completely enclosed within the boundary of another region. This
relationship defines one cluster. There can be multiple clusters selected for an
operation and these options will sort them for machining.

Perform Clustering
Check this box to enable clustering and then select which method to use. A clusteris
when multiple regions are completely enclosed within the boundary of another region.

'\..

No Clustering

Inside/Out
Select this option to machine one complete cluster at a time starting with all of its inner
regions first before machining its outer region.
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Inside/Out Clustering

Outside/In
Select this option to machine one complete cluster at a time starting with its outer
region before machining all of its inner regions.

=

b . o

Outside/In Clustering

8.8 Tool Tab

The following dialog allows you to select the appropriate tool for the current operation. The Tools
in Session are listed on the left. Expanding the Tool tree will list the current operations assigned
to that tool. See Create Edit Tools for more information.

[1] Dialog Box: Tool tab
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2 1/2 Axis Profiling >
Advanced Cut Parameters Cornerning Parameters Sorting Mesting Parameters
Clearance Plane Cut Parameters Cut Levels E ity /E it
Contral Geometny Tl Feeds & Speeds
= I'_m Tools » | |8 Tool Geometry
s J Flattill 0.25 Diameter 0.25
i 37542550 Loc ) Comer Radius |0
B a5 arL (150 Lac ) Taper 0
Fd 375 4FL (350 Loc | Tip Angle |0
B a7sorL1180L0c) B ToolProperties -
:'.1 375 2FL (900 Lot | Tool F_dame IzlatMlII: .25
¥ 375 4FL(1.050 Loc ) fool® :
' # of Flutes 2
fj 3122 FL (550 Lot ) Cutcom Regitd 2
:’ ZA04FLL. 750 Lac) Adjust Register |2
e m02FL7E0Lac) Ottt )
;'-1 2ol 2 FL[.800 Loc | Material CARBIDE
B zmoaFL E00 Loc) Coolant None
B s04FL1150 Loc) Comments
B 2504FL(1.730Loc) 38! | |3 Feeds & Speeds
a 87 2FL[.800 Loc ) Spindle Speed | 24446
> R GREEEY Feed Rate 14.67
B4 157 4L B8O Loc)
B 572U E50 Loc)
e 197 4L 6RO Lac)
187 2FL ES0Lac] v
L4 > Edit/Create/Select Toal ...
Preview Tool

Cancel Save Help

Dialog Box: Tool tab, similar for all Milling Operations

[ Edit/Create/Select Tool ...

If there are no Tools listed, select this button to Create a new tool. If atool is listed
and selected by default, select this button to Edit the parameters for that tool or to
Select a different tool for the current operation.

[T] Preview Tool

Select this button to display a graphical representation of the currently selected tool.
This is the same Preview of the tool that you see displayed in the Edit/Create/Select
Tool dialog.
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8.9

Feeds & Speeds

The following Feeds & Speeds tab is displayed for all Mill operations. It allows you to select the
appropriate Feeds & Speeds for the current Mill operation. In this tab, Spindle Parameters and
Feed Rates can be specified. Speeds & Feeds can also be loaded from a File or from the Tool.

1]

1]

Feed Rates Explained

Feed Rate is one of the most important factors to consider when
implementing any CNC strategy. Simply put, feed rate is the speed
at which the cutter engages the part and is typically measured in
units/minute. Suggested cut feed rates will vary depending on the o,
type of material you are cutting (i.e., aluminum, steel, wood, acrylic, etc.), the material
of the cutter (carbide, high speed steel, ceramic, etc.) and many other cutting factors
including desired surface and the characteristics of the CNC machine itself.

T -

Read the full article...

Dialog Box: Feeds & Speeds tab
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2 1/2 Axis Profiling >
Advanced Cut Parameters Cornerning Parameters Sorting Mesting Parameters
Clearance Plane Cut Parameters Cut Levels E ity /E it
Control Geometry Tool Feeds & Speeds

Spindle Parameters

Speed pa44E = FRPM

Direction @®ow (oW

Feed Rates

Plunge [Ff] 29334 = ifdrmin
Approach [&f]  |T4667 == indmin
Engage [Ef] 1 = infmin

Cut [C) 14667 20 in/min

Retract [R] " = in/min

Departure [Df |23.334 = in/min

Transter [TF] (@) Uze Rapid () Set
2333 2 indmin

Feed Rate Reduction Factors

Plunge between levels | 100 =
First =% pazs 100 =
Bottom £ Level 100 =

Load from T ool Load from File ..

Generate

Coolant

MHone

i

i

Cancel Save

Dialog Box: Feeds & Speeds tab,2 Axis Profiling

[T] Spindle Parameters

These parameters refer to the spindle on your machine.

Spindle Speed

Help

This is the rotational Speed (S) of the milling spindle expressed in RPIM.

Spindle Direction (CW)
This sets the spindle rotation to be

Spindle Direction (CCW)

Clockwise (CW).
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This sets the spindle rotation Direction to be Counter Clockwise (CCW).

Feed Rates

These are the feedrates (in Units/Min) that will be applied to the current toolpath
operation. If the values are currently populated from your Tool definition (Load from
Tool), Feeds & Speeds table (Load from File) or from your Knowledge Base, you can
override them for this operation.

Plunge (Pf)
This is the rate is the feed before the tool starts to engage in material. This is always
vertical.

Approach (Af)

This is the Approach (Af) feedrate (in Units/Min) used to prepare the cutter just before
it starts to Engage into material for cutting. Approach motions are dependent on the
method of machining.

Engage (Ef)
This is the Engage (Ef) feedrate (in Units/Min) used when the tool is Engaging the
material just prior to cutting.

Cut (Cf)
This is the Cut (Cf) feedrate (in Units/Min) used when the tool is Cutting material.

Retract (Rf)
This is the Retract (Rf) feedrate (in Units/Min), when the tool is performing a Retract
move away from material.

Departure (Df)
The is the feedrate (in Units/Min), when the tool Departs from the material.

Transfer (Tf) Use Rapid

This is the Transfer (Tf) feedrate (in Units/Min) used for Transfer motions. If you select
Use Rapid the posted G-Code will output a rapid motion (GO) with no feed rate. Note:
For more accurate machining time estimates, use the Set option and enter the feed
rate to use.

Transfer (Tf) Set

This is the Transfer (Tf) feedrate (in Units/Min) used for Transfer motions. Select Set to
enter an actual feedrate value for rapid motions (GO0). This is only used for calculating
the estimated machining time.

Feed Rates Reduction Factors (Hole Operations Only)

This section of the dialog allows you to specify Feed Rate Reduction Factors for specific
tool motions.

Plunge between levels
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This is a percentage of the Cut (Cf) feedrate to use when the tool is plunging between Z
levels.

First XY Pass
This is a percentage of the Cut (Cf) feedrate to use on the first XY cut motion when the
toolpath uses the full width of the cutter.

[ Coolant

Here you can override the Coolant that is specified by the Tool. Coolant can be set to
Flood, Mist or Through. Coolant codes are defined in the post processor generator
under Misc tab.

[T] Load from Tool
Load the Feed & Speeds values that are saved with the currently selected Tool.

See: Create/Edit Tools

[1] Load from File

This loads the Feeds & Speeds values from the Feeds & Speeds Table file. This will
display the Load Feeds from Table dialog box to make your selections.

[1] Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to
the Feeds & Speeds tab. The plunge, approach, engage, retract and departure
feeds are determined using a percent of the cut feed. The percent to use for
transferring the computed cut feed can be set under Feeds & Speeds
Preferences.
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Feeds/Speeds *

Load Feeds fram T able

Drata from T able

Stock Matenal ALUMIMUIM - 2024 w

T ool Maternial CAREBIDE w

Surface Speed 1600 : ftAmin
Feed/Toath 0.004 ="

[nput % ariables
Tool Diameter: | 0.5 =y
# aof Flutes: 2 =

kd awirnurm Limits for Compution

Max Spindle Speed 14000 = EPM

b ax Cut Feed 200 = in/min
Computed Vanables

Spindle Speed 12223 s BPM

Cut Feed [Cf) 97 = in/min

Cancel Help

Dialog Box: Load Feeds from Table

[T] Data from Table

These selections and calculations are defined in a feeds and speeds data file
which can be edited to add newer materials. See our blog post How to
Customize Materials Data for Feeds & Speeds Computation for more details.

Stock Material
Select the desired Stock Material from this list to use in Feeds/Speeds
calculations.

Tool Material
Select the desired Tool Material from this list. CARBIDE, HSS CERAMIC are
supported. The material is used in the tool's Feeds/Speeds calculations.

Surface Speed
Selecting a Stock Material and Tool Material displays the Surface Speed and
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Feed/Tooth. This information is contained in a feeds and speeds data file
which can be edited to add newer materials.

Feed/Tooth

Selecting a Stock Material and Tool Material displays the Surface Speed and
Feed/Tooth. This information is contained in a feeds and speeds data file
which can be edited to add newer materials.

[ Input Variables

The input variables Tool Diameter and Number of Flutes are automatically
loaded based on the tool selected for the operation. Based on these
parameters, the program computes Spindle Speed and Cut Feedrate.
Changing the Spindle Speed modifies the Cut Feedrate.

[T] Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values. Once
these two values are set, the Spindle Speed and Cut Feed calculated by this
dialog will not exceed these values even if you attempt to enter higher values
into the Computed Variables fields. To exceed these values, change them
here or you must edit the operation or tool parameters manually. This value
WILL NOT exceed the High Value setin your current post-processor selection.
To do so you must edit the post using the Post-Processor Generator (Program
tab > Post > Current Post Processor > Edit > Feedrate > High Value).

[ Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based
on the selections made in this dialog but will not exceed the values setin the
Maximum Limits for Computation section of the dialog. These values are then
assigned to the active toolpath operation or tool. You can override either of
these variables and the other will update automatically. Since this dialogis a
Feeds & Speeds Calculator, you cannot override both values. To do so, you
must edit the operation or tool parameters manually.

[1] The Milling Feeds & Speeds Calculator

Did you know that MecSoft’s MILL Module plug-ins have a built-in ¢
Feeds & Speeds Calculator? That’s right, you can ask the programto  *
suggest feeds & speeds values based on your current stock

material and active tool parameters! Once a Cut Feed is calculated,
you can then choose to automatically assign feed rate values for Al
the various toolpath motions in your operation including Plunge, -
Approach, Engage, Retract and Departure! The percentages of the

Cut Feed to assign are all controlled from the CAM Preferences
dialog. The Milling Feeds & Speeds Calculator...
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1]

Read the full article...

Customizing Feeds & Speeds

MILL module allows you to customize the feeds and speeds based on the stock material
being machined, the material of the cutter employed and also the operation type. This is
done by archiving your desired feeds and speeds settings in an external data file.

A default implementation of this table has been included with the RhinoCAM product
and can be found in a folder called "Materials" under the product installation directory.

This xml contains the list of materials, texture, feeds and speeds. The file is located
under Materials folder in the RhinoCAM install directory. (C:\ProgramData\MecSoft
Corporation\RhinoCAM 2020 for Rhino x.x\Materials).

Materials folder contains the following files

FeedsSpeedsDatalNCH.xml
FeedsSpeedsDataMM.xml

The Feeds and speeds file is an .xml file format, which can be edited using any text
editor to add newer materials. These values can then be recalled at any time to
compute the feeds/speeds to be used in the current program.

The format for this file is shown below.

<Units>Imperial</Units>

<FeedsSpeeds>

<Material>
<Name>Stock Material</Name>
<TextureFile>Texture Bitmap</TextureFile>
<FeedsSpeedsRecord>Operation type, Tool Material,

Surface Speed, Feed per Tooth</FeedsSpeedsRecord>

</Material>

</FeedsSpeeds>

An example entry is shown below.

<Material>
<Name>ALUMINUM - 2024</Name>
<TextureFile>ALUMINUM.bmp</TextureFile>
<FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00,
0.0200</FeedsSpeedsRecord>
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<FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00,
0.0200</FeedsSpeedsRecord>

<FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>
</Material>

n If part unit is set to Inches, MILL module automatically loads
FeedsSpeedsDatalNCH.xml and when part unit is set to MV,
FeedsSpeedsDataMM.xml is loaded.

[T] More on Customizing Materials Data

Note: This blog post is intended for advanced users who are | o -® 8
familiar with XML text editing and have administrative access to o ok Zee g s - R
their Windows Operating System. MecSoft's CAM plug-ins havea | =/ 2" ‘}' “ b

all 2 Asic Al -
built-in Feeds & Speeds Calculator that can suggest Spindle Speeds | ~ ‘o

and Cut Feed Rates based on your stock material and active tool —

parameters! However, what if you are cutting stock material thatis | ;..o
currently notin our Materials Library? Or what if you don’t like Qpesion:

what is currently assigned for the material of your choice in the

Materials Library? This post will show you how to customize MecSoft CAM to add and
manage multiple material files as well to add your own stock materials. If you are new to
MecSoft’s CAM plug-ins, you can review my earlier post on the Feeds & Speeds
Calculator and how it works.

Read the full article...

8.10 Clearance Plane

The clearance plane is an XY plane wherein all transfer motions between a retract and engage
motion takes place. In the case of 4 axis operations, the clearance plane is a cylinder and defined
along the axis of rotation. Typically you would define this plane at a certain safety distance above
the part geometry. This is done to prevent the tool from touching the part being machined during
transfer motions since these motions usually use a very fast or rapid feed rate.

[1] Dialog Box: Clearance Plane tab
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2 1/2 Axis Profiling >
Advanced Cut Parameters Cornerning Parameters Sorting Mesting Parameters
Contral Geometmy Tool Feeds & Speeds
Clearance Plane Cut Parameters Cut Levelz Enbry/E it

Clearance Plane Definition

+ Stock Max £

(®) Automatic
O PatMaxZ + Dist 025 2
() Stock MaxZ + Digt 025

() Absolute Z%alue  0.25 =

[ Ignore ‘wireframe Geometry in Bounds Computation

Cut Transfer Method

(O Skim ™ Clearance Plane ?
Skim Clearance [Z) |0

(®) Clearance Plane

Cancel Save Help

Dialog Box: Clearance Plane tab

Dj Clearance Plane Definition

This selection defines the Clearance Plane for the current toolpath operation.

Automatic
Allow the system to calculate a the clearance plane height automatically based on the
part and stock geometry.

i ~€— Automatic

a

Automatic

Part Max Z + Dist
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Set the Clearance Plane height to the maximum Z height of the Part plus this added

distance.
v,
Dist
A Part Max Z
|
|
(|
¥
l ’
Part Max + Dist
Stock Max Z + Dist

Select this option to use the Stock's Maximum Z height and then enter a Distance value
to add to this for the total Z height for the Clearance Plane.

L

Dist

4 A

~4€— Stock Max Z

Absolute Z Value
Select this to specify the absolute Z clearance height to use and then enter Z height
value. Be sure that the value you specify clears your part geometry.

a

Absolute Z Clearance

Stock Max + Dist

Ignore Wireframe Geometry in Bounds Computation

Check this box to ignore all wireframe geometry when calculating the Clearance Plane
definition. When checked, the Automatic and Part Max options for defining the
Clearance will be calculated from actual surface geometry.

Ignore Wireframe Geometry in Bounds Computation

© 2020 Mec Soft Corporation



193

RhinoCAM Profile-NEST 2020 Reference

D:I Cut Transfer Method

This section allows you to control the tool's motions when it needs transfer to another
region to begin cutting.

Clearance Plane
Select this option to move the tool to the Clearance Plane and then perform the
Transfer motion to the next cut location.

E Clearance Plane !
_‘

Transfer at Clearance Plane

Skim

Select this option to perform transfer motions at a Skim plane. The system
automatically determines a safe height and then adds this Skim Clearance (C) to the
computed Z value to perform the Transfer Motions.

! Clearance Plang '

-y
i -

. | F";L—n Pla :1*_-"‘]I

Transfer at Skim

1] Display of Clearance Plane for Milling operations

When the clearance plane dialog is active, specifying a clearance plane definition,
displays the clearance plane on the partin the view port.

Display of Clearance Plane for Milling operations
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Edit Operations

Once a Profile operation is created it is listed under the Machining Browser. By default all the
operations are created under the setup named Operations to Nest. The setup can hold several
Profile operations and each operation can be associatively edited and regenerated.

[1] The Program Tab of the Machining Browser

Changes can be made to any of the objects that make up the operation such as the
Control Geometry, Tool, Feeds/Speeds, Clearance Plane and Machining Parameters. Any
edits made to an operation are saved with the operation and upon regeneration the
changes will take affect.

Profile-NESTII'J‘ﬂ Mest Simulate o F & @
I8 Machine @ Stock = o™ Work Zero E Mesting Report
i% Post %5 aign - [O) 2172 Axis Profiling

E Sheets §=  Material I:;[ Mesting Parameters
Machine Setup Stock Operations To Mest

=1, Machining Job
y Machine - 3 Axis
:_;,.‘i' Post - Laguna_BR_IC
fiﬂ Stock - Box Stock
= E Operations to Nest
l;_lﬂ Mesting Parameters
;
|__ 21/2 Axis Profiling (Part 2)
[_ 2 1/2 Axis Profiling (Part 3)
|__ 21/2 Axis Profiling (Part 4)
=[5 | Nested Sheets
[ ] Sheet1
[ ] sheet2
[ ] Sheet3

B o | o e

e R EN R &3

Machining Browser

9.1 Edit Associatively

Profile operations can be edited by using the Machining Browser. Each operation is represented
as afolderin the browser. Inthe expanded state of a Profile operation folder, seven icons
representing different objects that make up the operation are displayed. The first five can be
associatively edited.
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[T The Machining Operation Tree Icons

The following icons are displayed under a machining operation's folder and represent
the different objects that make up the operation. The first five (Machining Features,
Tool, Feeds/Speeds, Clearance Geometry and Parameters) can be associatively edited.

= 21/2 Axis Profiling (Part 1)
Control Geometry
[ Fratmin: 025
3 Feeds/Speeds
Clearance
é[ Parameters

Toolpath

@ In-process Stock
Operation Folder Expanded

[T] Double Click to Open an Operation Dialog for Editing

Double clicking on the operation folder (or name) will open the operation's properties

dialog with all tabs displayed for editing.

-4, Machining Job
y Machine - 3 Axis
2 Post- Laguna_BR_IQ
fiﬂ Stock - Box Stock
= 3 Operations to Nest
l;'__lj_q Mesting Parameters
SRS 2 1/2 Axis Profiling (Part 1)
Zx Ig'—| ﬂ Control Geornetry
o/ # { Fatmil 025
E Feeds/Speeds
ét Clearance

Parameters

Toclpath
E@ In-process Stock
L 21/2 Axis Profiling (Part 2)
| | 21/2 Axis Profiling (Part 3)
[ 21/2 Axis Profiling (Part 4)

Double Click to Open a Machining Operations Dialog for
Editing
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1] Right or Double Click one of an Operation's Icons to Edit its Properties

Right mouse click or double clicking a specificicon, for example the Tool icon would
bring up the Tool Creation dialog, upon which you can substitute the current tool with
another or edit the parameters of the current tool.

Click on this Icon Displays the Operation's

5 Control Geometry tab
l'f Tool tab
Feeds/Speeds tab

Clearance tab

W) & «

Cut Parameters tab

Toolpath in the Toolpath Viewer

=l Machining Job

v Machine - 3 Axis
E;‘.il Post - Laguna_BR_IC
ﬁ Stock - Box Stock

= E Operations to Nest

E Mesting Parameters
=) 212 Axis Profiling (Part 1)
i Control Geometr_l,r

2}{@%?% @‘Ix

Speeds

Clearance
S Parameters
Toolpath
% In-process Stock
| | 21/2 Axis Profiling (Part 2)
| ) 21/2 Axis Profiling (Part 3)
| | 21/2 Axis Profiling (Part 4)

Nested Sheets

[ ] Sheet1
@[ | Sheet2

[ ] sheet3

Right or Double Click one of an Operation's Icons to Edit its Properties

m
HHEHIH

1] Drag & Drop a Tool from the Object Browser to an Operation
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The tool can also be edited by dragging and dropping a tool from Tools tab to the

Machining Browser.

-4, Machining Job
y Machine - 3 Axis
Zz Post- Laguna_BR_IQ
ﬁ Stock - Box Stock
= g Operations to Nest
L"‘_IA Mesting Parameters
= is Profiling (Part 1)
wl Geometry
[ Fratmit
Feeds/SpecaNgy [ 375 4FL ( 2.550 Loc )

%[Clearance \ % Der

Parameters

Toolpath

I:§ In-process St
| | 21/2 Axis Profilgg{Part 2

[ 2172 Axis Pm&g (Part 3)

B o3 s | A E 7| Default

tﬂbjects

hachs
I'r To-c-?gl{-ﬂases

T 8T

= Tools

B Flamin 025
M /375 4FL (2550 Loc | Drag

M msarL(1180Lec)
B4 a5 arL 950 Lac)

Drag & Drop a Tool from the Object Browser to an Operation

[T] Display of Operations that need Regenerating after Editing

If any of the objects that make up the operation were to be edited after the toolpath was
initially generated, the operation will be flagged dirty (i.e., needing regeneration). This

condition is indicated by adding a red marker ? to the operation folder. Also, the

object that necessitated this condition -ﬂf is also displayed with a red marker.

An example of this is shown below. In this case the tool used in the operation was edited
after the machining operation was created and so is shown differently, as is the

operation.
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=1, Machining Job
y Machine - 3 Axis
i Post- Laguna_BR_ICQ
fﬁ Stock - Box Stock
o--Fid Operations to Nest

o Mesting Parameters
= ?ﬂ 2 1/2 Axis Profiling (Part 1)
_ Control Geometry
W 3754FL (2550 Loc)
: ? Feeds/Speeds
- Clearance
é( Parameters
Toolpath
LE;:I In-process Stock
Display of Operations that need Regenerating after Editing
Profile operations will be flagged if any associated parameters outside of the operation
are edited. For example, if the geometry is modified, all Profile operations dependent
on that geometry will be flagged for regeneration. In the example below you see that

the Profile folder, Control Geometry and the In-process Stock are flagged, letting you
know that the operation needs to be regenerated and simulated.

=1~ Machining Job
y Machine - 3 Axis
£z Post - Laguna_BR_IQ
fﬁ Stock - Box Stock
o Fid Operations to Nest

S |

A Mesting Parameters
= ;ﬂ 2 1/2 Axis Profiling (Part 1)
'%T Control Geometry
_r S734FL (2550 Loc)

? Feeds/Speeds

[ Clearance
Parameters

Toolpath

E!'-J In-process Stock ‘

[T] Regenerating "Flagged" Machining Operations

In order to regenerate the operation that is flagged with a red marker, you would have to
select the operation, right click and select Regenerate.
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=1, Machining Job
y Machine - 3 Axis
:_;,.‘i' Post - Laguna_BR_IC
ﬁ Stock - Box Stock
= 3 Operations to Nest

I; Mesting Parameters H'D'
(=]

2 1/2 Axis Profiling (Part 1)
@ Cont ﬁ Regenerate
| 3754 a

Feed: = Post

%[ Clear @ Simulate

Parar

Toolg Simulate Until

_ P et i
@ In-pr l\_!r_) Information
|_ 21/2 Axis
- & _ .
Right-click on an Operation and Select Regenerate

The toolpath is now generated with the modified settings. Notice that the In-process
Stock is still flagged. This alerts you that it has not been simulated yet.

=l Machining Job
y Machine - 3 Axis
:_;;i' Post - Laguna_BR_IC
ﬁ Stock - Box Stock
= 3 Operations to Nest
L"._IA Mesting Parameters
CERi 2 1/2 Axis Profiling (Part 1)

Control Geometry
W 3754FL (2550 Loc)
Feeds/Speeds

%[ Clearance

Parameters

Toolpath
'Eb In-process Stock

Machining Operation is Regenerated

9.2 Copy/Paste

You can Copy and Paste machining operations in Machining Browser. To Copy an operation, select
the operation under the Machining Browser, right-click and select Copy.

[ Copy the Operation

© 2020 MecSoft Corporation



Edit Operations

=BT

m
HHHEHHHH

Machining Job
y Machine - 3 Axis

:;;?-

Post - Laguna_BR_IC

Ei Stock - Box Stock
= E Operations to Nest

G Mesting Parameters

2 1/2 Axis Profiling (Part 1)

[]
[ ] Sheet3

21/2 Axis Pr lﬁ Regenerate

21/2 Axis Pr|
21/2 Axis Pr, "/

Sheet 2

=

Post
Simulate
Simulate Until
Information
Edit

Rename
Suppress

Cut

Copy N
Paste

Save As Defaults

Properties

Machining Browser: Copy an Operation

[T] Paste the Operation

Right click on the operation and left click on Paste.

200
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=1, Machining Job

y Machine - 3 Axis

:_;,.‘i' Post - Laguna_BR_IO

fiﬂ Stock - Box Stock

= E Operations to Nest

l;_lﬂ Mesting Parameters
- B
| ) 21/2 Axis Prof @ Regenerate
| 21/2 Axis Prof a_
[ 21/2 Axis Prof & O

Simulate

Simulate Until

m
HHHEHHHH
3
g
[¥ 5]
=g
2

|:| Sheet 3 (_‘-!-r_:l Infermation

W) e
Rename
|£ Suppress
Cut
@ Copy
EE Paste

Save As Defaults

|ju Properties

Machining Browser: Paste an Operation

[T Edit or Regenerate the Operation

This creates a copy of the operation located under the currently selected operation. If
you picked Yes to the Execute Nest message dialog, additional sheets are added to the

Nested Sheets list to accommodate the additional operation.
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=1, Machining Job

‘y Machine - 3 Axis

i Post- Laguna_BR_ICQ

(9 Stock - Box Stock Original

= E Operations to Nest
Z Mesting Parameters {

[_ 2 1/2 Axis Profiling (Part 1)
2 1/2 Axis Profiling (Part 1) + Copy
2 1/2 Axis Profiling (Part 2)
21/2 Axis Profiling (Part 3)
) 21/2 Axis Profiling (Part 4)
MNested Sheets

[ ] sheet1
[ ] Sheet2
[ ] Sheet3

[ ] Sheet4 | 2 Additional
[ ] Sheets € Sheets Added

Pasted Operation & Additional Nested Sheets

[ R el et B

m
HHHHHEHHHHH

You can then edit the operation and regenerate toolpath.

9.3 Delete

To Delete a machining operation, select it from the Machining Browser, right click and select Cut
from the context menu.

[ Cut an Operation

© 2020 Mec Soft Corporation



203

RhinoCAM Profile-NEST 2020 Reference

94

=1, Machining Job
y Machine - 3 Axis
:_E..'i' Post - Laguna_BR_IC
@ Stock - Box Stock
= E Operations to Nest
IE Mesting Pararneters

|-- Erin nn (Pard
I 21_;’2,ﬂxi:,ﬁ Regenerate
I 21_.'r2.|':'-3(i!.“l'_' Post
[ 2120 ¥
= E Mested Shee Simulate
[ ] Sheet1
Simulate Until
[ ] sheet2
|:| Sheet 3 (_;!-r_) Infarmaticon

W) e
Rename

IE Suppress

o} Cut Ik

2 con
Ej Paste

Save As Defaults

IjJ Properties

Delete from Right-Click Menu

[T] Alternate Methods to Delete an Operation
Alternatively you can delete a machining operation by:
e Selecting the operation and pressing the Delete key on your keyboard.

e Selecting the operation and dragging the operation out of the mops browser to
the viewport area.

Rename

You can Rename a machining operation or the Setup in the Machining Browser by selecting it,
right click and select Rename from the context menu.
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[T] Select Rename from the Right-click Menu

=1, Machining Job
y Machine - 3 Axis
S_;‘,.i Post - Laguna_BR_IC
Ei Stock - Box Stock
= g Operations to Nest
E Mesting Parameters

|-_ (] i i
| ) 21/2 Axis ﬁ Regenerate
| 21/2 Axis | Post
- =% Pos
[ 212 Ais|
= [i | Mested Sheet Simulate
Sheet 1
|:| Simulate Until
[ ] sheet2
|:| Sheet 3 @ Infarmation

W) e
Rename

[ = Suppress

Select Rename from the Right-click Menu
Selecting Rename allows you to edit the operation name.

=-{, - Machining Job
y Machine - 3 Axis
Zz Post- Laguna_BR_IQ
[Ei Stock - Box Stock
= g Operations to Nest
5 Mesting Parameters

-~
e e

21/2 Axis Profiling (Part 3)
2 1/2 Axis Profiling (Part 4)

=

Edit the Operation's Name

[1] Conventions for Renaming Operations

Do not use any of these common illegal characters/symbols in your Mop Names:
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9.5

# pound ? guestion mark
% percent / forward slash

& ampersand S dollar sign

{ left bracket ! exclamation point
} right bracket ' single quotes

\ back slash " double quotes
< left angle bracket colon

> right angle bracket @ atsign

* asterisk

Also, keep these rules in mind:

Suppress

[T] To Suppress an Operation

Do not start or end your Mop Names with a space or period

Keep your file names to a reasonable length and be sure they are under 31
characters.

You can Suppress a machining operation in the Machining Browser by selecting it, right click and
select Suppress from the context menu. Suppressed operations will not be displayed, posted or
simulated. You can also right-click and Unsuppress an operation.
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=~ Machining Job
y Machine - 3 Axis
S_;‘,.i Post - Laguna_BR_IC
Ei Stock - Box Stock
= E Operations to Nest
E Mesting Parameters
@ T
| 21728 Iﬁ Regenerate
| 2128 -,
(2128 ¥
= E Nested She @ Simulate
[ ] Sheet1
[ ] sheet2

|:| Sheet 3 @ Information
E Edit

Rename

- H--H

Post

3]

Simulate Until

& Suppress
- R
apb Cut

To Suppress an Operation

[T] The Suppressed Operation Icon
A Suppress operation will display in the Machining Job with the following icon:

=~ Machining Job
y Machine - 3 Axis
iz Post- Laguna_BR_IQ
[Ei Stock - Box Stock
= E Operations to Nest

" 4| Mesting Pararneters
i) 2 1/2 Axis Profiling (Part 1)

j ) 21/2 Axis Profiling (Part 2]

[__,l 2 1/2 Axis Profiling (Part 3)

[__,l 2 1/2 Axis Profiling (Part 4)
= [i | Nested Sheets

[ ] Sheet

[ ] Sheet2

[ ] Sheet3

Suppressed Operation Icon

[T] To Unsuppress an Operation
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To Unsuppress an operation, right-click on it and select Unsuppress.

= Machining Job
y Machine - 3 Axis
iz Post- Laguna_BR_IQ
fiﬂ Stock - Box Stock
= E Operations to Nest
L‘__IA Mesting Parameters

I 21;’21’1'-:<i5F'r|':_;!;_> Information
[ 21/2 Axis P
[ 21/2 Axis Pn Rename

= E Nested Sheets IL_r Unsuppress L}
[ ] Sheet1 :
[] Sheetz | op CH
|:| Sheet 3 j Properties

To Unsuppress an Operation

9.6 Edit Properties

You can set the properties of a Operation by selecting it in the Machining Browser window,
clicking on the right mouse button and selecting the Properties menu item.

[T] Select Properties from the Right-click Menu (in the MILL Module)
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=BT

=

m
HHHEHHHH
3
2
(¥,
g

Machining Job
y Machine - 3 Axis
5.;? Post - Laguna_BR_IC
Ei Stock - Box Stock
ﬁ Operations to Nest
E Mesting Parameters
| 2172 A .ﬁ Regenerate
[ 21/2 A e,
]

" Post
2172 &
Simulate
[ sheett Simulate Until

%SheetB 8) Information
A SEL
Rename
& Suppress
4 Cut
@ Copy
@ Paste

Save Az Defaults

\j] Properties

Select Properties from the Right-click Menu

[T] Dialog Box: Machining Operation Properties

This will bring up the dialog that is shown below.

208
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Machining QOperation Properties *

Name: | 2 172 Awis Profiling [Part 1] |

Frogram #: | |

Simulation Calar: |:| -

Comments to Output

Previouzly Output Ta File

Presaouzly Dutput On

| |
Cancel Help

Dialog Box: Machining Operation Properties

Name
Change the Name of the Machining Operation.

Program #
Specify Program # for the operation. This program number will be output during post
processing of the operation.

Simulation Color

This allows you to specify a unique color for this operation during Simulation display.
Referto the Simulate tab Status Bar for setting the simulation to display by Mop (i.e.,
machining operation type).

Comments to Output

You can also include commands that will be saved with the operation. These comments
will also be output during post-processing of the operation. This might be a good place
to putin comments or instructions for the machine tool operator.

y Thiscan be used to putin add comments or instructions for
the machine tool operator!

Previously Output To File
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This refers to the name of the external post-processed file that this particular operation
was output to.

Previously Output On

This refers to the last time the operation was post-processed and the time the post-
processing was performed.
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Simulate

MILL module offers very powerful cut material simulation functionality to allow you to simulate
actual machining of the generated toolpaths. The output of this simulation is a true 3D cut model.
This 3D model can be rotated, zoomed and manipulated.

This cut model can be visually compared with the part model to show areas of uncut material
and/or areas of over-cut material using this component. The simulation features allow the early
detection and correction of programming errors.

[ 3 Types of Simulation Available
There are three kinds of toolpath simulation available in MILL module. These are
1. Tool Animation
2. Cut Material Simulation
3. Machine Tool Simulation

The simulation can be performed either on the currently active machining operation or
on multiple operations.

[T] Simulate the Active Operation

The active operation is the one that is selected and shown highlighted in the Machining
Browser. Typically, this would be the last toolpath that was generated. To simulate any
operation, select the operation in the browser and click Simulate from simulate tab of
the browser or by using right click and Simulate.

Profile-NEST| /3| Mest Simulate o & @
[i:’l Preferences 6]7,1 Stock - EI Step Levels ﬂ Stop

¥ [ Play [ ToEnd
Simulate by Mowves m step ml Pause

Opticns Simulate

= Machining Job | pj,, ~

Machine -
‘y acnine . Perform Toolpath
s Post-lag Simulation or Animation

@ Stock - Bo

= tﬂ Operations to Nest

Z Mesting Parameters

[_ 2 1/2 Axis Profiling (Part 1)

|12 1/2 Axis Peofiline Part 2)

Simulate the Active Operation

[ Simulate Multiple Operations
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To perform simulation on multiple operations select the last operation, right click and
choose Simulate Until. You can also select multiple operations by holding down the Ctrl
key.

=1, Machining Job
¥ Machine - 3 Axis
2z Post- Laguna_BR_IQ
fij Stock - Box Stock
= E Operations to Nest
l_"__IA Mesting Parameters
[_ 2 1/2 Axis Profiling (Part 1)
[_ 2 1/2 Axis Profiling (Part 2)
|__ L i
[ 21/2 Axis| g Regenerate
Nested Sheets o
[ sheet1 | & o
Sheet 2 Simulate

[
[ ] sheet3

+

m
HIHEHHHH

Simulate Until [}

(_!_:J Information

Simulate Until the Active Operation

[T] Simulate all Operations within the Operations to Nest (Setup)

Alternatively you can select a Setup and select Simulate to simulate all the operations
within a Setup.

=-{, - Machining Job
y Machine - 3 Axis
Zz Post- Laguna_BR_IQ
fij Stock - Box Stock
R or-rrionniies
’;_IA Negtin@ Regenerate
[ 2128, r
[ 2124 ot
l
l

;_1;;_; Simulate [}

21724 &~ .
L I 1 Infarmatinn
Simulate all Operations within Operations to Nest (Setup)

1] Simulate one or more Nested Sheet

You can also simulate one or all of your currently nested sheets or one or more nested
operations within a nested sheet. You can use the same selection and right-click options
on sheets as you can of operations. you can select a Setup and select Simulate to
simulate all the operations within a Setup.
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=BT

=

o

Machining Job

y Machine - 3 Axis

S_;,.‘i' Post - Laguna_BR_IC

ﬁ Stock - Box Stock

ﬁ Operations to Nest

G Mesting Parameters

[_ 2 1/2 Axis Profiling (Part 1)
21/2 Axis Profiling (Part 2)
2 1/2 Axis Profiling (Part 3)
21/2 Axis Profiling (Part 4)
Hested Sheets

=

|:| Sheet @ Regenerate
2]

Sheet |
;_;;', Post

@ Simulate I},

Simulate Until
Simulate a Nested Sheet

L '

IHHEHHHH

Machining Job
y Machine - 3 Axis
S_;,.‘i' Post - Laguna_BR_IC
ﬁ Stock - Box Stock
ﬁ Operations to Nest
G Mesting Parameters
[ 2 1/2 Axis Profiling (Part 1)

_ .
| | 21/2 Axis Profiling (Part 2)
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Simulate one or more Nested Operations

10.1 Tool Animation

Available in: Xpress Standard Expert Professional Premium

v v v v v

Simple tool animation can be carried out in MILL module by using the controls on the Simulate
tab. If there is no stock loaded or if the stock is loaded and the stock visibility is turned off then
the tool can be animated to follow the toolpath by setting the step increment to the desired value
and clicking on the Simulate button on the Simulate tab of the browser or by selecting an
operation and choosing right click to simulate.

= Ii Nest;?:;:;eb. -
[ ] sheet1
o 1 e il b
b B Fler P H I Default -

Stock Visibility
Visual o =
f K2 Toggle Stock Visibility

IR

Location of the Toggle Stock Visibility Icon

You can also choose to display the toolpath as the tool is being animated. This is a powerful
function that allows you to actually watch the toolpath being displayed on the screen
incrementally. To do this make sure Toolpath Visibility is turned on before starting the tool
animation along the toolpath.
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it
=[5 | Nested Sheets

[ ] Sheet1
= 1 e P hd

8B (o fHS T Default .
Loy

Toolpath Visibili
VisualCAM - Mac oolpath Visibility a X

'55:.’-' Teggle Toolpath Visibility

r Tools
A A o

Location of the Toggle Toolpath Visibility Icon

Tool Animation

10.2 Cut Material

Available in: Xpress Standard Expert Professional Premium

v v v v v

As mentioned earlier, the Profile-NEST module offers very powerful cut material simulation
functionality to allow you to simulate actual machining of the generated toolpaths. To perform
cutting simulation, a Stock model must be defined and displayed and a machining operation must
be active.

[ Location of the Toggle Stock Visibility Icon
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Location of the Toggle Stock Visibility Icon

Selecting Play on the Simulate tab simulates the selected operation.

1] An Example of Cut Material Simulation

The output of this simulation is a true 3D cut model. This 3D model can be rotated,
zoomed and manipulated. This cut model can be visually compared with the part model
to show areas of uncut material and/or areas of over-cut material using this component.
An example of cut material simulation is shown below.

An Example of Cut Material Simulation

1] An Example of Voxel Simulation Visual Artifacts

When the Simulation Model is set to Voxel, in some cases, especially when simulating
cutting of vertical walls (as is typically done in 2 axis machining), the Voxel simulation
model leaves visual artifacts at these areas. The reason for this is that the Voxel
simulation model display resolution is not very high along the Z-axis. This causes jagged
areas to be displayed under these circumstances. It should be emphasized that these are
purely visual artifacts and do not represent the true output that would be generated on
the machine tool. An example of this visual artifact is shown below. To avoid this,
change the Simulation Model to Polygonal under Preferences..
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10.2.1

10.3

An Example of Visual Artifacts

Advanced Engine

Available in: Xpress Standard Expert Professional Premium

v/

There are two material removal simulation modes (or models) available for use. The main
advantage of the Voxel method is very rapid processing times. The Polygonal method is more
comprehensive and results in better display quality, however at the expense of speed.

To change the simulation module in the Profile-NEST module, select Simulation Preferences
located under the Simulate tab or select CAM Preferences > Simulation Settings button under the
Machining Browser and select the appropriate model for simulation.

Refer to Simulation Preferences for a detailed description.

Voxel Simulation Polygonal Simulation

Material Texture

Material texture can be applied to your cut material simulations. This functionality allows you to
simulate actual machining of the generated toolpaths with material textures applied.

[1] To Prepare for Cut Material Simulation with Material Texture
1. Stock model must be defined and displayed.
2. Material must be defined under the Program tab

3. Turn on Material Texture Visibility
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..... |:| Sheet 1
.;. | h
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Visual S

535 Toggle Material Texture
| if! Visibility on Stock

VT~

Location of the Material Texture Visibility Icon

4. A machining operation must be active.

[:D To Perform the Simulation

Then using the controls in the Simulate tab of the Machining Browser you can perform
the cutting simulation.

See Material for a detailed description.

1] Example of Cut Material Simulation with Material Texture

An example of cut material simulation with material texture is shown below. The
Material is set to Wood under Choose Stock Material.

Example of Cut Material Simulation with Material
Texture
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Post-Process

Once nested sheets are created they can be post processed to a specific machine controller. To
post process a nested sheet, select the Sheet in the browser, right click and select Post. The
product comes with a set of over 300 post-processors to choose from.

[1] Example of Posting a Nested Sheet.

= Machining Job
y Machine - 3 Axis - 38xMakinoV99L
i Post-Laguna_BR_IQ
fjj Stock - Box Stock
o--Fid Operations to Nest
e 3 Mesting Parameters
2 1/2 Axis Profiling (Part 1)
2 1/2 Bxis Profiling (Part 2)
2 1/2 Axis Profiling (Part 3)
2 1/2 Bxis Profiling (Part 4)
Mested Sheets

C B
[ ] Sheet @ Regenerate
[]

Sheet -
e Post I},

Simulate

Example of Posting a Nested Sheet

m
HIHEHHHH

[T] Post-processing Multiple Machining Operations

You have the ability to select multiple operations within a nested sheet of machining
and post process them with a single button click. To do this expand the nested sheet,
select the operations and right click and select Post.

You can select multiple operations by holding down the Ctrl key.

Example below shows posting multiple machining operations.
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| ) 21/2 Axis Profiling (Part 3)
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| | 21/2 Axis Profiling (Part 1) 2
(I 2 1/2 Auis Profiling (Part 1) 3
[ 2 1/2 Axis Deofilig (Dapt 1
| ) 21/2 Axis @ Regenerate
| ) 21/2 Axis|

- 7o Post
[ 21/2 Axis (s
[0 21/2 Axis Simulate

g ! i R
Selecting multiple operations by holding down the Ctrl key for posting

[T] Post from the Program & Simulate tabs

Post-processing can be done from the Program or Simulate tabs under the Machining
Browser.

Selecting Post will display the Post and Save As Dialog.
The following are the default settings when the Post and Save As Dialog is displayed.

e Post & Save As Dialog points to the folder location where the part geometry is
located.

e Save as type —this refers to post file extension. This information is obtained from
the Program tab > Set Post Options dialog.

e Current Post - this refers to the controller/post processor to post process the
toolpath. This information is also obtained from the Program tab > Set Post
Options dialog.

You can override the default settings using the Post & Save As Dialog.

Select Post and the posted file will be written to the specified folder.
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Save in: Tutorials ~ @ F B
'z Name : Date modif
e This folder is emnpty.
Recent Places
Desktop
'l'] )
MecSoft Demo
[
LY
Computer
[ W
== 4| 1} 4
Metwork
File name: Gasket-Completed. nc - Post
Save as type: Posted Output Files ("nc v] [ Cancel |
Current Post: -
[ Do nat show this dislog again

Dialog Box: Post & Save As

[T] Tool Number Validation during Posting

Tool number conflicts are flagged before post-processing multiple operations. If
multiple machining operations use different tools but with one or more coincident tool
numbers, you are notified of this condition with the following message:

Different tools with the same tool number found in the
operations selected to be posted! Do you want to continue?

11.1 Set Post Options

iz Post You canspecify certain post-processor options and rules for post processing. This is

done by selecting "Set Post Options" from the Program tab under the Machining
Browser.

This will bring up the following dialog.

[T] Dialog Box: Set Post-Processor Options
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Set Post-Processor Options >
Set Post-Proceszor Options

Select Pozt Processar

Current Post Processor. | Haas w~ || Edit ...

Folder where post-proceszsar files are located:

| ramC atatkecSoft Corporation®, |

Program to zend pozted file to

|nu:utepau:| |

Posted File Maming Corventions
When a Machining Dperation(z] iz selected for Posting, uze
Part File Mame+t achining Operation M ame e

When a Setup iz zelected for Pozsting, use

Part File M.ame+5etup M ame e

When posting all in file, uze

Part File Mame e

Posted File Extenzion: | .nc b Add Mew ..

Show Output Dialog when Post-Processing

Cancel Help

Dialog Box: Set Post-Processor Options

[T] Current Post Processor

User can change the default post processor by selecting a post from the list of available
post processors under Current Post Processor.

[1] Folder where post-processor files are located

MILL module uses macro files with a.spm extension to handle post-processing to
different controllers. These files are typically located in the "Posts" directory under the
RhinoCAM installation folder(C:\ProgramData\MecSoft Corporation\RhinoCAM 2020 for
Rhino x.x\Posts\Mill).
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MILL module by default looks in this directory to build the list of available post-
processors shown under the Current Post. User can change the post processor by
selecting a post from the list of available post processors under Current Post.

To change the post processor file location, you can specify the folder to find the Post-
Processor macro files by selecting the "Browser for Folder" button in the dialog.

Program to send the Posted file to

This feature allows you to specify a program to display the posted file. This could be a NC
editor or a text editor like Notepad.

You could also have this point to your control software’s
executable file and RhinoCAM will automatically launch this
application when the machining operations are post processed.

o

Posted File Naming Conventions

This allows you to set rules for posted file name when post processing machining
operations.

When a machining operation is selected for posting you can set the output file name
from one of the following options.

e Part File Name + Machining Operation Name

e Part File Name + Setup Name + Machining Operation Name
e Setup Name + Machining Operation Name

e Machining Operation Name

When a setup is selected for posting you can set the output file name from one of the
following options.

e PartFile Name + Setup Name
e Setup Name

When Machining Job is selected to Post All, you can set the output file name from one of
the following options.

e PartFile Name
e Part File Name + First Setup Name

e First Setup Name

Posted File extension

You can select a posted file extension from the list or add an extension to the list by
selecting Add new button. This displays the Post File Extension dialog shown below
where you can specify a new file extension and click OK.
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Post File Extension [oE3m]

Enter Extension for Post File
{example : .abc, .xyz)

[ OK ] I Cancel

Dialog Box: Post File Extension

The new file extension is now set as your posted file extension automatically.

By default RhinoCAM performs interactive post-processing. That is, when you select a
toolpath for post-processing, RhinoCAM launches the post-processor and waits for it to
complete. You can also turn off the display of the output dialog (post and save dialog).

During interactive post-processing, RhinoCAM launches the NC editor to view the output
file. You can specify a different NC editor to use. See Program to send the Posted file to
above for doing this.
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Archive

Once machining operations are created they can be archived along with the Rhino part (.3dm) file.
This can be accomplished by simply saving the part file. When the part file is retrieved, all
archived operations will be loaded along with the part file.
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Find More Resources

Download this PDF Guide for a list of the available RhinoCAM Resources.

D:l 2020 RhinoCAM Resource Guide

—._-lﬁ The RhinoCAM 2020

2020 :
RhinoCAM | - Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Click Here to download this guide!
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LAN Daemon

Enable 47

P 47
Password 47
Port Number 47
Username 47
Learning Resources 7
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Default Tool 28
Licensing
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Load Tool Library 100
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Machine Setup
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Archiving Operations 225
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Post Processing Operations 219
Preferences 32
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Stock

Preferences 27
Transparency 27, 39
Suppress (Operations) 205
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Tool Tab 181
Toolpath 37
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Editor 125
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Viewer 125
Tools
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Tools (See Cutting Tools) 89
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139
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Invalid tool definition 139

Invalid Z level setting! Please correct before

proceeding 139

21
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123

123

139

No Valid solution could be found

Skipping them 139

Open loops found. Cannot proceed further!
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139
Object(s) used in Machining Operation(s)!

-U -

Understanding 5
Unsuppress (Operations) 205
User Interfface 11

Machining Browser 13
Preferences 42
Profile-NEST Browsers 12
Ribbon Style 42

Utilities

Explode Cabinet Design 134
Export to VCP 138

Post Process Generator 133

-V -

Voxel Model (Simulation) 39

-W -

Welcome 5
Work Zero
Dialog 76
Example 76
Generate 76
Locate 76
Menu ltem 76
Output Work Offset (G54) 76
Workflow 5
World CSYS Visibility 15
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